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Intro to OnePlan

Log in to OnePlan with the Login Form

Log In To OnePlan

This article explains how to access OnePlan. If Logging in with Microsoft

_ o Credentials
OnePlan allows for multiple authentication

methods: Office365 Strict, meaning only users
in your organization's Azure Active Directory are
able to access OnePlan, or Multi-Authentication,

meaning users can log in to OnePlan using S NOTE
a OnePlan account they create (see Create a Follow these instructions to access
OnePlan Account [17] for instructions), or a OnePlan when using Microsoft
Microsoft account. See Enable OnePlan Multi- credentials. These steps apply if
Authentication for more information. your organization is using Multi-
Authentication with Office365
Regardless of the authentication method your as an Allowed Authenticator,
organization uses, when you go to OnePlan or Office365 Strict. See Enable
(my.oneplan.ai, ca.oneplan.ai, eu.oneplan.ai, OnePlan Multi-Authentication for
au.oneplan.ai, us.oneplan.ai), you will be greeted more information.

with a login form.

1. Click Sign in with Microsoft. You will be
redirected to the Microsoft login page.
Welcome to OnePlan 2. If prompted, enter your email address and
click Next. Or select your preferred Microsoft
account from the Pick an account form.

MnePlan

Email

Password

MnePlan

[ Remember Me Forgot Password?

signin

someone@example.com
Dont' have an account? Create One

Can't access your account?

Sign in with Microsoft

Qk‘, Sign-in options
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3.

= Microsoft

Pick an account

I-EI tshirk@oneplan.ai

—|— Use another account

Enter your password and click Sign in.

MnePlan
< tshirk@oneplan.ai

Enter password

Forgot my password

Follow any additional prompts, such as multi-
factor authentication steps. Once complete,
you will be redirected to your organization's
OnePlan instance.

If Logging in with a OnePlan Account

NOTE
Follow these instructions to

access OnePlan using a
OnePlan account. See see
Create a OnePlan Account [17]
for instructions to create a
OnePlan account. These steps
apply if your organization

is using Multi-Authenitcation
with Forms as an Allowed
Authenticator. See Enable
OnePlan Multi-Authentication for
more information.

1. In the Email field, enter the email address you
used to create your OnePlan account.

2. In the Password field, enter the password you
created for your OnePlan account.

3. (Optional) Check the Remember Me check
box. This means that, after you login to
OnePlan the first time, you will continue to
have access to OnePlan when you access it
from same computer and browser. This access
will be possible until you logout of OnePlan.

4. Click Sign In.

Log in to OnePlan with a Share With
URL

If your organization is using Office365 Strict
authentication, your manager or administrator may
send you a link directly to your organization's
OnePlan environment (see Share Your OnePlan
Environment with the Share With Link [17] for
instructions to get a sharable URL for your OnePlan
environment). This link will send you directly to

the Microsoft login page. From there, enter your
Microsoft credentials as prompted.

16
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(MnePlan
Sign in
Can't access your account?

O*h Sign-in options

0 IMPORTANT

Be sure to keep the link for later
use (bookmark, etc.) so you will
always be sent directly to your
organization's OnePlan instance,
and you will not have to interact
with the OnePlan login form.

Getting Started

The first time you log in to OnePlan, you are
directed to the Getting Started "Welcome to
OnePlan" page. This page includes an intro video
to get you familiar with OnePlan.

Going forward, OnePlan will remember your last
screen and open there each time you log in. To
return to the Getting Started page at anytime,

1. Click on the Help Menu (?).
2. Select Getting Started.

Share Your OnePlan
Environment with the Share
With Link

This article explains how to access the Share With
link to provide users with a link directly to your
organization's OnePlan environment.

You may want to have a link directly to your
organization's OnePlan environment for many
reasons, such as:

* If you are adding external users to your OnePlan
tenant. See Add an external user to a OnePlan
tenant for instructions).

* If your organization is using Office365 Strict
authentication, and you want your users to be
directed straight to your OnePlan environment.
See Log In To OnePlan and Enable OnePlan
Multi-Authentication for more information.

To get the Share With link to your OnePlan
environment:

1. Click on the User Menu. Then select Share
With. The Shared URL form will open.

2. Copy the URL from the Shareable URL field.
This link will direct users directly to your
organization's OnePlan environment.

Create a OnePlan Account

This article describes how to create a OnePlan
account.

For an Existing OnePlan Group

If your organization has enabled multi-
authentication for your OnePlan group, users are
able to create a native OnePlan account to access
and use OnePlan rather than using Office 365
authentication.
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This feature can be particularly useful if you want to
invite users to collaborate with you without requiring
them to be added to your company's Microsoft
365/Azure Active Directory. These users can be
contractors, customers, or whoever you would like
to collaborate with who is outside of your company.

To create a OnePlan account for an existing
OnePlan group:

1.  Follow the OnePlan invite link sent to you via
email. This link will take you to the login page
of your organization's OnePlan group.

2. On the login page, click Create Account. This
will launch the account creation process.

S NOTE
At this step, you can also click

Sign up with Microsoft, and
connect any Microsoft account
to this OnePlan group and use
it to access OnePlan.

0 T

WL EEH
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3. Verify your email address, then click
Next.OnePlan will send a verification code to
the listed email address.

MnePlan

Welcome to OnePlan
Get started - it's free. No credit card needed.

academy@oneplan.ai

-] Sign up with Microsoft

Go to your inbox and copy the verification code
sent from OnePlan. Then, go back to OnePlan
and paste the verification code into the Enter
Verification Code field. Click Next.Enter the
verification code from your email, and click
Next.

CrePlan Verification Code

spurad, o youTs DEEING N0 3 Nk ke, vl e e cock.

MnePlan

Welcome to OnePlan

Get started - it's free. No credit card needed.

A verification code has been sent to your email. Please check your email.

Complete your OnePlan account setup by
creating a password, and providing your name
and organization. Then click Next to log into
into OnePlan.
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@ IEIE (MnePlan

Passwords must be at least 8

characters long, and contain Welcome to OnePlan
upper and lower case letters, i
a number, and a special
character.
Password
—_—) [ Remember Me Forgot Password?

®nePlan

Welcome to OnePlan i

Get started - it's free. No credit card needed.

Password

= Sign in with Microsoft

Verify Password

3. First, enter the email address you would like
to use for your OnePlan account. Click Next.
OnePlan will send out a unige varification code
to the email address you just entered.

MnePlan

Welcome to OnePlan

Full Name

Organization Name

For a New OnePlan Environment Get started - it's free. No credit card needed.

If you are not part of an organization that is using ' addres:

OnePlan, you can still create a OnePlan account.

As part of the process, you will also create a
OnePlan group. You need to create a new OnePlan

group because the account you create will not be
associated with any existing OnePlan group.

" Sign up with Microsoft
To create a new OnePlan account and group:
1. Go to OnePlan (my.oneplan.ai, ca.oneplan.ai, 4. Go to your inbox and copy the verification code
eu.ongplan.al, au.oneplan.ai, .us.oneplan.al). sent from OnePlan. Then, go back to OnePlan
You will be greated by the login page. and paste the verification code into the Enter
2. Click Create Account. This will launch the Verification Code field. Click Next.

account creation wizard.

3 NOTE
At this step, you can also click

Sign up with Microsoft, and
connect any Microsoft account
to this OnePlan group and use
it to access OnePlan.

OnePlan Verification Code
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5.

MnePlan

Welcome to OnePlan

Get started - it's free. No credit card needed.

A verification code has been sent to your email. Please check your email

Complete your OnePlan account setup by

creating a password, and providing your name

and organization. Click Next.

K

NOTE

Passwords must be at least 8
characters long, and contain
upper and lower case letters,
a number, and a special
character.

MnePlan

Welcome to OnePlan

Get started - it's free. No credit card needed.
Password

Verify Password

Full Name

Organization Name

Your OnePlan account is now complete.
However, the account is not connected to any
OnePlan group, so you need to create a new
OnePlan group. Click New Group.

MnePlan

Welcome to OnePlan

Get started - it's free, No credit card needed.

Thank you for signing up. Now create youj new group|

7. Enter a name for your OnePlan group,

determine if you would like to include sample
data in this new group, and select the template
you would like to use for this new group. Click
Create Group. OnePlan will generate your
new group and redirect you to the Getting
Started page of your new OnePlan site. Now
you can begin using OnePlan.

8. If you would like to add more people to
your OnePlan environment, you will need to
invite them. See Add Users to OnePlan for
instructions. Then, those users need to follow
the instructions in the For an Existing OnePlan
Group [17] section of this article to create their
OnePlan accounts.

OnePlan Minimum Software and

Hardware Requirements

In order for OnePlan to work properly, users need
to meet the following technology requirements, at
minimum.

Software Requirements

Users need to create a a new Office 365 tenant
to support the subscription(s) OR use an existing
Office 365 tenant to support the subscription(s).

Users are required to use a supported web
browser. Supported browsers are the most current
versions of Chrome, Edge, and Firefox.

20
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The table lists links to download a supported How do | get around in

web browser or update your browser to the latest

version. See the release notes for each browser for ~ OnePlan?
more information on their latest releases. This article explains the main navigation icons and
menus in OnePlan.

Table 1.
[ V] H H
Browser Download Update Release Notes“ tion
Browser Browser The main navigation icons are along the left side of
Chrome Download Update https:// the screen. You may see some or all of these icons
Chrome ?htrr?me chromereleases.googlelipgg@d/on which apps or features have been added
O the .
latest to your OnePlan group/environment.
version
Edge Download Update https://docs.microsoft.cogna%k an icon on t_he left-hand side to Open.that
Edge Edge to us/deployedge/microsofpage. The Plans icon opens a panel showing all
o2 relnote-stable-channel yoyr plans (plans you manage and plans that have
latest b h d with
version een shared with you).
Firefox Download Update https://www.mozilla.org/eq:U$/ L .
Firefox Firefox firefox/releases/ ClicK the push pin icon to lock the plans panel in
to the place or hide it.
latest
version

* My Work - This is where team members see what work items they have assigned and make

Hardware Requirements

OnePlan is a web-based solution that will work on
any modern computer. A modern computer has the
hardware to support the latest version of Windows
operating system (Windows 11) (and other modern .
OSs).

The table lists the basic hardware requirements to
support OnePlan. See Windows minimum hardware

requirements for more information. .
Table 2. .
Component Minimum Requirement

Processor 1 GHz, 2 Cores
System memory 4GB
Storage 64 GB

Recommended Browser
Settings for OnePlan
We recommend a minimum of Windows 10.

Browsers supported: (latest versions)

+ Edge
» Chrome
* Firefox

Please ensure that cookies and pop-ups are
allowed.

updates to status, etc.

(w1

* Timesheets - This is where team members track time on work.

]

« My Ideas— This is where you can view the process step, state, priority, category, business unit,

budget, and benefits of an idea.

Q

My Strategy — This is where you can organize your strategies by viewing the objective, priority,
key results, and business unit. As well as seeing the status of the strategies whether they are On
Track, At Risk, or Off Track.

€]

«  Portfolios - This is a view of all plans. Within the Portfolios page, analysis & prioritization may be

done across the plans. The hierarchy of plans (such as portfolios to programs to projects or
strategic themes to programs to epics) is visible here.

Resource Plan - This is where resource managers see the allocation of their resources to all
plans. The resource managers can analyze and adjust their team's commitments as needed.

£

Scheduler - This is where resource managers see the work assignments of their resources to all
plans. The resource managers can analyze and adjust their team's work as needed.

«  Status Reports — This where open and submitted reports can be viewed. Based on report date

and report status.

@

«  Resource Center - This is the page that shows all the named & generic resources in your

OnePlan group.

R
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What do the Colors Signify?

Allocation Bars

The colored bars are based on percentage of a
resource's allocation of work.

* Red: Over allocated. Booked more than 110%

* Yellow: Over allocated. Booked between
100-110%

» Green: Booked 100%

» Blue: Resource has availability. Booked less than
100%

» Gray: No allocated hours, 0%

Task/Booking Bars
The Task (i.e. Booking/Engagement) bar colors are
based on the item's status.

» Gray: Not Started
* Blue: In Progress
» Green: Completed

Plan Grid
B mi smmr cemom
- - v
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D
?
Resource Scheduler
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OnePlan Licensing Capability

Matrix

This article describes the OnePlan capabilities
available to users based on their licensing and
permissions.

OnePlan Capabilities Matrix by

License Type

For more information about OnePlan licenses,
and to purchase OnePlan, please go to https://
oneplan.ai/pricing/.
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Capability $ * Team Member - Thigepermissroeelevel will require
Enterprise lellther T'ﬁe%m Memb&%nqr TearHe'})/lo?{nt er Plus
Contributor Executive Manager Ownelrcens.member . Member . dinetiats . .
« Contrib&tét - This permission level will require
Insights Al X X X X Enterpfise license&X
Efm‘o"o 0"'}" " Relad | X X« Executive - This permission level will require
an availapble Tor only, a . .
Plans Plans Enterprise license.
created by * Manager - This permission level will require
useror Enterprise license.
shared with . .. A .
IGER * Owner - This permission level will require
Plan Details Only Read X X E“te"%% license.
available for only, all only,
Plans Plans I:q H H
Ponted by OnePJgn User Permissions
user or toor
shared with Permiglii‘ign Levels
user with the
user
* None: The user does not have access to
Resource Only Read X . . . .
Plan evellEbls G only, all OnePlan. The user is still available in the
Plans Plans Resource Center to be used for scheduling and
Sgtzf by resource planning.
shared with * Requestor: The user has access to the
user Requests area. The user can submit requests.
Eilna“da' 0"'}’| " Relad | X X+ Team Member: The user has access to My
an availapble tor only, a . . .
Plans Plans Work, Insights and Reporting areas in QnePIgn.
created by The user can update statuses of items in their
user or work.
shared with
user * Team Member Plus: The user has access to My
Work Plan Only Read X x  Work,dpsights, Tlmeshgets, Rleportlng. The user
available for only, all can updgte statuses of items in their work.
(F:’r':;‘tsed A Flans NOTE:E}%"E Member and Team Member
I
— Y Plus utge,;gs Doth appear as "Team Member"
shared with in OneRdad. The different permissions are
Ve differetitidt&d on a license-level.
user
» Contributor: The user can create plans and plan
My Work X X X X ><t P P
content, but can only see plans that they have
Status X X X X ted
P created.
Timesheets X X X x * Executive: The user has read-only access to all
Reporting X X X x Plans and plan captent. X
Advanced X X X x* Manager: The user can. create plans and plan
Reporting content. The user can view and edit|all plans and
Visualizer X X X x Pplan content.
Portfolio X X X x * Owner: The user can create plans and plan
Modeler content. The user can view and edit all plans and
Auditing X X X X plan content. The user can access and configure
Integrations $ $ $ $ OnePlan administration settings.
Accelerators $ $ $ $
Licensing Required by Permissions
See OnePlan User Permissions [23] for more
information on user permissions.
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Permissions and OnePlan Licenses

Resource
Status

Active

Active

Inactive

Permissions

Owner,
Manager,
Executive,
Contributor,
Team
Member

None

None

OnePlan
License

Consumes
a license

Does not
consume
a license

Does not
consume
a license

Description

The
resource
can be
utilized for
resource
planning,
and has
access to
OnePlan.

The
resource
can be
utilized for
resource
planning,
but does
not have
access to
OnePlan.

The
resource
cannot be
utilized in
resource
planning,
and does
not have
access to
OnePlan.
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Global Search

* The Recent Plans tab: Plans that you have

Search for Plans with the recently accessed will be listed under the Recent
tab.

Global Search Bar * The Favorite Plans tab: Plans that you have

This article explains how to use the Global Search marked as a favorite will be listed under the

Bar to easily locate and navigate to your plans from Favorites tab.

any screen within OnePlan.
Hover over a plan name to open the contextual

The Global Search Bar is located in the top ribbon menu. From this menu, you can access all modules
of OnePlan, and can be accessed from any page in within the plan, such as the Work Plan, Financial
the application. Plan, Resource Plan, Plan Details, and Reports.

You can also add comments to the plan, mark it as
m a favorite, share the plan, reorganize the plan, and
© @ s manage the plan's dependencies.
£ " w—

Recent Favorite

J = L Fionis
i : k. SeeFood * i
1 s - = <
Products
. .- |
I - ol Increase project success rate
1 i ey B L S § Objective

Implement a project governance framework to ensure i
compliance with regulations and standards
Key Result

When you click into the Search bar, the search | e Develprnent

Idea

interface will open up. In this interface, you will find: o e on s

Project

I Enterorise Data Platform

i By default, the Search interface displays your

recently accessed plans. Click on the Favorite tab
to access any plans that you have marked as a

fot e e favorite.

ct gowemance framework to ensine compliance sith

regula

Agile Develapment
dez

All Plans. =
|0~u Winrehourse Migration

Voo o sorm Recert

Application Development
Portfedic

VOIP Phones
+ The Plan Type filter: You can narrow your e
search to specific plan types, such as projects,
Ideas, etc. by selecting the desired plan type
from the Plan Type filter, and then entering the
plan name into the search bar.
* The Search bar: Enter the name of the plan
you would like to access into the search bar.
Then press enter on your keyboard to launch the

search.
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To search for a plan in your OnePlan group, enter
the part, or all, of the plan name into the Search
bar, and press enter on your keyboard. A Results
tab will appear with a list of all of the plans in your
environment that match the search query.

In this example, | searched for plans with the word
"manage" in their name.

cent Favorite Results

Brand Management
Program

Br a nd Management Portfolio

han qe Management

Customer Relationship Management

l[ontem Management Systems (CMS)
ICuslumu Relationship Management (CRM)

You can narrow down the search by using the Plan
Type filter. Click on the filter and select the desired
plan type. You can only select one plan type at

a time. Then enter the name of the plan into the
search bar and press enter on your keyboard. The
Results tab will contain plans that match the search
query and selected plan type.

ate

Ernance framework to ensure compliance with
s

TENTEIDISE Lata Flatarm

In this example, | searched for Projects with the
word "manage" in the title.

varite Results

|Crnngo Management
| Im.entc\ry Management

|VL ndor Management
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OnePlan Home Page

Home Page Insights Table 3.
This article explains what Insights are, and how to lcon Insight Type Meaning
manage them on your OnePlan Home Page. o Information The item is for information
Insight only. There are no actions that
Insights notify you about plan items that require need to be taken. Example: A
your attention. The Insights on your home page reminder that your timesheet s
. due tomorrow.

come from the work items and plans that are ) L ,

. e . Warning The item is an issue but is not
assigned to you, so you only get notifications for Insight urgent. If not addressed, the
your own work. warning will be escalated to a

problem. Example: A reminder
that your timesheet is due today.

Access Your Insights

. . . (] Problem The item is causing issues
Go to the Home page from the side navigation. The Insight for the plan and must
Insights panel is located in the top right corner of be g}fldrgsseﬁ. Example: Ah
the Home page. gog‘/l:féfgt at your timesheet
0 Compliance These work items are used
=: Crartn T o | fmsa Insight in compliance calculations and
A R ; must be addressed for the
7 3 el back, Tins Shirk — plan to remain in compliance.
e e o i e Example: A plan has not been
|_ @ L3 Kicers B o s A G updated in a specified number
n‘ SR — ofdays.
. Cap
- A —
E o Manage Insights
' - Click View Details to see all work items that need
& . oy, e | S - your attention.
. - - Click Refresh  to update your Insights in real-
E ﬁ " time. This will pull any updates from relevant plans
l m e and tasks into your Home Page, so you know what
! a is going on at all times.

T f Insiaht Click Snooze  to remove the Insight from your
ypes ot Insig _ S _ o _ Insight list. The Insight will reappear the next time
There are several different kinds of insights. Insight Insights are refreshed if it has not been addressed.

notifications have different levels of severity Less

severe insight notifications can be escalated to https://player.vimeo.com/video/738665209
more severe insights if the issue is not addressed in

a set amount of time. Home Page Plans

This article explains how to use the Plans panel on
your OnePlan Home Page.

The Plans panel on the home page lets you quickly
view or search recent plans to pick up your work
right where you left it.
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E—
=

Tabs and Search Bar

The Plans panel has several tabs to help you
quickly find the plan you need. These tabs include:

* Recent: Displays your most recently accessed
plans.

* Favorite: Displays all plans that you have
marked as a favorite.

* Plans | Own: Displays all plans that you are an
owner of.

* Plans Shared With Me: Displays all plans that
have been shared with you by another plan
owner.

» All Plans: Displays all plans in your OnePlan
environment that you have access to.

There is also a search bar that allows you to search
each tab in the Plans panel. This search function

is particularly useful if there are a lot of plans listed
in a tab, such as in the All Plans tab. Simply begin
typing in the name of the plan, and the plans will
begin to filter based on your search.

Contextual Menu

Select the contextual menu for a plan to see the
available planning modules and options for that
plan.

Favorite Plans | Own

m
mn
]
J
m

== s Integration and mess

Details
Financials
Resourcs Plar
‘Wark Plan

Reporting

[
i
[k}
1
i

» Favorite: Click Favorite to mark the selected
plan as a favorite. This plan will then be listed
in the Favorites tab of the Plans Panel on your
Home Page.

* Quick Edit: Select Quick Edit from the plan's
contextual menu. On the right side of the screen,
the plan details form appears, condensed to one
column. Scroll up and down for the plan fields.
Click the Expand icon to open a larger view of
the plan details form. The form is editable and
your edits save automatically.

» Shared With: Click Shared With from the
contextual menu to quickly access a plan's
Shared With form. The Shared With form lists all
of the users who have access to a particular plan,
along with their plan-level permissions.
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Comments: Click Comments to add a comment
or access an existing comment thread for that
plan.

Dependencies: Click Dependencies to access

the plan dependencies form. From this form, you

can view and manage dependencies between
your various plans. See Portfolio Dependencies:

Manage Dependencies Between Plans for

instructions on how to manage these inter-plan

dependencies.

Reorganize: Click Reorganize to reorganize the

selected plan anywhere in your OnePlan group.

Using the Reorganize function, you can change

the plan type of the plan, and its place in

your OnePlan hierarchy. The Reorganize function

does not retain any historical information about

the plan's previous type or location. It is simply a

"lift-and-shift" function.

Details: Click Details to jump directly to the

selected plan's Plan Details Form.

Financials: Click Financials to jump directly to

the selected plan's Financial Plan.

Resource Plan: Click Resource Plan to jump

directly to the selected plan's Resource Plan.

Work Plan

« List: Click List to jump directly to the selected
plan's Work Plan List view.

* Board: Click Board to jump directly to the
selected plan's Work Plan Board view.

Reporting

» Status Reports: Click Status Reports to jump
directly to the selected plan's Status Reports.

* Visualize: Click Visualize to jump directly to
the selected plan's Visualizer.

* Insights: Click Insights to jump directly to the
selected plan's Plan-Level Insights page.

* Dashboard: Click Dashboard to jump directly
to the selected plan's Power Bl Reporting
Dashboard.

Delete: Click Delete to access the Delete and

Archive form. Here, you can either completely

delete the selected plan (including all associated

data), or archive the plan, which enables your

administrator the ability to restore that plan at a

later date.

See Delete or Archive a Plan for more

information.

Create a New Plan

You can use the New Item icon @ in the Plans
section of the Home Page to create a new plan.
See Create a New Plan for more information.

UL

Home Page Recent

Conversations

This article explains how to use the Recent
Conversations section of your OnePlan Home
Page.

The conversation threads on your home page come
from the work items that are relevant to you, so you
can quickly get updates on your work.

1y

Recent comments update on the
Home Page

Comments made on your work items in the plan will
automatically update in the Recent Conversations
panel on the home page.

®-

Add to the Conversation

You can quickly add to a conversation from your
home page.
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Click View Thread to see the entire conversation.

Then type in your comment in the field and
press Enter. The new comment will appear in the
conversation on your home page and in the plan
itself.

Remove Comments

To remove a comment from a thread, simply click
Remove. Then confirm the removal.

Commastieg®x  CommantingOn

Go to the related work plan

You can jump right to a plan from a comment. Click

View Item to go to the related plan.

Home Page Due Soon

This article explains how to use the Due Soon
section of your OnePlan Home Page.

The Due Soon panel on your home page gives you

a quick view of upcoming and overdue tasks.

Due Soon

Overdue This Week This Month
Name Due
OnePlan Overview Quiz 02/04/2022
My Work Quiz 02/04/2022

Overdue Tab
The Overdue tab lists all of your tasks that have
due dates in the past.

Due Soon

Overdue This Week This Month
Name Due
OnePlan Overview Quiz 02/04/2022
My Wark Quiz 02/04/2022

This Week Tab
The This Week tab lists all of your tasks that have
due dates in the next 7 days.
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Due Soon

QOverdue This Week This Month [ ]
MName Due

(O Home Page Panels 02/18/2022

(O ©OnePlan Home Page Quiz 02/18/2022

This Month Tab

The This Month tab lists all of your tasks that have
due dates in the next 30 days.

Due Soon
Overdue This Week This Month ;
MName Due

() OnePlan Timesheet Quiz 02/25/2022

(O Home Page Panels 02/18/2022

(O OnePlan Home Page Quiz 02/18/2022

() OnePlan Overview Quiz 02/04/2022

O My Work Quiz 02/04/2022

Mark Tasks Complete

You can mark tasks complete by checking the
check box next to the desired task.

Due Soon

Overdue  ThisWeek  This Month 1T
MName Due

() OnePlan Timesheet Quiz 02/25/2022

Q Home Page Panels 02/18/2022

() OnePlan Home Page Quiz 02/18/2022
My Work Quiz 02/04/2022

Access All of your Work

You can access all of your work items in the My
Work area by clicking the briefcase icon.

Due Soon

Overdue This Week This Month

Name Due

() OnePlan Timesheet Quiz 02/25/2022
(O Home Page Panels 02/18/2022
() OnePlan Home Page Quiz 02/18/2022
O My Work Quiz 02/04/2022

Notifications
This article explains OnePlan notifications.

NOTE

To manage your notification
settings, see Manage Resource
Notification Settings [253].

K

NOTE

System notifications will not be
sent to users marked as inactive.

K

Notifications are located in the header menu

in OnePlan. A blue dot will appear next to

the Notifications icon when you have a new
notification. If you have more than one notification,
the blue dot will be labeled with the total number of
unread notifications. You will also receive an email
with the notification.

Tina Shirk -~

ONEPLAN ¥
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Maotifications

¥ Systen: W)

Welcome to the stifications, There is now a new interface as well as system

notification support.

Types of Notifications

OnePlan will push out system notifications when
there are updates to the system such as releases,
scheduled maintenance, etc.

Depending on your organization's OnePlan
configuration and your role, you can receive the
following interface notifications:

* Welcome to OnePlan: You will receive this
notification when you begin using OnePlan.

* You have been invited to OnePlan: You will
receive this notification when you are invited to a
OnePlan group.

» {From.Name} has shared the {Plan.Name}
plan with you: You will receive this notification
when someone shared a plan with you.

* New comment: You receive a new comment
notification when someone makes a comment on
one of your tasks.

You will receive a new comment notification in the

following scenarios:

* If you start a comment/thread, you will receive
notifications about comments on that task/
thread going forward.

* If you have previously commented on a task,
you will receive notifications about comments
on that task/thread going forward.

* If you are a resource assigned to a task that is
commented on, you will get a notification about
that comment.

« If you are a plan owner and someone
comments on your plan, you will get a
notification about that comment.

* If you are a plan owner and a task in your plan
is commented on, you will get a notification
about that comment.

+ Update {Plan.Name} plan in OnePlan: You will
receive this notification when you need to update
tasks.

* Time off requested: You will receive this
notification if you are an approver and someone
has submitted a time off request. See Time
off request notifications and approvals for

more information on who should receive these
notifications.

Time off approved: You will receive this
notification when your time off request has been
approved.

Resource requested: You will receive this
notification if you are a resource manager and
someone has requested a resource for a task.
Resource request approved: You will receive
this notification if your resource request has been
approved.

Resource request rejected: You will receive this
notification if your resource request has been
rejected.

New status reports: You will receive this
notification when there is a new status report
available for you to review and submit.

32 @ OnePlan



Using OnePlan

Enter Time on My Timesheet

This article explains how to enter time using the
OnePlan timesheets.

K

NOTE

Resources must be assigned a
role to import timesheet hours into
the resource plan.

Access Your Timesheet

Click on the Timesheets icon in the navigation.
You will begin in the "Time Entry" mode. This is
where Team Members track time on their work
assignments.

Any items that are assigned to you and are
scheduled during the current time period will
automatically load into your timesheet the FIRST
TIME you open the timesheet for that period. You
will need to import or add additional timesheet
times the next time you log into your timesheet.

-

.

Change Timesheet Periods

When you first go to your timesheet, you'll navigate
to the current timesheet period. If needed, you may
navigate to another timesheet period.

Click on the period dates. A drop down will show all
open/unlocked timesheet periods. If the admin has
locked a period, you can no longer navigate to it.

Aug 8, 2021 - Aug 14, 2021 }« [m@ »

il
<

Aug 8, 2021 - Aug 14, 2021

Aug 22, 2021 - Aug 28, 2021
Aug 29, 2021 - Sep 4, 2021 SUN 8 N
Sep 5, 2021 - Sep 11, 2021

Sep 12, 2021 - Sep 18, 2021

Sep 19, 20

(%]

1-Sep 25, 2021
Sep 26, 2021 - Oct 2, 2021

Oct 3, 2021 - Oct 9, 2021

Use the period navigation icons to quickly move to
the previous period, the current/"today" period, or
the next period.

My Timesheet | Aug 8, 2021 - Aug 14, 2021 “

Copy or Import Timesheet Iltems

The OnePlan timesheet allows you to import any
work items that are assigned to you to make
management of your tasks easy. Additionally,
the OnePlan timesheet allows you to copy

your timesheet from one time period to another
to simplify management and time tracking on
repetitive tasks.

To copy or import timesheet items into your
timesheet:

1. Click the Copy Timesheet icon .
2. Select the desired copy or import method:

» Copy From Previous Period: Select to
copy items from the previous timesheet
period into the current timesheet period. This
will overwrite any existing entries for this
period.
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3.

+ Copy To Next Period: Select to copy items
from the current timesheet period to the
next timesheet period. This will overwrite any
existing entries for that period.

* Import from Tasks: Select to import any
tasks to your timesheet you are currently
assigned to for the current period.

» Import from Resource Plan: Select to
import items that have been assigned to you
in the Resource Plan. This will overwrite any
existing entries for that period.

K

NOTE

The timesheet will
automatically import any
tasks assigned to you the
FIRST TIME you access the
timesheet for the current
period. After the first time, you
will need to use the Import
from Tasks or Import from
Resource Plan functions to
bring in any additional tasks
that are assigned to you in the
current timesheet period.

Click YES on the warning pop up to confirm the

copy.

K

NOTE

If using the Import from
Resource Plan method, check
the "Include hours in import"
check box to import hours
from the Resource Plan into
the timesheet.

IMPORTANT

When copying work items from

one period to another, work items
that are no longer assigned to

you (and the plan is set to only
allow adding time to assigned work
items) will not be copied.

Add Tasks and Work Items to Your
Timesheet

IMPORTANT

If a Plan is open to the team

or assigned to specific individuals,
only team members or those
assigned to the plan will have

the ability to add time. This
restricts access for Managers and
Owners, ensuring that time entry
is limited to those directly involved
with the Plan, contributing to a
more focused and controlled time-
tracking process.

There are multiple methods to add a task to your

timesheet.

Add Timesheet Items Using the Add
Item Button from the Header

1. Click the Add Item icon @ . The Add Tasks
window will open.
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2. Search for and select the desired plan. Either
type in the plan name into the Find Plan field,

or select a plan from the list of plans. The Task

section of the form will populate with all of the
available tasks from the selected plan.

3. Search for and select the desired task. Either
type in the task name into the Find Task field,
or select a task from the list of tasks.

K
K

NOTE

You can select multiple tasks
to add into your timesheet.

NOTE

The timesheet interface
excludes check boxes next

to work items, like summary
tasks, that cannot be added to
your timesheet.

4. Click Add Task(s) to add the selected task(s)
to your timesheet.

Add Timesheet Items Using the Add
Item Bar at the Bottom of the
Timesheet

1. Search for or select the desired plan. Either
type in the plan name into the Select Plan
field, or open the drop down menu and select a
plan from the list of plans.

2. Select the desired task from the Select Tasks
drop down menu. When a task is selected, it
will be added to your timesheet.

S NOTE
Tasks that are eligible to be

added to your timesheet have

a paper icon next to them .
Summary tasks, which cannot
be added to your timesheet,
have a folder icon next to

them =. When a summary
task is collapsed the folder
icon is closed, indicating there
are child tasks below the item
I
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Submit Your Timesheet

Once your timesheet is complete, you need to
submit it for review.

1.  Check the check box next to the timesheet
rows you would like to submit for review.

= 2. Click the Submit icon = in the timesheet

~ | header. The selected timesheet rows will be
sent off to your timesheet manager for review
and approval.

Track Time in Your Timesheet

Now that you have all of your tasks in your .o
timesheet, you need to enter the time you actually

spend on these tasks.

1. Click into the desired date cell for a timesheet
item. When you click in a cell, the task info
pops open on the right side with the following:
Plan, Task, Date, Hours, and Notes. Enter your
time value directly into the cell or into the
Hours field in the task pop up on the right.

" S NOTE
_ —— Once a row is submitted, it is

no longer editable. If needed, you
may select the row and click

Recall ™ to edit.

2. Some timesheet entries require you to provide s
additional information about your entries, such
as the Charge Type (indicating whether your
time entries for that task are chargeable or
not). Select the appropriate values for the
additional fields if required.

@ NOTE
Additional fields vary by

organization and are setup by Recall Your Timesheet

your administrator. If you have submitted your timesheet for review, but
need to make changes, you can recall timesheet
rows to edit your entires;

NOTE

You cannot recall approved

3. Once your time entries are complete, submit timesheet rows.

your timesheet for review.
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1.  Check the check box next to the timesheet
rows you would like to submit for review.

[
El

2. Click the Recall icon —. Confirm that you want

to recall the selected timesheet items. Once
confirmed, the selected timesheet row(s) will
be recalled and become editable.

Recall Items x

9 Are you sure you want to recall those items? This will stop the workflow for those items

1

3. Once your edits are complete, resubmit the
edited timesheet rows.

View the Timesheet Workflow Status

S NOTE
Based on your organization,

timesheets may be set to auto-
approve.

When your timesheet manager has approved or
rejected your timesheet entries, you will see the
updated status icon in your timesheet. Click on
the icon to see the workflow status and any
approval/rejection notes. Then, if required, recall
any rejected timesheet items and update the
timesheet accordingly.

Use the Stopwatch to Record

Time in Your Timesheet

This article explains how to use the stopwatch
feature of the timesheet to record time.

1. To start the stopwatch, click the stopwatch icon

next to the desired task. Then confirm that
you would like to start the stopwatch.

S NOTE
There can only be one active

stopwatch at a time. Starting a
new stopwatch will cancel any
previous stopwatches.

Confirmation x

2.  Work on your task. You can navigate away
from or close the OnePlan tab. The stopwatch
will continue to record time.

3. To stop the stopwatch, click the highlighted

stopwatch icon ©. Then confirm that you would
like to stop the stopwatch. The time recorded
by the stopwatch will populate the timesheet
for the selected task and current date.
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Confirmation b 4

9 Are you sure you want to stop this Stopwatch?

Change Timesheet Periods

When you first go to your timesheet, you'll navigate
to the current timesheet period. If needed, you may
navigate to another timesheet period.

Click on the period dates. A drop down will show all
open/unlocked timesheet periods. If the admin has
locked a period, you can no longer navigate to it.

Aug 8, 2021 - Aug 14, 2021 |« [m@ »

Aug 22, 2021 - Aug 28, 202

Aug 29, 2021 - Sep 4, 202 SUN 8 A
Sep 5, 2021 - Se 202

Sep 12, 2021 - Sep 18, 2021

Sep 19, 2021 - Sep 25, 202

Sep 26, 2021 - Oct 2, 202

Use the period navigation icons to quickly move to
the previous period, the current/"today" period, or
the next period.

My Timesheet = Aug 8, 2021 - Aug 14, 2021

Copy or Import Timesheet Iltems

The OnePlan timesheet allows you to import any
work items that are assigned to you to make
management of your tasks easy. Additionally,
the OnePlan timesheet allows you to copy

your timesheet from one time period to another
to simplify management and time tracking on
repetitive tasks.

To copy or import timesheet items into your
timesheet:

1. Click the Copy Timesheet icon
2. Select the desired copy or import method:

+ Copy From Previous Period: Select to
copy items from the previous timesheet
period into the current timesheet period. This
will overwrite any existing entries for this
period.

» Copy To Next Period: Select to copy items
from the current timesheet period to the
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next timesheet period. This will overwrite any
existing entries for that period.

* Import from Tasks: Select to import any
tasks to your timesheet you are currently
assigned to for the current period.

* Import from Resource Plan: Select to
import items that have been assigned to you
in the Resource Plan. This will overwrite any
existing entries for that period.

K

NOTE

The timesheet will
automatically import any
tasks assigned to you the
FIRST TIME you access the
timesheet for the current
period. After the first time, you
will need to use the Import
from Tasks or Import from
Resource Plan functions to
bring in any additional tasks
that are assigned to you in the
current timesheet period.

3. Click YES on the warning pop up to confirm the

copy.

K

NOTE

If using the Import from
Resource Plan method, check
the "Include hours in import"
check box to import hours
from the Resource Plan into
the timesheet.

IMPORTANT

When copying work items from

one period to another, work items
that are no longer assigned to

you (and the plan is set to only
allow adding time to assigned work
items) will not be copied.

Add Tasks and Work Items to
Your Timesheet

There are multiple methods to add a task to your

timesheet.

Add Timesheet Items Using the Add

IMPORTANT

If a Plan is open to the team

or assigned to specific individuals,
only team members or those
assigned to the plan will have

the ability to add time. This
restricts access for Managers and
Owners, ensuring that time entry
is limited to those directly involved
with the Plan, contributing to a
more focused and controlled time-
tracking process.

Item Button from the Header

1. Click the Add Item icon @ . The Add Tasks

window will open.

@ OnePlan
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Search for and select the desired plan. Either

type in the plan name into the Find Plan field,

or select a plan from the list of plans. The Task

section of the form will populate with all of the
available tasks from the selected plan.

At Tasks

3. Search for and select the desired task. Either

type in the task name into the Find Task field,

or select a task from the list of tasks.

K
K

NOTE

You can select multiple tasks
to add into your timesheet.

NOTE

The timesheet interface
excludes check boxes next

to work items, like summary
tasks, that cannot be added to
your timesheet.

4. Click Add Task(s) to add the selected task(s)
to your timesheet.

Add Timesheet Items Using the Add
Item Bar at the Bottom of the
Timesheet

1. Search for or select the desired plan. Either
type in the plan name into the Select Plan
field, or open the drop down menu and select a
plan from the list of plans.

2. Select the desired task from the Select Tasks
drop down menu. When a task is selected, it
will be added to your timesheet.

S NOTE
Tasks that are eligible to be

added to your timesheet have

a paper icon next to them .
Summary tasks, which cannot
be added to your timesheet,
have a folder icon next to

them =. When a summary
task is collapsed the folder
icon is closed, indicating there
are child tasks below the item
(i
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S NOTE
Once a row is submitted, it is

no longer editable. If needed, you
may select the row and click

Recall © to edit.

o 3 -
FE— |
Recall Your Timesheet
If you have submitted your timesheet for review, but
Submit Your Timesheet need to make changes, you can recall timesheet
Once your timesheet is complete, you need to rows to edit your entires;

submit it for review.

1.  Check the check box next to the timesheet
rows you would like to submit for review.

2. Click the Submit icon = in the timesheet
header. The selected timesheet rows will be
sent off to your timesheet manager for review
and approval.

NOTE

You cannot recall approved
timesheet rows.

Check the check box next to the timesheet
rows you would like to submit for review.

L =]

1

Click the Recall icon =. Confirm that you want
to recall the selected timesheet items. Once
confirmed, the selected timesheet row(s) will
be recalled and become editable.

Recall Items x

9 Are you sure you want to recall those items? This will stop the workflow for those items.

@ OnePlan
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Navigate to Timesheets
- Click on the Timesheets icon in the navigation.
'_ == s You will begin in the "Time Entry" mode. This is
| == where Team Members track time on their work
- assignments. To switch to Approval mode, select
the desired approval view.

3.  Once your edits are complete, resubmit the

edited timesheet rows. g My Timesheet | sepa-sep14 « @ »
Make a Comment on a Task or JL AR
Project from the Timesheet = T |ty mosoucg, |
To make a comment on a task or project from the . [l Fabrikam | Avprovals by Plan
timesheet: )% P Approvals - Detail Grid -
=l

Develop Strategies and Plans

1. Click the Comments icon. The Comment
window will open.

Select Items to Approve or Reject
S NOTE Select one or multiple items to approve or reject. A
You can view all previous comments window will open.
comments on the task or
project in the Comment M TiRRERE | il e
window.

2. In the Comment window, enter your comment.
3. Press Enter to submit your comment.

o D Development complete

Commenting On:
terface to support Rest AP

opment complete

Plan: e
Task: D

Review and Approve

Timesheets

This article explains how to use the Timesheets
feature as a Manager, someone who is reviewing
and approving time tracked on plans & tasks.
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porovals by Resource

MAME HARGE TYPE

Fabrikam
@ Conduct Peer Review
0 e Develop Strategies and Plans

Approvals by Resource View

In the Approvals by Resource view, you will see
any time submitted for users whom you are the
Timesheet Manager. Only pending approvals show.

uuuuuuuuuuuu

Approvals by Plan View

In the Approvals by Plan, you will see any plans
for which you are a Plan Owner. Only pending
approvals show.

Approvals - Detail Grid View

The Approvals - Detail Grid view shows items
pending approval, and includes a column for the
manager approval and the planner approval.

= Support Customers using Ma...

= Heali 65

Timesheet Delegates

Act as Delegate

If you are a delegate for another user, you may
view and edit their timesheet on their behalf. The
user profile photo shows for whose timesheet
you see. Click on the photo to see a list of

your delegated users and select another user's
timesheet, if able and needed.

My Timesheet

Sep8-Sep 14 4 .

lime Entry

Assign Delegates

If enabled, you may be able to assign your

own delegates. Click on your user profile picture.
Select My Delegates. Enter any names for Entry
Delegates & Approval Delegates (Anything for
which you are the approver will be delegated to the
approval delegate(s) you assign).

o =

g‘ e My Delegates x
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Administer Timesheets

This article explains how to administer timesheets.
You must be a Timesheet Administrator to
administer timesheets.

If you are set as a Timesheet Administrator in
your OnePlan environment, you will have access
to additional Administer Timesheet and Unlock
options in your timesheet.

My Timesheet = Aug 1, 2021 - Aug 7, 2021 4 "
L] = Time Entry ~ H -
e » Total
y D =)
HARG

1. Click the user icon in the left-corner,
then select Administer Timesheets. The
Admininster Timesheets form will open.

3

[

2. Enter the name of the user whose timesheet
you would like to access. Available users will
appear as typeahead search results. Select the
desired user.

3. Click Administer.

Administer Timesheets x

£

You will be redirected to the user's timesheet. As
a Timesheet Administrator, you have full access to
edit the user's timesheet as needed for accurate
reporting.

Unlock Timesheet Rows

This article explains how to unlock timesheet rows
after they have been locked. You must be a
Timesheet Administrator to unlock timesheet rows.

If you are set as a Timesheet Administrator in
your OnePlan environment, you will have access
to additional Administer Timesheet and Unlock
options in your timesheet.

My Timesheet = Aug 1, 2021 - Aug 7, 2021 4 "
L] = Time Entry ~ H -
e » Total
y Delega
HARG

1. Go to the desired timesheet. See Administer
Timesheets for instructions on accessing
another users timesheet.

Select the timesheet rows you would like to
unlock. Then click Unlock.

3. Click Yes in the pop-up to confirm that you
would like to unlock the selected rows.

Unlack ltems x

e A yau sure you want to unkock those items? This will stop the waekflow far those items

The timesheet rows are now unlocked and editable.
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My Work

My Work overview

This article provides a brief overview of My

Work. The My Work feature is designed for Team
Members to view and update all work assignments
on a single page. The Plan Owner will see the
updated values when they look at the plan schedule
and elsewhere (reports, etc.).

My Work allows users to manage work in a List,

a Board, and in a personal Resource Plan. From
these views, users can group, filter and sort their
work items, view work in a gantt chart, save custom
view configurations, add activities to work items,
add new work items, update work items, and enter
time off.

NOTE

The work items that appear in My
Work are based on the tasks date.
My Work only shows work items
with dates from past or the next 30
days.

K

NOTE

If you are assigned to any activities
from the work plan, the parent task
will show in My Work.

K

Access My Work

Click the My Work icon in the main navigation
menu to access My Work. The List view will open
by default.

Manage work in the List, Board, or

Resource Plan

The List is the main way to manage your work
items in My Work. See Manage My Work in
lists [52] to manage work in the list.

Users can also manage work in a kan ban

board view. Click Board. For more information on
managing work in the board view, see Manage My
Work in boards [55].

Users can also view personal resource plan in My
Work to see which plans you should be working
on and if you are over or under allocated. Click
Resource Plan to view your personal resource
plan. See View your personal resource plan in My
Work [56] for more information.

Typical actions in My Work

The following are typical actions a Team Member
will take when using My Work.

For more information on how to use all of the
components of My Work, see Manage My Work in
lists [52], Manage My Work in boards [55], and
View your personal resource plan in My Work [56].

Group, filter, sort, and arrange work

items

To narrow and organize the work items in My Work,
use the group, filter, sort, and column functions.

Modify views
Make any changes to the view, such as adding
columns, arranging columns, etc.

Add or remove columns

Right-click a column header
To add or remove a column:

1. Right-click in any column header. Expand the
Columns sub-heading.

K

NOTE

The columns already in the
view marked with a check.
The remaining available fields
are listed.

2. Select or deselect the columns to show or hide
in the view. Newly added columns show on the
far right.
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Select Columns button
To add or remove columns: o - Group By: Plan *

1. Click Select Columns. The Select Columns None
form will open.

2. To add columns to the view, drag and drop
desired columns from the All Columns column

a2

into the Selected Columns column.

3. Toremove a column, drag and drop the )
desired column from the Selected Columns '
column into the All Columns column. O B

Select Columns B
B
All Columns | Selected Columns
Actual Cost Name < B sk Stat
Actual Finish % Done
Actual Revenue Status
| :“7”“ — | Da" Filter work items
T ; . Click the Filter icon to sort the Work ltems by a
Baseline Effort field.

Baseline Remaining Effort

Baseline Start

Arrange column order

To arrange the columns, click on the column
heading and drag the column to the desired
location. Let go of the mouse to drop the column
in that spot.

A i

Sort columns

Click on the column header so sort the column in
ascending or descending order.

Group work items

Select a grouping category from the Group By drop
down to group the work items.

@ OnePlan
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Update work item information
Click into and update any field in line that's editable,
such as % Done, Status, etc.

el FIlLEer: ' @ NOTE
Some fields are auto-updated

based on the values of others,
such as the Status and % Done.
If you update the Status from Not
Started to In Progress, the %
Done goes from 0% to 50%, and

¥ vice versa.
Il 4 Enter a time off request
Click Time Off to enter a time off request. See
' Enter a time off request [48]for more information
r on entering a time off request.

Enter a time off request

P This article explains how to enter a time off request.
Time off in OnePlan will update the resource pool to
allow for accurate scheduling.

i ! If you are an approver, see Time off request
notifications and approvals.

1. Go to My Work.
1 2. Click Time Off. The Time Off window will
open.

4’
B [ | 3 o0

3. Click Add Time Off. The Add Time Off form
will open.

Mark a work item "complete”

Select the check box to mark an item as complete.
Status will update to Completed and % Done will
update to 100%.

Once you have updated the task and the Project
Manager has accepted the changes there will be an
approval status indicator. This makes it easy to see
if the status updates have been approved.
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Time Off x

@ Add Time Off

Complete the Add Time Off form.

Select Resource: Only editable for Owners
and Managers. Search for and select the
resource to create a time off request for. For
Team Members, this field will be auto-filled
with your name.

Category: Select the time off category.
These categories are configured by your
OnePlan administrator.

Start: Select the time off start date.

End: Select the time off end date.

Hours Per Day: Select the number of time
off hours per day within the set date range.
Notes: Enter any notes that the approving
manager may need.

Status: Only available for Owners and
Managers. Select the status of the time off
request upon submission. Options include
Approved, Requested, and Rejected.

Add Time Off ®

Approved

SAVE

5. Click Save. The time off request is now
submitted. In the Time Off window, you will see
a list of all of your time off requests and their
statuses.

Time Off x

& Add Time Off

Add a work item in My Work

This article explains how to add work items in My
Work.
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NOTE
Users need at least a Team

Member Plus license to add items
from My Work. Task Information -

Mame: Secure praject sponsorship
Task Status:

Status: Completad
Work items created in My Work will go back into the
schedule for the Project Manager. These items will
automatically be assigned to you.

Priotity:

Task Description a

Description:

The items that can be added are defined by the

system administrator. An example of some out of 6
the box items are Tasks, Backlog, Risks, Issues,

Changes, and Key Decisions.

To add a work item:

1. Click New Item and select the item type from 10 Task Schedule -
the drop down. The Add New [Item] form will .. Start

Open. Due:
2. Complete the Add New [Item] form. y
* Plan: Select the plan where the new item 1
should be added. RS
» Name: Enter the name of the new work item. 7 Bones

Actual Start: 0212472020

Add New Tasks x 1¢ Task Effort -
Effort:
Timesheet Hours:
@ NOTE
3. Click ADD ITEM. The item information form will The item information form will
open. look different depending on
4. Complete the item information form with the work type you chose in
necessary information. step 1.

The new work item will appear in your My Work List
and Board, and be added to the designated plan.

Create and edit views in My
Work

This article explains how to create and edit views in
the My Work List view.

Modify views
Make any changes to the view, such as adding
columns, arranging columns, etc.
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Add or remove columns

Right-click a column header
To add or remove a column:

1. Right-click in any column header. Expand the
Columns sub-heading.

K

NOTE

The columns already in the
view marked with a check.
The remaining available fields
are listed.

2. Select or deselect the columns to show or hide
in the view. Newly added columns show on the
far right.

Select Columns button
To add or remove columns:

1. Click Select Columns. The Select Columns
form will open.

2. To add columns to the view, drag and drop
desired columns from the All Columns column
into the Selected Columns column.

3. Toremove a column, drag and drop the
desired column from the Selected Columns
column into the All Columns column.

Select Columns

All Columns | Selected Columns
Actual Cost Mame

Actual Finish : Done

Actual Revenue Status

Actual Start Start

I Baseline % Done I Due

1e Due : Complete

aseline Effort

temaining Effort

Arrange column order

To arrange the columns, click on the column
heading and drag the column to the desired
location. Let go of the mouse to drop the column
in that spot.

Save a view

Make any changes to the view, such as adding
columns, arranging columns, etc.

1.  On the View menu, select Save View. The

Save View form will open.

2. Complete the Save View form.

a. View Name: Initially, the current view
name will show. Update to a new name. If
updating a view rather than saving a new
view, keep the name as-is.

b. Default View: Check the checkbox if this
is a default view. A default view will open
automatically when you go to the Work
Plan.

c. Personal View: Check the checkbox if
this is a personal view. It is checked by
default. Administrators may save a view as
a global view for the group by deselecting
the checkbox.

Delete a view
Navigate to the view you want to delete.

1.  On the View menu, select Delete View.
Deleting a global view deletes it for everyone.
2. Confirm deletion.
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Manage My Work in lists

This article explains how to manage My Work work
items in the List view.

The List is the main way to manage and update
assigned work items in My Work. From the List
view, users can manage work items, create new
work items, add activities to work items, view work
in a gantt chart, and enter time off.

See My Work overview [46] for a brief overview of
My Work.

Mark a work item "complete™

Select the check box to mark an item as complete.
Status will update to Completed and % Done will
update to 100%.

Once you have updated the task and the Project
Manager has accepted the changes there will be an
approval status indicator. This makes it easy to see
if the status updates have been approved.

Update work item information

Click into and update any field in line that's editable,
such as % Done, Status, etc.

K

NOTE

Some fields are auto-updated
based on the values of others,
such as the Status and % Done.
If you update the Status from Not
Started to In Progress, the %
Done goes from 0% to 50%, and
vice versa.

Add a new work item

K

NOTE

Users need at least a Team
Member plus license to add work
items from My Work.

Click Add New Item to add a new work item to

a plan in My Work. Work items created in My

Work will automatically be assigned to the user who
created them.

See Add a work item in My Work [49] for more
information on creating work items in My Work.

Enter time off

See Enter a time off request [48] for instructions
and information entering time off.

View and add activities to work items
Select a work item in the List view. Then click
Activities to view the activities for that work item.
There is an activities button in the header, or next to
the work item title.

Add a new activity
There are two ways to quickly add a new activity for
a task:

» Using the Add Activity field.

1. Enter the name of the new activity in the
field.

2. Press Enter. The new activity will be added
to the farthest left column of the activities
board (typically "Not Started").

» Using the Add Task button.

. Click the Add Task button in the desired
column. The new activity will be added to the
bottom of the column.
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Newly added activities are blank. To add
information to the activities:

1. Double click the activity. The Edit task form will
open.

Edit task x

NAME | New task

2. Update the Edit task form.
+ Name: Enter the name of the activity.
» Description: Enter a description of the
activity.
* Resources: Search for and select users to
assign the activity.
+ State: Select the state the activity is in.
3. Press Enter to apply the changes.

Show gantt

The gantt view allows team members to better
visualize the timeline of when work needs to be
completed. The buttons to the right of the gantt
allow for zooming in and zooming out along with
Zoom to Fit.

Group, filter, sort, and arrange work

items

To narrow and organize the work items in My Work,
use the group, filter, sort, and column functions.

Modify views
Make any changes to the view, such as adding
columns, arranging columns, etc.

Add or remove columns

Right-click a column header
To add or remove a column:

1. Right-click in any column header. Expand the
Columns sub-heading.

K

NOTE

The columns already in the
view marked with a check.
The remaining available fields
are listed.

2. Select or deselect the columns to show or hide
in the view. Newly added columns show on the
far right.

Select Columns button
To add or remove columns:

1. Click Select Columns. The Select Columns
form will open.

2. To add columns to the view, drag and drop
desired columns from the All Columns column
into the Selected Columns column.

3. To remove a column, drag and drop the
desired column from the Selected Columns
column into the All Columns column.

Select Columns

All Columns | Selected Columns
Actual Cost Name

Actual Finish & Done

Actual Revenue Status

Actual Start Start

| ow

: Complete

I Baseline % Done

eline Effort

Baseline Remaining Effort

Baseline Start
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Arrange column order

To arrange the columns, click on the column
heading and drag the column to the desired

location. Let go of the mouse to drop the column

in that spot.

A i

jar b
Sort columns
Click on the column header so sort the column in
ascending or descending order. b
Group work items
Select a grouping category from the Group By drop
down to group the work items. 1301 P
e - Group By: Plan +* A b
v ¥ 5l b
sact i & i h
B
Bi ) EStL k
D Bi
B 15k Stat I tatu k
Filter work items
Click the Filter icon to sort the Work Items by a Use, create, and manage views

field.

Click Views to open the drop down. You can
select a saved view, or create and save your own
personal view. See Create and edit views in My
Work [50] for more information on views.

54
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Manage My Work in boards

This article explains how to manage work items in

the My Work Board.

The Board presents assigned work items in a
Kanban board view.

Move items in the board

To move items in the board, drag and drop the
desired card into the desired location. This will
update the status of the item in the plan.

Edit work item information
To edit work item information:

1. On the desired work item card select the

K

NOTE

Due to column and lane selection

some drag options may not be
available. You may only drag items
between statusable columns or
lanes.

gl D
[Hed]

ellipses > Quick Edit. The quick edit form will

open.

2. Update the item information as required. The

changes will auto-save.

Modify the Board View

Configure the board Columns and
Lanes

Filter work items
Filter the work items that appear in the board view.

To apply filters:

1. Click Filter

2. Select and set the desired filter(s). A check
mark appears next to selected filters.

N

NOTE

The Filter icon is blue when
filters are applied.

3. To remove filters:
* Uncheck selected filters to clear individual

filters.

* Click Clear Filters to clear all filters.

Select the fields from the Column and Lane menus

to create the columns and lanes in the board.

@ OnePlan
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Configure work item card information

Select the information that appears on the work

item cards.

1. Click Select Columns /. The Select
Columns form will open.

2. To add a column to the work item cards,
drag the desired column from All Columns to
Selected Columns.
To remove a column from the work item card,
drag the column from Selected Columns to
All Columns.

3. Click OK to update the work item cards.

[

|

[

Save a view

Make any changes to the view, such as adding
columns, arranging columns, etc.

1.  On the View menu, select Save View. The
Save View form will open.
2. Complete the Save View form.
a. View Name: Initially, the current view
name will show. Update to a new name. If

updating a view rather than saving a new
view, keep the name as-is.

b. Default View: Check the checkbox if this
is a default view. A default view will open
automatically when you go to the Work
Plan.

c. Personal View: Check the checkbox if
this is a personal view. It is checked by
default. Administrators may save a view as
a global view for the group by deselecting
the checkbox.

View your personal resource
plan in My Work

This article explains how to view your personal
resource plan in My Work.

The personal resource plan allows users to see
which plans they should be working on and if they
are over or under allocated.

Access your personal resource

1. Go to My Work.
2. Click Resource Plan. Your resource plan will
open.

Use your personal resource plan

Select the cost type

Select which cost type you would like to review
in your resource plan, such as Scheduled or
Committed.
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NOTE

OnePlan administrator and will
vary.

Scheduled -

P o e e |
o -t
-

L o N T |

Select the planning mode

Cost types are configured by your

Add or remove columns
You can add or remove columns in the left pane of

the resource plan.

1. Click the arrow next to a column header to

open the column menu.

2. Go to Columns, and select or deselect the
desired column(s).
Columns in the view have a check mark next to
them.
Click on selected columns again to remove

them from the view.

Select the planning mode you would like to review
your resource plan in. Options include Hours, %

(percent), and FTE (full time equivalent).

Hours -

Resource

FJ ¥ Product Development

o8 Tina Shirk

Move columns

To move a column, drag and drop the desired
column header into a new location.

NOTE

You can only move columns in the
left pane of the resource plan.

@ OnePlan
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Totals

Resource | Role =
Scheduled
EE * Product Development
Q Tina Shirk Developer
Totals
Resource | Role
Scheduled
[ +* Product Development
2 Tina Shirk Developer

Sort columns

Click on a column header to sort. You can toggle
between ascending and descending order.

You can also click the arrow next to a column
header to open the column menu, then select Sort
Ascending or Sort Descending.

Resource T *  FRole

[E * Product Development

ol Tina Shirk |2 sort Descending

Set the date range
To set the date range you would like to view in the
resource plan:

Go to the filters icon > Dates, then set the date
range using the dates form. You can select a date
range preset, or set a custom range.

Apply filters
Go to the filters icon > Filter, then select the
desired filter(s) from the menu.

Click Clear Filters to remove all filters in the view.

—?T - = v
tlan 2022 - Jan 2023 4
| Dates:) : 2022 Mar 2022
. Filter: Off Clear Filtars
Compare To: Capacit » "

4.00
»
56.00
Role >
34.80
Timesheet Manager P
20.00 16.00
atus ¥
84.00 48.00
Siate 4

Compare To
Select the method to compare your resource usage
against.

Go to the filters icon > Compare To, then select the
desired comparison from the menu.

B =~

:Jan2022-Jan 2023 0
| Dates: . 2 2022 Mar 2022 4
. Filter: OFf uled Scheduled Sc

Compare To: Capacity Capacity

Crbad Comrmited

>CNeduled > Lo ied

Select, save, and delete views

To apply a previously saved view, go to the Views
menu, then select the desired view.

» Default / global views are on the top of the
views list. These views can be created by
administrators and are available to all users in
the OnePlan group.

* Personal views are below the global views. All
users can create personal views, and they are
only available to the user who created them.
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View: Resource Plans by Business Unit

Default / global views

ProductDeve "

Personal views

To save a new view:

1.

Go to the Views menu > Save View. The Save

View form will open.

Complete the Save View form.

* View Name: Enter the name of the new
view.

* Default View: Check the check box if the
new view is a default / global view.

* Personal View: Check the check box if the
new view is a personal view.

Click Save. The new view will appear in the

Views menu.

To delete a view:

1.

Go to the Views menu > Delete View. The
Delete View warning will open.

Click Yes to delete the currently applied view.
The view will be removed from the Views
menu.

View team work as a resource

manager in My Work

This article explains how to view your team's My
Work areas as a resource manager.

@ NOTE
You must be set as a "Resource

Manager" in your OnePlan group
to view your team's My Work
areas. See How do | set Resource
Managers?.

As a "Resource Manager", you can access the My
Work area of the users who you manage. This
includes the List, Board, and Resource Plan views
within the other user's My Work.

To access your team's work:

1. Go to My Work.

2. Click on the user icon in the top left corner.
This will open a drop down that displays the
users you manage.

3. Select the desired user. The user's My Work
data will be displayed.

S NOTE
Note the user icon image

changes to the selected user's
avatar.
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Select the Date Period in My
Work

This article explains how to set the date period of
work displayed in My Work.

You can choose the date period of work you want to
see (up to 180 days in the future). To set the date
period:

1. Click the Date Period menu in the My Work
heater.

°- Goaup By Fan = . B v P :‘ =

Comtemar X

2. Using the calendar interface, select a date you
would like to see work items in the future.
Think of this as selecting the end date to a date
range. The date range begins with your oldest
overdue task and will end with the date you
select in the future.

In this example, | selected March 30, 2024, as
the end date for the date range of work items
displayed in my work. You can see that there
are work items listed in my work with due dates
between
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My Ideas

Add and approve Ideas

This article explains how to use Ideas or sometimes
call project intake. An Idea will usually come from
an internal resource. This keeps all ideas in one — ; .

. . . . Plan Type Project
location for approval of possible upcoming projects.
We will go through entering an idea, walk through

the process of approving the idea and then creating Parent Plar D e
the project.

This process is optional depending on your
organization CANCE] REORGANIZE

Add an Idea

In this example we are going to navigate to the light
bulb and click the New button to add a new project
idea or request.

Change Plan Type: Team Collaboration

B e

0

[

Tl

Creating a Project from an Idea

One the approval has been completed a project can
be created. On the view with the hover over the
item and click on the menu. Select Reorganize and
change the Plan Type to Project. Then click the
pencil next to the Parent Plan to select the Portfolio
and Program to associate the project with and click
Select and Reorganize.

Closed Approved
Cloned Appraved

pdat.  Closed Rejected

B |p
.

Closed Approved
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Select Plan

Mame |

v Appeal to a younger demograpriic
Ecommerce Portal Development
Improve and Enhancements

-

Cloud and Mobile First
Improve Infrastructure

Mobile Applications

T
A L

World-Class Customer Support

This will ask one last time to change the plan type,
select Yes. The Idea is now a project to be worked

Tog

boards menu.

et a betterflinderstanding lets go through the

his will be the same for all boards in

the system

1. New ltem@8items can be added directly from
the board

2. Column - @his is the columns shown on the
board

3. Lanes - A@ditional grouping can be done by
creating sf@lim lanes. This one is done by
Priority

4. Color - Thi is the color of the cards. In this
list the onl§ color coding is done by the State
field. For gkample this could show if an item is
Green, Yellow, Red

5. Totals - Infihe column header this example is
showing Wikth the Budget. This can just be a
count of c@rd, click on the dropdown to see all
the availa@e fields

6. Plan Type@ This is showing us we are looking
at the Ided@lPlan Type

7. Filter - Filt@ring can be done on many different
fields. Forfexample | only want to see the
Category fhat equals Security

8. Icon size @The options are Small, Medium,

SELECT

current board is on the Large cards
- Budget Constraints can be set for
ory. For Example | only want to see
s higher than $100,000 dollars

- This allows to add/remove fields
from the cards

After any changes are made to a view make sure

to click Save on the dropdown on the Board menu.

on. You can overwrite the current view or save as a

. new view.
Idea Board Views
The Ideas Board page shows each item in column
swim lanes. You can change your groups and
choose to include/exclude additional fields on the
plan cards.
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Idea Details

Complete the plan details. Your form may have
different fields based on your organization's use

case & configuration. The page is editable and you

may always return to the Details page through the
life cycle of the Idea. The Approval Status field is
used by the Approver.

When you make an update or change, the page will

save automatically.

1edan dmrmasion

[ ——

Idea Name
Enter the name of your project idea of Team
Collaboration and click Add Plan .

Click on the Go To Menu and select Details

Detsils

New

Idea Information
MName: Tear al
State: Proposed
Requested By:
Executive Sponsor:
Business Unit: T
I Priority:
Category:
Goals:
Associated Objectives:

Associated Programs:

Description

Move Idea to the Next Stage

Once all the information has been completed in the
Idea, update the Stage to In Review.

Click on the stage name to visually see the current
stage. The tab color changes to green on the
current stage. Future stages are gray. Previous
stages are blue.

Click on New and click next to move to In Review.
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Step

Status

In Review

Header Menus and Icons

Closed

¢ Add New: Click to create a new idea. See Add

and approve Ideas [61] for more information.

* Plan Type Menu: Select a plan type to view in

the list. Your configuration may have multiple plan

Priority: types in the Ideas area.

I~ abamee

Review Submitted Ideas

Depending on your organization this may be a
committee meeting where a panel reviews the new
Ideas and will put in priority order, or a single
person who reviews the requests. The project can
be selected based on the Prioritization score or the
organizational need.

As they go through and approve, reject or put on
hold they will update the State to Closed, Stage to
Closed and Approval Status to the final decision. If
approved it is time to create a project.

Team Collaboration

New in Raview ’ .-',-.-,e

Manage Requests in the Ideas

area

This article explains how to manage and prioritize
your user requests using the Ideas area.

This article assumes that your admin has
configured the Requests app to create new

ideas when requests are created and submitted.
This will place requests in the Ideas area for
managers to use the more advanced prioritization
and management features to analyze the requests/
ideas.

The Ideas area's management and prioritization
features mimic the features of the Work Planner,
and many other areas of OnePlan.

» Expand / Collapse: Click the plus to expand all
of the ideas in the list. Click the minus to collapse
all of the ideas in the list.

* Group By: Select a plan-level field to group your
ideas by in the list. A common example would be
to group your ideas by their Process Step (i.e. In
Review, New, Closed).

* Filters: Select filter(s) from the Filters menu to
refine the ideas in your list.

* Prioritize: Click to turn on prioritization for the
ideas in your list. This will number the ideas
beginning with 1 at the top, being the highest
priority. Drag and drop the ideas in the list to
re-prioritize.

» Gantt: Click to open the Gantt chart for the ideas
in your list.

» Export: Click to export the ideas list to an Excel
file.

» Refresh: Click to refresh the data in the ideas
list.

* Views Menu: Select a preconfigured view from
the menu. You can also save and delete views
from this menu.

List, Board, and Dashboard

By default, the Ideas area will display ideas in the
list view.

You can also view your ideas in a board view
by clicking Board in the upper right corner of the
screen.
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| S re——— Ig NOTE
. Which plan type the request

e - Pt converts into is set by your
administrator.

3. Click Yes to confirm the conversion. The
request will be converted into a plan.

You can also view any configured PowerBI
reporting dashboards by clicking Dashboard in the
upper right corner of the screen.

_ 4. Click View Plan to view the newly converted
- plan. Otherwise, click Close.

Convert a Request into a Plan

This article explains how to convert a request in the
Ideas area into a plan.

You administrator will need to set up the plan
conversion logic before you can proceed.

Manually Convert Requests into Plans

If your environment is set up so you can manually
convert requests into plans, you can do so by:

1. Select your desired request. The request
details form will open.

s Automatically Convert Requests into
Plans
Your environment my be set up to automatically
convert requests into plans given set triggers (e.g.
entering a certain process step or status). This logic
is set up by your administrator. Please consult with
2. Click Convert 7 to convert the selected your administrator about how the automation works
request into the set plan type. for your particular environment.
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Innovation

Submit an Idea with the

Innovation App

This article explains how Requestors can create
and submit new Ideas using the Innovation App.

o IMPORTANT

This article assumes you are a
user with a limited Requestor
license. The process for creating
new items in the Innovation App is
the same for all users, however,
some users may have more
controls on the page based on
their permissions. The Requestor
license and permissions are the
most limited and will be reflected
in the images in this article.

Access the Innovation App Area

As a Requestor, you only have access to areas
in OnePlan where the Innovation App is enabled.
In this example, | have access to the My Ideas
area as it is the only one with the Innovation App
enabled.

Create a New ldea

1. Click the New Item icon in the header, then
select the item type you would like to create. In
this example, | can only create new Ideas.

Business Unit

My Ideas

o -

Mew ldea

Plan Type: Id

The Add New Idea form will open. This form
will look a little different depending on how
your organization has the area configured. If
the area has a flat hierarchy, the form will look
like this, where you simply give your new Idea
a name.

Add New Idea x

Mame: Esprasso Maching in the Break Room

If the area has a hierarchy, the form will

look like this, where you need to select the
parents of your new Idea. This helps you
properly organize your new ldea based on your
organization's plan hierarchy structure.

Add New Idea x
Space Information Technology X -

Challenge: Eco-Design and Rapid Prototyping Challenn ¥+

Namea: Compostable Cupsl

ADD PLAN CANCEL

If required, select the proper parents for your
new ldea. Then give your new Idea a name.
Click Add Plan to create your new Idea.
This new Idea will now be available in the
Innovation App area for others to vote and
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comment on. Be sure to add details about your
new Idea using the Quick Edit form.

Update Idea Details

To update details for a given item in the Innovation
App area, click the contextual (hamburger) menu
next to the desired item. Then select Quick Edit.
The Quick Edit form for the selected item will open
on the right side of the screen. Update the item's
details as needed. Changes will auto-save.

If you are updating the details for multiple items in
the Innovation App area, leave the Quick Edit form
open and select the next item in the list. The Quick
Edit form will update for the selected item.

Vote on Ideas with the
Innovation App

This article explains how to vote on items in the
Innovation App area. All users can review, vote on,
and comment on items in the Innovation App area.

Vote on Ideas

Voting on Ideas in the Innovation App area is
simple.

If your organization uses single voting, click on the
star icon next to the Idea you would like to vote for.
This will open the Ratings form. Click on the Your

Vote icon to cast your vote. Click on the X in the top

right corner to exit the form and return to the Ideas
list.

If your organization uses star voting, you can rate
Ideas on a 1 to 5 star scale. Click on the star icons
next to the Idea you would like to rate. This will
open the Ratings form. Click on the Your Vote
icons to rate the Idea from 1 to 5 stars. Click on the
X in the top right corner to exit the form and return
to the Ideas list.

Review Voting Results on Ideas

To review the voting results of items in the
Innovation App, click on the score or vote total next
to the desired item. The Ratings form will open.

If the area is using star voting, all users can

rate items from 1 to 5. The results will show a
breakdown of the ratings, as well as the average
rating for all votes.

If the area is using single votes, all users will be
able to vote on items that they like. The results will
show the total count of votes on that item.

@ OnePlan
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Ratings x

Your Vote:

1 total vote

Make and Review Comments on Ideas
To make and review comments on items in the
Innovation App, click on the Comments icon next
to the desired item. The Comments panel will open
on the right side of the screen. ltems with existing
comments have the icon highlighted in blue.

a
|

Favorite an Idea

To add an item to your Favorites list on your
Homepage, click the contextual (hamburger) menu
for the desired item, then select Favorite. The
selected item will now be available for quick access
in the Favorites tab of the Plans Panel on your
Homepage.

==

Manage Ideas with the
Innovation App

Once your Innovation App area has several Ideas
created and voted on, you will want to review the
items and take action on them.

The plan management capabilities in the Innovation

App area are identical to those in the Portfolio Area.

NOTE

You can apply the Innovation on
any Plan Type in OnePlan. For this
article, we will use an example of
the Innovation App applied to the
Ideas Plan Type.

K

IMPORTANT

This article assumes that you have
Plan Creation permissions beyond
the Requestor permission level
(such as Manager permissions).

Create Hierarchies in the Innovation
App

The major difference between the Innovation App
and its predecessor, the Requests App, is that you
can create hierarchies with the Innovation App. This
means that you can organize your Innovation space
in any way that makes sense for your organization.
Requestors are limited to creating and voting on
the Plan Type set to "Open to All Users" in the

back end. This will likely be the lowest-level Plan
Type. See Configure the Innovation App for more
information.

In this example, all users can create and vote on
Ideas, but only Managers can create Spaces and
Challenges.

To create these parent plans as a user with proper
plan creation permissions:

1. Click the New Item icon in the header to create
a new top-level item in the hierarchy. The New
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[Item Type] form will open. Give the new top-
level item a name, then click Add Plan.

2. Click the New Item icon in the list view to
create a child item in the hierarchy. The New
[Item Type] form will open. Give the new child
item a name, then click Add Plan.

Now when other users create new Ideas, they have
a hierarchy to organize their Ideas into.

Configure and Save Views in the

Innovation App

As a Manager, it is your responsibility to create
views for other users to leverage when using the
Innovation App area. To create views:

1. Add your desired columns into the view and
arrange them in a way that makes sense to
you and your organization. Click on the Select
Columns icon in the header. Drag desired
columns from the All Columns list into the
Selected Columns list to add the column to
your view.

You can rearrange the columns from left
(columns at the top of the list) to right (columns
at the bottom of the list). When you are happy
with your columns and their order, click OK.

Select Columns

Find Field
All Columns T Selected Columns

Active lssues Votes

Active Issues Trend Plan Type

Active Risks Name L\\, :

Actual Cost (Summary) Strategic Thermes ——
Actual Hours Description

Actual Revenue (Summary) Associated Key Results

Actuals Approval Status

Additional Comments

Associated Applications

Add Grouping to the view to group items by a
selected field. Click the Group By menu, and
select the field you would like to group items in
the view by.

In this example, | decided to group the items in
my view by their Priority.

@ OnePlan
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In

Ir+a

3

Group By: None »

Category

Challengs

Crazted By

Effort Health
Enterprise Architaciure
Executive Sponsor
Financizl Hzalth

Funding Source

m 5

Improve Employee Retention

Imvestment Horizon
lzzlys Haaln

lira Project Names
Lower Cost
Manager

Modified By
Objective

Cwerzll Health

Plan Type

Portfolio

0

Here you can see the Priority grouping applied
to the view.

Add Filters to the view to reduce the number
of items in the view. Click the Filters icon, then
select the field(s) you would like to filter items
in the area on.

70
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Product
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4. Set the row height. Click the Row Height icon,

R L Small Meclum, and Large.
Clear Filters = | —
=+ w =
Mame b
Approval Status b Sr""lal |
Associated Applications b
Azzocizied Challengs b
Azzocizied lgesas b
Azzocizied Intiztives b
Azzocizied Key Rezuls b
Azzocizied Diojectives b
Associated Products b
Azzocizied Space b
Azzocizied Value Stream b
* Medium row height looks like this:
Business Unit b o -
Category » E =
Challengs b :- 5? ; -%;ZL" . }i
Created b ? : 1§_ }f." - — 2;
Crazted By b « Large row height looks like this:
Effort Health b
Enterprise Architeciure b
Estimated End b
Estimated Start b
Executive Sponsor K OnePlan 71
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Save View
v Mame Ideas by Priority

Parzonzl visw O

& CAMCEL

The new view will now be available from the
Views menu.

5. Save the current view for other users to utilize.
Click on the Views menu, then select Save
View. The Save View form will open.

All ldeas -

=T 5 =R T =AT

Delete View Save View
Give your view a name, leave the Personal E.Flp--. WY
ol i U et

View check box blank as this will be a global
view for all users to utilize, and check the
phishing email check box if this view should be
the default view for the area. Then click Save.
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Configure Plan-Level Notifications for
the Innovation App

Since the Innovation App is an additional module
that sits on top of the portfolio plan architecture, you
can use a lot of the functionality that is available in
the Portfolio area, including plan-level notifications
for the various plans in the Innovation App area.

See Create and Manage Plan-Level Notifications
for instructions.

Reorganize or Convert an Idea to
Another Plan Type

Once you have reviewed all Ideas (or your
organization's preferred plan type), you will likely
want to create project plans around the most
popular Ideas. In OnePlan, there are a couple of
methods to kick off this process.

You can Reorganize the item into another plan
type, such as a Project. Click on the contextual
(hamburger) menu > Reorganize. Then select the
Plan Type you would like to change the Idea into
and its parent plan. Then click Reorganize to
change the plan type. Reorganizing will completely
move the item and all of its data into the new plan
type and location in your OnePlan group. There will
be no historical data about its origin.

You can also Convert the item into another plan
type if plan conversions are configured for your
OnePlan group. See Convert a Request into a Plan
for instructions. Conversions will leave the original
item in place and create a new item of the desired
plan type. You can configure links between the

two to maintain a historical record of that item's
progression.

@ OnePlan

73


https://support.oneplan.ai/hc/en-us/articles/20716055021965-Create-and-Manage-Plan-Level-Notifications
https://support.oneplan.ai/hc/en-us/articles/11203691262733-Convert-a-Request-into-a-Plan

Using OnePlan

Click New Item. The Add New Item form will

Requests Overview open.

This article introduces the Requests app in
OnePlan.

—_

0]

To access the Requests app, you need to purchase
a license for the app. Then your Administrator
needs to install the app.

What is the Requests App?

The Requests app is an area in OnePlan where
employees can submit ideas and or requests into
OnePlan.

2. Enter a title for your new request. Then click
Create. The item details form will open.

» See Create a New Request [74] for instructions
to create a new request.

From there, managers can review the list of ideas
and or requests, and potentially convert them into
projects using the Ideas portal.

+ See Manage Requests in the Ideas area [64] to
learn how to manage and prioritize your requests. 3.  Fill out the item details form with as much
» See Convert a Request into a Plan [65] to learn information as you can provide for your
how to convert requests into different plan types request. Your changes will auto save.
S0 you can make innovative ideas into reality.

Requestor Permission

With the app, OnePlan also introduced a new

user permission called Requestor. Requestors only
have access to the Requests area in OnePlan.
See OnePlan User Permissions [23] for more
information.

Create a New Request

This article explains how to create new requests in
the OnePlan Requests app.
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My Strategy

Manage corporate strategy

Connect long-term business strategy, goals/OKRs
and results to adapt and thrive.

https://player.vimeo.com/video/565062102
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Plan Types and Plan Type

Structures

This article explains the different use cases for plan
types in OnePlan. Your organization may follow
the examples here, or your plan types may be
completely unique. Plan Types are important in
OnePlan as the different tools can be utilized at
each plan type or level.

Video Length - 1:54

https://player.vimeo.com/video/755601722

Plan Types

A "plan" is a general term that may be used for
something to be managed and/or analyzed, such as
projects, epics, portfolios, programs, initiatives, etc.

In OnePlan, each of these items is referred to as

a Plan Type. Plan Types are important in OnePlan
as different tools can be utilized at each plan type
or level and are completely configurable to meet the
needs of your organization.

When creating a new plan, you will first select

the plan type (see Create a New Plan [77] for
complete instructions to create a plan.) The plan
details options and which features are available will
be based off your plan type selection.

Each plan type may have a different plan details
form, and in each form, there may be different
sections, fields, stages/steps, and different planning
modules. This is configured by your administrator.

Plan Type Structures

The Plan Type structure or hierarchy is also
configurable. It is important to know how your
company organizes their plans, and that you
understand how that structure impacts how different
plans interact in your environment.

Flat Hierarchy Plan Type Structure

The first method is to have a flat hierarchy, where
the plan types are not related to each other. For
example, Enterprise Project (where perhaps the
budget is over 1 million dollars) and Small Project
(which have budgets less than 1 million).

Plan Types

Add Type
Name

Enterprise Project

Simple Project

Hierarchical Plan Type Structure

The second method is to build out a hierarchy

of plans where there is a parent to child lookup
relationship between the plans. This also for tree
grid visibility & data roll up. For example, Portfolios
and then under the portfolios, we have children
Value Streams, and then under the value streams,
we have children Epics, and then under the epics,
we have children Features.
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Plan Types

Add Type
Name
¥ Portfolio
¥ Value Stream
¥ Epic

Feature

Zoom: Month Plan Type: Porticlio + Group By: None ¥ -
Type Nar V" Potiolio State
Value Stream _
Portfolio b4 emographic
Epic
Value Stream Faative Development (1) Proposed
Epic Project squires 3 better s...
Feabure All Types
Epic V¥ As a manager, | need to be able ..
Feature Notifications: New shares, up...
Epic VY Asa buyer, | need to be able to ... (1) Proposed
Feature Mobile Read Only Mode M
Portfolio W Cloud and mobile first
Value Stream ™ Fabrikam
Epic Vv Framework to port applications .
Feature Add Company Account
Epic A Support Customers using Mobile
Epic A Improve User Experience (1) Proposed
Epic A Service interface to support Rest.

Blended Plan Type Structure

The third method is to have a blend. You may have
a hierarchy, such as Portfolios and Programs, and
then at a child level have multiple different plan
types that are equal in their level to each other.
Such as Waterfall Project (for projects managed
with traditional waterfall scheduling & details), and
also Agile Project (for project teams who follow an
agile or lean management process).

Plan Type: Portfolio «
v Fortfolio
Program
Waterfall Project

Agile Project

B~ ™

All Types

Create a New Plan

This article explains how to create a new plan.

A "plan" is a general term that may be used for
something to be managed and/or analyzed. Such
as projects, epics, portfolios, programs, initiatives,
etc.

You can create a new plan in multiple locations
in OnePlan including the Home Page and the My
Portfolio area. Users need to have Contributor,
Manager, or Owner permissions to create new
plans.

Video Length - 1:57

https://player.vimeo.com/video/755606143
Create a Plan from the Home Page

1. Inthe Plans panel, click New Item. Then select
the plan type you would like to create. The Add
New [Plan Type] form will open.

=

=
=
¥
i
Y
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2. Complete the Add New [Plan Type] form.
Depending on the plan type chosen and your
environment’s plan type hierarchy, you may
need to specify the plan hierarchy above the
new plan. Then enter the name of the new
plan.

Add New Project x

3. Click Add Plan. The new plan will be added to
your environment.

Create a Plan from the My Portfolio
Area

There are two ways to create a plan in the My
Portfolio area:

From the My Portfolio Header

1. Select the Plan Type that you would like to
create from the Plan Type drop down. The
plan type(s) selected dictate which plan types
you can create.

2. Click New Item. Then select the plan type you
would like to create. The Add New [Plan Type]
form will open.

3. Complete the Add New [Plan Type] form.
Depending on the plan type chosen and your
environment’s plan type hierarchy, you may
need to you may need to specify the plan
hierarchy above the new plan.. Then enter the
name of the new plan.

Add New Project x

4. Click Add Plan. The new plan will be added to
your environment.

From the My Portfolio List

You can create child plans within the list view in My
Portfolio. To do this, click Add Item next to the plan
you would like to create a child plan for. The Add
New [Plan Type] form will open. Enter the name of
the new plan.

Click Add Plan. The new plan will be added as a
child of that initial plan.

Add New Project x

Name

Plan Details

After you have created the new plan, complete the
plan's details. Your form may have different fields
and different stages, based on your organization's
use case and configuration. The page is editable
and you may always return to the Details page
throughout the life of the plan. When you make a
change, it is saved automatically.

Delete or Archive a Plan
This article explains how to delete or archive a plan.
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Deleting a plan also deletes that plan's financial
plan, resource plan, tasks, etc.

Archiving a plan saves all plan data and can
be restored from the OnePlan Admin pages. See
Restore archived plans.

Video Length - 1:21

https://player.vimeo.com/video/755590633

Delete a plan

Be cautious when deleting a plan! There is no undo
option.

1. From the Portfolios page, open the contextual
menu for the desired plan to delete. Select Delete.

7
New Plan 4

Team App

2 v Appeal to a younger demographic

_ Quick Edit

= Software Development
Shared With

=] VOIP Phones
Comments

- Dependencies Customer Luncheon

Prioritize ltems

Details

From the Plans navigation menu, open the
ellipsis menu (...) for the desired plan. Select
Delete Plan.

=

QLY Team App -
Shared With
VOIP Phones Quick Edit
Comments
v Templates

Create Child Plan

Rate Table

E Standard Plan Te---

Delete Plan

2. Type the name of your plan exactly in order to
confirm the plan you want to delete. If you mistype,
the Delete button will not continue. Click DELETE.

Delete Plan

This will delete all plan data! To delete this plan enter "VOIP Phones' in the box below

3. Click YES to make your final confirmation that
you want to delete the plan.

Delete b 4

9 Are you sure you want to delete that Plan?

Archive a plan

1. From the Portfolios page, open the contextual
menu for the desired plan to delete. Select Delete.

7
New Plan »

Team App

2 ™ Appeal to a younger demographic

_ Quick Edit

= Software Development
Shared With

=] VOIP Phones
Comments

" Dependencies Customer Luncheon

Prioritize Items

Details

From the Plans navigation menu, open the
ellipsis menu (...) for the desired plan. Select
Delete Plan.

Team App -
Shared With
VOIP Phones Quick Edit
Comments
- Templates

Create Child Plan

Rate Table

E Standard Plan Te-..

Delete Plan
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2. Type the name of your plan exactly in order

to confirm the plan you want to delete. If you
mistype, the Archive button will not continue. Click
ARCHIVE.

Delete Plan

This will delete all plan data! To delete this plan enter "VOIP Phones' in the box below

3. Click Yes to make your final confirmation that you
want to archive the plan.

Delete b4

9 Are you sure you want ta archive that Plan?

Share a Plan

This article explains how to share a plan in
OnePlan. OnePlan enables collaborative work by
allowing you to share your plan with your team,
and even coworkers who might not be part of your
project team. In this article, we will discuss how to
manage the users on your plans using OnePlan.

Video length - 2:19

https://player.vimeo.com/video/755274629

Access Plan Shared With Information

There are many ways to access the Share With
information for your plan.

* From the plan Work Plan list: Open the Grid
Options menu. Select Shared With.

* From the plan Resource Side Panel: Click on
the Resources icon from the Work Plan header.
Then click the (+) icon to open the Share With
form.

L
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* From the plan action menu: Click the ellipsis
and select Shared With.

* From My Portfolios: open the plan contextual
menu, and select Shared With.

* From the Home Page Plans panel: open the
plan contextual menu, and select Shared With.
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The Shared With form shows the plan team with
each user's Name, Email address and Access
level.

Add a User to the Plan

Now that we’re in the Shared With form, you can
add a user to your plan. Make sure you are in the
Users tab of the Shared With form, then type the
user's name into the Add User field. Once you type
3 or more characters, matching users will show for
selection based on the directory of users in the
Resource Center.

Newly added users will be added to the team as a
Reader, so adjust the access level as necessary.
See Edit User Access Levels for the Plan [82].

Add a Team to the Plan

You can also add entire teams of resources to
plans. Go to the Teams tab of the Shared With
form, then type the team's name into the Add Team
field. Once you type 3 or more characters into the
field, matching teams will show for selection based
on the directory of teams in the Resource Center.

Newly added teams will be added to the plan as
Readers. so adjust the access level as necessary.

NOTE

If you add a resource to a team,
that user will automatically have
access to all plans that have been
shared with that team.

)

Delete a User from the Plan

To remove a user from your plan, go to the Users
tab of the Shared With form. Then click the Delete

icon T to the left of the user.

NOTE

This does not delete the user from
OnePlan, just from your plan.
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Delete a Team from the Plan

To remove a team from your plan, go to the Teams
tab of the Shared With form. Then click the Delete

icon @ to the left of the team.

NOTE

This does not delete the team from
OnePlan, just from your plan.

Edit User Access Levels for the Plan

To edit a user’s access level, go to the Users tab
of the Shared With form. Then click in the Access

column for the desired user. Select the access level

from the drop-down. Options include:

* No Access: The user will not have access to the

plan, and will not see assigned work items in My
Work. The user can be assigned to tasks by the
Plan Manager.

» My Work Only: The user will not have access
to the plan. The user will see all assigned work
items in their My Work area.

* Reader: The user has read-only access to the

plan. The user will see all assigned work items in

their My Work area.

» Contributor: The user has edit access to the
plan. The user cannot delete or archive the plan.

* Owner: The user has full edit rights to the plan.
The user can delete or archive the plan.

What users can access and do with shared plans

is dependent on the plan permissions you set,

and their OnePlan environment permissions. Higher
environment permissions will outweigh restrictions
set on the plan level.

We have created a matrix [83]to detail how the
environment and share with permissions interact.
See OnePlan Plan Permission Hierarchy [83] for
more information.

Edit Team Access Levels for the Plan
To edit a user’s access level, go to the Users tab
of the Shared With form. Then click in the Access
column for the desired user. Select the access level
from the drop-down. Options include:

* No Access: The user will not have access to the
plan, and will not see assigned work items in My
Work. The user can be assigned to tasks by the
Plan Manager.

» My Work Only: The user will not have access
to the plan. The user will see all assigned work
items in their My Work area.

* Reader: The user has read-only access to the
plan. The user will see all assigned work items in
their My Work area.

» Contributor: The user has edit access to the
plan. The user cannot delete or archive the plan.

* Owner: The user has full edit rights to the plan.
The user can delete or archive the plan.
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Check User Permission Levels for the
Plan

Because you can add both individual users and
teams of users to your plans, determining their
level of access/permissions to your plan can be
confusing. You can use the Permissions tab of the
Shared With form to check the permissions for the
users on your plan team.

To check a user's permissions, go to the
Permissions tab of the Share With form. Then
type in the user's name into the Enter Name field.
Once you type 3 or more characters into the field,
matching users will show for selection based on the
directory of users in the plan's Shared With. Select
the user from the drop-down. Then that user's
permission level and where those permissions
come from show in the form below.

OnePlan Plan Permission
Hierarchy

What users can access and do with plans is
dependent on three factors: the Enterprise Security
Group, Plan Type Security, and Plan Shared With
permissions set for the user.

Enterprise Security Group

Enterprise Security Groups are where global
OnePlan permissions are configured. These
permission settings are at the top of the permission
hierarchy. See Create and Manage Enterprise
Security Groups for more information on setting up
and managing global OnePlan permission groups.

Plan-related permissions configured in the
Enterprise Security Group settings:

* Global Permissions:
« Edit all plans: The user can edit all plans in
OnePlan (e.g. make changes to plan data).

* View all plans: The user can view all plans
in OnePlan regardless of whether the plan is
shared/not shared with that user.

* Global Plan Permissions:

* Add Plan: The user can add a plan (e.g. the
user will see the add blue button on the Home
Page and Portfolio).

* Delete Plan: The user can delete a plan.

» Archive Plan: The user can archive a plan.

Plan Type Security

The goal of Plan Type Security is to allow

OnePlan users the ability to control which security
groups can create plans by the plan types. Plan
Type Security settings are the second level of

the permission hierarchy. See Set Up Plan Type
Security for instructions on how to set up Plan Type
Permissions

» Users whose security group has global
permission of 'Administrator' are exempt from the
Plan Type Security, meaning they can bypass the
security and still create a plan.

» Users whose security group is without global 'Add
Plan' permission will not be able to add/see the
add plan buttons in the first place, so this setting
does not apply to them.

» So, the users whose security group has the
global 'Add Plan' permission will be the ones
affected by the Plan Type Security feature.

How this feature works for affected security groups:

+ If certain security groups are listed/specified in
the Plan Type Security settings:

» Only users whose security group is specified
can freely create plans of this plan type.

» What about users whose security group has
'Add Plan' permission, but the security group is
not listed in the plan type security settings?

» Then these users can create plans of this
type only if they have contributor or owner
access (via the Plan Share With settings) to
the parent plans.

+ Example: If you have a plan type hierarchy
of Portfolio > Program > Project and security
is placed at the Project plan type, you
will still be able to create a 'Project’ plan
type only if you have contributor or owner
access to the parent plans. The user will be
prompted to select a Portfolio and Program,
and if they do not have contributor or owner
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access (via the Plan Share With settings) to
any Portfolios or Programs, then they will not
be able to select them and therefore won't be
able to proceed with the 'Project’ creation.
* If no security groups are listed/specified in the
plan type security settings:
* Then any users whose security group has 'Add
Plan' permission can create plans of this type.

Plan Share With

See Share a Plan for more information on sharing
plans and plan Share With permissions.

Plan Share With permissions are plan-specific
permissions where you can place someone to be
a contributor, owner, reader, etc. of a specific plan.
Plan Share With permissions are the bottom level
of the permission hierarchy.

The Plan Share With permissions interacts with
the Plan Type Security feature as explained in the
example in the Plan Type Security section.

* If certain security groups are specified in the Plan
Type Security settings, then only users whose
security group is specified can freely create plans
of this plan type.

* However, security groups that have 'Add Plan’
permission but are not listed in the plan type
security settings for the plan type can create
plans of this type only if they have contributor or
owner access (via the Plan Share With settings)
to the parent plans.

Organize your Plans

This article describes how plans are organized in
OnePlan.

Plan Hierarchies: Parent and Child
Plans

A plan may have one or multiple children plans
(sub-plans). By selecting the parent plan, the
children plans' tasks show as well. The totals and
summary row data rollup to the parent plan level.

Areas

Your organization can organize different plan types
into different Areas. Areas are larger units of
organization and functionality in OnePlan. See
Create and Manage Areas

In this example, the environment has the My Ideas,
My Strategy, and My Portfolio areas.

The My Ideas areas contains Idea plans and their
children.

Edit Area x

Pre Filters

The My Strategy area contains Objective plans and
their children, Key Results.
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Edit Area x
I Mama: My Strategy I
lcon: BullseyeTarget
Order: 22 -
I Flan Types Objective % - I
Avzilzcle Viaws: List ®  Dashboard X  Board v
Roadmap *
Avzilable Controls: | Gantt % v
Pre Filters
Field

The My Portfolio area contains Portfolio plans and
their children, Programs, Projects, and Epics.

Edit Area x
I MNamg My Portfolio I

lcon:

Order: 30 -
Flzn Types Portfolio % . -

Lyzllzble Views Board ¥ Dashboard ¥  List % -

Roadmap %
Avzilable Controls: | Financials ¥  Gantt % Pivot % -

Resource Plans ®

Pre Filters

Field

Plan Details Overview

This article explains what the Plan Details are, and
provides an overview of the buttons and features of
an example Plan Details form.

https://player.vimeo.com/video/757218547

What are Plan Details?

The plan details forms in OnePlan are where plan
managers will enter all metadata for a given plan.
The metadata entered into the plan details directly
impacts rollup values in the work plan and reports.
So, the more information provided in the plan
details, the better.

Access the Plan Details

There are a couple ways to get to the plan details
for your plan.

From the home page, in the Plans panel, click the
quick edit menu next to the desired plan and select
Details.

T s

ISI

From the My Portfolio area, locate the desired
plan. Click the quick edit menu and select Details.

(NEAT

SETIIIE

You can also use the Quick Edit menu to open the
plan details in a pop-out window.
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Get Around the Plan Details

The plan details forms are highly customizable, and

each organization will likely have their own twist
on this form. Additionally, each plan type has its
own form, and each form may be a little different
depending on the kind of plan it is.

Plan Contextual Menu

Starting in the top right corner, you see this ellipsis
next to the plan name. Click the ellipsis to access
the plan contextual menu. Here you can:

» Shared With: Share the plan with other users.
You can Add or remove users from the Shared
With form.

+ Comments: Add comments to the current plan.

* Add Favorite: Add the current plan to your
Favorite list. You can access your Favorite plans
from the Home page.

* Copy Plan Hierarchy: Here you can copy the
current plan’s hierarchy over to a new or existing
plan. For example, you could copy all the plans
from one program to another. You could also
copy the program and all plans under it. This
creates the plans and copies the plan level field
values (it does not currently copy schedules,
resource plans, etc.).

» Switch Plans: Locate and go to a different plan
from the Switch Plans pop up.

* Integrated Tools: If your OnePlan group is
integrated with another tool, you may access
additional menu options to synch and/or launch
the other integrated tools.

Plan Action Menu

Below the plan name, are some icons.

» Shared With: Share the plan with other users.
You can Add or remove users from the Shared
With form.

+ Comments: Add comments to the current plan.

» Add Favorite: Add the current plan to your
Favorite list. You can access your Favorite plans
from the Home page.

* Integrated Tools: If your OnePlan group is
integrated with another tool, you may access
additional menu options to synch and/or launch
the other integrated tools. In the example, there
is a Microsoft Teams integration.

On the left side of the screen, there is

the recalculate button, which, when clicked,
recalculates all rollup calculations in the plan on
demand.

Planning Modules

To the right, you will see all the different Planning
Modules available in this plan.

» Plan Details are where you enter all metadata for
the given plan.

» Plan Financials is where you can enter and
monitor the financials for the given plan.

» Plan Resource Plan is where you can manage
the resources assigned to the given plan.
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» The Work Plan is where you track and monitor
the execution of the given plan.

* Reporting (Status Reports, Insights, Visualizer,
Power Bl Dashboards): OnePlan offers robust
reporting options to give you detailed summaries
of the given plan with Status Reports, Insights,
Visualizer, and Power Bl Reporting dashboards.

Process Steps

Here we have the plan process steps. Again, these
are customizable, so this is just an example. As you
progress through each step, the plan details form
changes to meet the needs of the stage.

For example, let's say | start in the Plan step. The
plan details form contains the Project information,
Associated Key Results, Project Business Case,
Project Schedule, and Project Financials sections.
If I move the plan forward to the Manage

step, the Plan Details form now includes Project
Prioritization, Project Health and Project Trending
sections.

Click on the Process History icon = to access a
record of the plan's progress through the various
process step phases.

The process steps can also be enhanced and
automated with customization and Microsoft Power
Automate.

Types of Fields in the Details Form

» Plan fields are independent fields from plans.
These fields are inputted directly, and are not
dependent on other fields. These include fields
like Name, Description, and Estimated Start.

+ Summary fields aggregate data from the plan
fields below it, such as % Done, Actual Cost, or
Remaining Effort.

+ Split fields allow you to split plan costs between
parent plans.

» Trend fields allow you to easily see if key metrics
are improving over time.

Edit the Plan Details Form

This article explains how to edit a plan on the Plan
Details form. The form will differ, as it is configured
per your organization. Also, each plan type may
have different details forms.

You may also edit the plan details via the Portfolios
page using Quick Edit. How do | view and edit
plans from the Portfolios page? [103]

https://player.vimeo.com/video/755597959

Move plan from one step to another

At the top of the Plan Details form, there may

be various Process Steps. The current step is
highlighted green. Previous steps are highlighted
blue. Future steps are highlighted gray. Click on a
step to see the status. To see the Process Step in
OnePlan views, use the field called Process Step.

To move a plan from one step to the next:

*  Select the stage/step. The name of the step &
status will show. Click Next >.

You may also move a plan back to its previous step,
if needed.

£

Create Select Plan
Step Select
Status  Active: Agproved
I I Stage:

State:

Review the Process History

Click on the Process History icon = next to the
process steps to access the process step history for
the plan.
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Update field values

Click into any editable field to make a change.
Changes are saved immediately. If it's a choice
field, make a selection from the choices. If it's a
date field, select the date from the calendar. If it's
a user field, begin typing the name of the user
desired (must type at least 3 letters), and make
your selection. If the field is multi-lines of text, you
may also format the text (bold, size, etc.).

ccccccc

Additional fields based on step

Different sections of the Plan Details form may be
shown or hidden based on the current stage/step.

Plan actions

Perform common plan actions such as sharing a
plan, favoring a plan, or adding a comment to a
plan using the plan actions toolbar (1), or the plan
actions menu (2).

The plan actions toolbar varies by organization and
is configured by your OnePlan administrator.

Common plan actions:

Shared With: Select the icon in the toolbar or
Shared With from the plan actions menu to open
the Shared With form. Add or remove users from
the plan.

Add Favorite: Select the icon in the toolbar

or Add Favorite from the plan actions menu to
add the current plan to your Favorites. Favorite
plans appear in the Favorites tab on your Home
screen.

Comment: Select the icon in the toolbar or
Comments in the plan actions menu to open the
Comments form. View previous comments and
enter a new comment.

Rate Table: Select the icon in the toolbar or Rate
Table in the plan actions menu to open the Rate
Table form. Select, add, edit, and manage rate
tables from the Rate Tables form.

Switch Plans: Select the icon in the toolbar or
Switch Plans in the plan actions menu to open
the Switch Plans window. Locate and select the
plan that you would like to go to.

IWorId-CIass Customer Support °

Related Items °| @i
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Create and Manage Plan-Level

Notifications

This article explains how to create and manage
plan-level notifications. This means that you can
create notifications for plans at any level, including
portfolios, programs, projects, etc.

Plan-Level Notification Variables
{PlanName}: When creating single plan
notifications, users can include the Plan Name by
simply entering {PlanName} in the subject line.

Create a Plan-Level Notification

K

NOTE

The Plan Notifications schedule
must be enabled by your
administrator before you can
create any plan-level notifications.

Who can create plan-level notifications?

» Users with "Manage Data" permissions (typically
owners and managers) can create global
notifications across all or many plans.

* Plan owners can create notifications around
plans they own.

What kind of notifications can | create?

* Notifications can be triggered when a field
changes, when a date passes, or when a process
step changes. This allows you to be notified
when important plan updates occur.

Where can | create plan-level notifications?

* You can create plan-level notifications from 2
locations in OnePlan: The My Portfolio area, and
from within a plan. The instructions below detail
each scenario.

Create
Portfol

K

a Notification from the My
io Area

NOTE

Only users with "Manage

Data" permissions can create
notifications in the My Portfolio
area. These notifications will be
global notifications and will apply
to all plans that meet the set
criteria.

i

i
!
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1. Go to the My Portfolio area.
2. Click on the Notifications icon in the header.

The

Plan Notifications form will open.

3. Click the Add Notification icon. The Add
Notification form will open.
4. Complete the Add Notification form.

a.

Select the Scope for the notification.
When you create notifications from the My
Portfolio area, the Scope will be All Plans.
This means the notification will apply to all
plans in your environment that meet the
criteria you set in the notification settings
(e.g. all Programs, all Projects).

Select the Plan Type that this notification
will apply to. Options include all configured
plan types in your environment (e.g.
Portfolio, Program, Project, Epic).

Select the Trigger that needs to be met for
the notification to be sent. Options include
When a Field Changes, When a Date
Passes, and When a Step Changes. The
form dynamically changes based on your
selection here.

@ OnePlan
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* When you select When a Field
Changes: The When and Changes To
fields will appear.

* In the When field, select the plan-
level field that will be used to trigger
the notification.

* In the Changes To field enter or
select the value that the When field
needs to change to for the notification
to be triggered.

So, for example, you can create a
notification that will trigger when the
Effort Health field changes to At
Risk.

* You can also check the Any Value
check box which will trigger a
notification to send any time the
When field changes.

So, for example, you can create a
notification that will trigger when the
Active Risks field changes to any
value.

* When you select When a Date Passes:
The Field field appears.

» Select the date field that will be used
to trigger the notification. When the
date in the selected field passes, the
notification will be triggered and sent
out.

* When you select When a Step
Changes: The When and Changes To
fields will appear.

* The When field will be auto-populated
with Process Step.

* In the Changes To field, select the
step that, when a user changes the
process flow to the selected step, the
notification will be triggered.

So, for example, you can create a
notification that will trigger when the
Process Step changes to Active.

* You can also check the Any Value
check box which will trigger a
notification to send any time the
When field changes.

So, for example, you can create a
notification that will trigger when the
Process Step changes to any value
(e.g. Active, Closed, Proposed)

(Optional) Add Filters to the notification.
You can create notification filters on any
plan-level field.
Select When the notification will be sent
out once it has been triggered. When you
create notifications from the My Portfolio
area, all notifications will be sent out
Immediately.
Select who the notification will be sent To.
* First, select how the system will
determine the users to send the
notification to. Options in this first drop-
down include Specific Users, Field,
and Shared With Level(s).

* If you select Specific Users, search
for and select the desired user.

* If you select Field, select the plan-
level user field to determine the
recipient. For example, you can select
Project Lead, and the notification will
send out to the user who us assigned
as the Project Lead for a given
project.

* If you select Shared With Level(s),
select the Shared With permission
levels you would like the notification
to send out to. For example, you can
select Owners and Contributors.
The notification will send out to
users with either Owner or Contributor
permissions to the plan.

Enter the Subject of the notification.
Think of this as the email subject for this
message.

Select the Fields Sent to include in the
notification message. The fields selected
here will populate a table appended to the
bottom of the notification message body.
Draft the message body for the
notification. Think of this as the email body
for this message. Tell the recipients what
they need to know and any actions that
are required of them when this notification
is sent out.

Click Add. Your new plan-level notification will
now be active and available.
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Create a Notification from a Plan

@ NOTE
Typically, plan owners will create

notifications from within a plan.
Notifications created within a plan
only apply to the plan owner's
various plans, or the current plan.
These notifications are not global.

(-]

1.  Go to the Details section of a plan.

2. Click on the ellipsis next to the plan name.
Select Notifications from the drop-down. The
Plan Notifications form will open.

3. Click the Add Notification icon. The Add
Notification form will open.

4. Complete the Add Notification form.

a. Select the Scope for the notification.

Options include Plans | Own, and This

Plan.

+ If you select Plans | Own, the
notification will apply to all plans that
you are an owner of.

« If you select This Plan, the notification
will apply to only the current plan.

b. Select the Plan Type that this notification
will apply to. Options include all configured

plan types in your environment (e.g.

Portfolio, Program, Project, Epic).

c. Select the Trigger that needs to be met for
the notification to be sent. Options include

When a Field Changes, When a Date

Passes, and When a Step Changes. The

form dynamically changes based on your

selection here.

* When you select When a Field
Changes: The When and Changes To
fields will appear.

* In the When field, select the plan-
level field that will be used to trigger
the notification.

* In the Changes To field enter or
select the value that the When field
needs to change to for the notification
to be triggered.

So, for example, you can create a
notification that will trigger when the
Effort Health field changes to At
Risk.

* You can also check the Any Value
check box which will trigger a
notification to send any time the
When field changes.

So, for example, you can create a
notification that will trigger when the
Active Risks field changes to any
value.

* When you select When a Date Passes:
The Field field appears.

» Select the date field that will be used
to trigger the notification. When the
date in the selected field passes, the
notification will be triggered and sent
out.

* When you select When a Step
Changes: The When and Changes To
fields will appear.

* The When field will be auto-populated
with Process Step.

* In the Changes To field, select the
step that, when a user changes the
process flow to the selected step, the
notification will be triggered.

So, for example, you can create a
notification that will trigger when the
Process Step changes to Active.

* You can also check the Any Value
check box which will trigger a
notification to send any time the
When field changes.

So, for example, you can create a
notification that will trigger when the
Process Step changes to any value
(e.g. Active, Closed, Proposed)
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(Optional) Add Filters to the notification.
You can create notification filters on any
plan-level field.

Select When the notification will be sent

out once it has been triggered. Options

include Immediately, Daily, or Weekly.

* If you select Inmediately, the
notification will be sent out as soon as
it has been triggered.

* If you select Daily, once the
the notification is triggered, it will
send out daily based on the Plan
Notification schedule configured by your
administrator.

* If you select Weekly, once the
notification is triggered, it will send out
once a week. The Day of Week field will
appear. Select the day you would like
the notification to send out.

Select who the notification will be sent To.

* First, select how the system will
determine the users to send the
notification to. Options in this first
drop-down include Specific Users,
Specific Teams, Field, and Shared
With Level(s).

* If you select Specific Users, search
for and select the desired user(s) you
would like the notification to be sent
to.

* If you select Specific Teams, search
for and select the desired team(s) you
would like the notification to be sent
to.

+ If you select Field, select the plan-
level user field to determine the
recipient. For example, you can select
Project Lead, and the notification will
send out to the user who us assigned
as the Project Lead for a given
project.

* If you select Shared With Level(s),
select the Shared With permission
levels you would like the notification
to send out to. For example, you can
select Owners and Contributors.
The notification will send out to
users with either Owner or Contributor
permissions to the plan.

g. Enter the Subject of the notification.
Think of this as the email subject for this
message.

h. Select the Fields Sent to include in the
notification message. The fields selected
here will populate a table appended to the
bottom of the notification message body.

i. Draft the message body for the
notification. Think of this as the email body
for this message. Tell the recipients what
they need to know and any actions that
are required of them when this notification
is sent out.

Click Add. Your new plan-level notification will

now be active and available.
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My Portfolio Planning Modules

This article provides an overview of the different
planning modules available in the My Portfolio
Area.

You can locate all of the Portfolio modules in the top
right corner of the My Portfolio Area.

 List: The portfolio list provides an organized
view of various projects, programs, and epics
grouped under different portfolios. It presents key
information such as plan types, names, states,
statuses, schedule health, financial health, effort
health, issue health, budgets, benefits, estimated
end dates, and percentage done (summary).

* Board: The portfolio board is a visual
representation of portfolios, programs, projects,
and epics within an organization, displaying
their progress, status, and other key metrics. It
typically consists of cards or tiles arranged in
columns or lanes, with each card representing
a particular project, program, or epic within
the portfolio. The columns or lanes generally
represent different stages, such as proposed,
active, on hold, completed, or any other custom
stages according to the organization's workflow.
See Portfolio Board for more information on how
to use the Board.

* Roadmap: The portfolio roadmap is a modern
and interactive visualization tool that allows you
to build out roadmap timelines of the plans in
your portfolio. From the roadmap view, you can
view the relationships between the plans in your
Portfolio, create and rearrange new plans, and
create key Event markers in the timeline that
may impact your Portfolio planning. See Portfolio
Analysis - Roadmap for more information on how
to use the roadmap.

* Dashboard: The portfolio dashboard holds
Power Bl reports related to your portfolio,
allowing you and your stakeholders to easily
visualize progress, blockers, etc. of your portfolio.

Portfolios

Portfolio Board

This article explains the features and functionality of
the OnePlan Portfolio Board.

OnePlan Portfolio Board is a visual tool used to
track and manage the progress of plans within a
portfolio. It includes a series of columns and/or
lanes that represent the different stages or phases
of the plan lifecycle, and it can be used to display
information about each plan, such as the plan
name, owner, status, budget and more.

Portfolio Board Configuration

Example

Let's begin by taking a look at an example Portfolio

Board. The board view is customizable, so it can be
helpful to see an example of how the board can be

configured.

In this example, each column on the board
represents a Business Unit (IT, Product
Development, and Marketing in this example).

At the top of each column, you can see the total
budget of all of the items within each column. So,
for example, here you can see the total Budget
(see the Totals setting in the header) of all of the
items in the IT column equals $3,919,245.

Each card in the columns represents a project or
epic in your portfolio. The cards are color-coded by
the project or epic Status (out of the box, green =
On Track, yellow = At Risk, red = Off Track).

The cards also display some general information
about the project or epic, including the Benefits,
Budget, Business Unit, and Prioritization Score.

At the bottom of each card, you can see a bar
displaying the project or epic overall % Done, how
many days the project has been in a particular
stage, and a color-coded dot representing the
project or epic State (out of the box, light gray =
Proposed, blue = Active, yellow = On Hold, dark
gray = Closed). There is also a speech bubble icon
you can click to add comments for a project or epic.
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The lines connecting different cards on the board * Column: Select the plan field want to use for the
represent dependencies between various projects columns in the board. For example, | will click
or epics. The direction of the arrow shows the on the Column menu, and select Goals from the
direction of the successor/predecessor relationship, drop-down. Now the Goals plan field will be used
with the arrow pointing at the predecessor. The for the columns in the board.
color of the line represents the method of the
relationship, W|th blug lines represgntmg regular. o . Column: Business Unit Lan
dependent relationships, and red lines representing
blocker relationships.
All of these settings are configurable so you can > Approval Status 0o
personalize the Portfolio Board in a way that works _ !
Associated Portfolio
best for you. % l
(0 | & Business Unit
Cr—— e — % Business Value
jul ' R
| - = Default Task Mode
e Detault Task Tvpe
c e
Effort Health
Customize the Portfolio Board Enterprise Architecture l
Now that we have walked through an example of a
Portfolio Board configuration, let's dive into how you Financial Health
can configure the board for your use. nctionsl £
uncoonal Fit
All of the board configuration settings are available e
here in the board header. Funcing source
: [F,
Pt —— - Cr— Improve Emp oyee Retanuon
' lzzlg Hzalih l
| e m — - lira Project Mames
e —— ’ Lowear Cost

* Lanes: Select the plan field want to use for the
lanes in the board. For example, | will click on
the Lanes menu, and select Program from the
drop-down. Now the board will have swim lanes
to group the cards by the Program they belong
to.

* New Plan @: Click to create a new plan in
your Portfolio. If you create a new plan from
the board view, it may not display on the board
immediately, as the new plan will likely not fit into
the board view configuration. If you would like to
view the new plan on the board, you need to go
to the Portfolio List view, locate the new plan,
and update the plan information so it fits into the
columns and lanes of the board.
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e - Column: Goals + Color By: S Q- Column: Goals + Lanes: Program = Color By: Status + Totals:

Buzinsss Value b4 CUSTOMER SATISFACTION Jira Project Names )

> CUSTOMER. SATIS . £ A CEEIEEETET
Category
= Metric
E D=fault Task Moge User Interface Enhan... :
= -
— v b T . 3 -
Q Benefits: $720,000.( Default Task Type Benefits: 52,000,000.00 |
9] ) Budget: $456,400.00 Plan Type 1
Budget: §379,508.2 Effort Health Business Unit: Applications fartolin
Business Unit: IT Prioritization Score: 56.25 ’
Prioritization Score Enterprise Architecture Priority
® w00 Process Step
Financial Health > T
1 Product
Functional Fit @ (ETERIEEL 5
- Program
Fur‘:ir‘g SD“’CE I -
- Risk Reduction
) Goals \
Benefits: $110,000.( Schedule Heaith
Budget: $151,560.0 Improve Employes Retantion ‘
i it I
Business Unit: IT lssus Health [

Prioritization Score
Jira Project Mames

Lower Cost
Product Launch Meirie I
Ohjective
Benefits: $1,270,00(
Budget: $1,148,160 Querzll Health
Business Unit: Prod Plan Type i
Prioritization Score A
Porifolio =iz — o
Priority 1

L * Totals: Select the plan field want to use as the
e I column totals. For example, | will click on the

Froduct Totals menu, and select Benefits from the drop-
Be:ef'mz'”””-oo‘ down. Now the column total value is a sum of the
B t: §790,200.0 - . . .

HeosE R fel Benefits values of all of the projects and epics in
Business Unit: Profe =
the column.

— - — © v ColumnGosk v LanesiPiogam v Color By: Stage » Plan Tye

» CUSTOMER SATISFACTIORN $292582800 <

A AGLE DEVELOPMENT

===— - = ; =
= = = ° - Al L ]
» Color By: Select the plan field want to use to o s

color-code the cards on the board. For example,
I will click on the Color By menu, and select
Overall Health. Now the cards on the board will
be color-coded by the project or epic Stage.
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T [T T
-]

* Plan Type: Select the plan types you would like
available on the board as cards. For example,

| will click on the Plan Types menu, and in the
drop-down, you can see that | could display
Portfolios, Programs, Projects, and Epics.
These are the different plan types that are
available in the My Portfolio area currently. Here
| will select Projects and Epics. This means that
all of the cards on the board represent a project
or epic from my portfolio of work.

O v ol v LavmcProgadi = Colwly S v Towks Beicks = [

SRACTION £6,100,00000 <

Filter 7 : Select plan fields to use as filters

to limit the number of items that appear in the
board. For example, | might set a filter on the
Status field, and only load in projects and epics
that have a Status of On Track.

=
(T

. -

[ I
In the screenshot below, you can see the board
with the Status > On Track filter applied. Notice
that the Filter icon is highlighted blue. This
means that there is a filter applied. To remove
the filters, simply click on the Filter icon, then
select Clear Filters (the first option in the Filter
drop-down). This will remove all filters.

— 7 [ — -]

« Zoom “: Select the size of the cards on the

board. Options here include Small, Medium, and
Large. Large is the default size.
* Small cards look like this:

= | |
L ==] | |
[ = [ ]
= =
= = e L3

* Medium cards look like this:

=] o (==
. == [ ==
- - — -}
* Large cards look like this:

» Constraints ©: Set the constraint values for

the columns in the board to run some light what-
if scenarios. The constraints are based on the
value you selected for the Totals. So, in the
example I've been using throughout this article,
the Totals, and thus the Constraints, are based
on the Benefits values of the projects and epics
in the board. To set constraints in the board:
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* Fields

1. Click on the Constraints icon, the Edit
[Selected Totals] Constraints form will
open.

2. Select the Constraint Goal. Options include
None, Above Constraint, or Below
Constraint. Because in this example | am
working with Benefits as my Total values, |
want to be above the constraint value | will
set, as more benefits from projects and epics
= more money for the organization. So, | will
select Above Constraint.

3. Set the constraint values for each column.
Again, | am working with Benefits in this
example. So for each column, | want to set
the minimum benefits | want to see from
all of the projects and epics in a column.

To set these constraint values, click into the
Constraint field for each column, and enter
the desired value.

Constraint Goal Above Constraint
Column Constraint
Customer Satisfaction 6000000
Grow Business 7000000
10000000

Run Business

Transformation SJJCCEd

Edit Benefits Constraints x

4. Once the constraints are all set, click Save.
Now, when you hover over the column
title, you can view the column Total value
compared to the column Constraint value to
see if you are hitting your goals.

|y

—— o ep—— B ——

: Select the plan fields you would like
displayed on the cards on the board. Out of
the box, the Benefits, Budget, Business Unit,
and Perioritization Score fields are displayed on
the cards. For this example, | will also add the
Funding Available and Overall Health fields
to the cards. To do this, click on the Fields
icon, then select the desired fields (Funding
Available and Overall Health) from the drop-
down. The data from the selected fields will now
be displayed on the cards on the board.

A i s B i [e———r. e

Save a Board View

Now that we have the Portfolio Board configured to
our liking, we can go ahead and save this view for
later use. To save a view:

1. Click on the Views menu. Then select Save
Board.

2. The Save View form will open. Complete the

form.

Enter a name for your view.

4. If you are an Admin, you will see the Personal
View check box. Check the check box if you
want the new view to be a personal view only.
Otherwise the view will be a Global view for all
users in your OnePlan environment.

K

w

NOTE

If you do not have Admin
permissions, you will NOT see
the Personal View check box,
and every board view you
save will be a personal view.

5. Check the Default View check box if you want
the new view to the the default view that loads
when you go to the Portfolio Board.

6. Click Save. Your new view will now be
available in the Views menu.

Portfolio Analysis - Roadmap

This article explains how to use the Portfolio
Roadmap.

@ OnePlan
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The Portfolio Roadmap is a modern and interactive * Give your new plan a Name.
visualization tool that allows you to build out c. Click Add Plan, and your new plan will
roadmap timelines of the plans in your Portfolio. appear in your Roadmap. The plan's

From the Roadmap view, you can view the Quick Edit form will also open on the right
relationships between the plans in your Portfolio, of the screen.

create and rearrange new plans, and create key
Event markers in the timeline that may impact your
Portfolio planning.

Access the Roadmap Page

To access the Portfolio Roadmap, go to the My
Portfolio area. Then click Roadmap in the upper
right corner. This will open the Roadmap page to
its default view.

2. Right-click directly on the Roadmap.
= a. Right-click on the Roadmap on the date
= you would like your new plan to start. Then
= click Add New Plan. The Add New Plan
: form will open.
: b. Complete the Add New Plan form.
.o » Select the Plan Type for your new plan.
* Select the Parent Plan for your new
The Portfolio Roadmap page lists each plan in a plan, if applicable.
roadmap timeline. * Give your new plan a Name.
c. Click Add Plan, and your new plan will
appear in your Roadmap. The plan's
Quick Edit form will also open on the right

—— of the screen.

e @ NOTE
e — Using the right-click
- o method will create a plan

with a 1-month duration
by default. The plan bar

Create New Plans in the Roadmap will begin where you
You can create new plans to add to your Roadmap. initially right-clicked on
There are three ways to create a new plan in the the Roadmap.
Roadmap:

1. Click and drag directly on the Roadmap.

a. Click and drag your mouse to create a
new bar in the date range you would like o
for your new plan. When you let go of your
mouse click, the Add New Plan form will
open.

b. Complete the Add New Plan form.
» Select the Plan Type for your new plan.

* Select the Parent Plan for your new 3. Use the New Plan button in the header.
plan, if applicable.

==

=
Err——
]
——m
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Click the New Plan button. Select the

desired Plan Type from the drop-down.

The Add New [Plan Type] form will open.

Complete the Add New [Plan Type] form.

» Select the Parent Plan for your new
plan, if applicable.

* Give your new plan a Name.

Click Add Plan. The plan's Quick Edit

form will also open on the right of the

screen.

K

NOTE

The plan's bar will not
appear in the Roadmap
until you add Estimated
Start and Estimated End
dates. You can add this
information to the plan
using the Quick Edit

form. Once the dates are
entered, the plan's bar will
appear in the Roadmap.

C.

» Update the Start and Finish dates and
times if necessary.

K

NOTE

Setting an Event's
duration to a single day
(so the Start and Finish
dates are the same) will
change the Event bar
into a diamond in the
Roadmap.

Click Save, and your new Event will
appear in your Roadmap.

I

]

2. Right-click directly on the top row of the
Roadmap.

a.

Right-click on the Roadmap on the date
you would like your new Event to start.
Then click Add New Event. The Event
Information form will open.

¢ b. Complete the Information form.
* Give your new Event a Name.
Create Events in the Roadmap * Update the Start and Finish dates and
Events are timeline markers that allow you to easily times if necessary.
bring attention to special dates like milestones,
release dates, program increments, etc. Saving a NOTE
view will save the events to that view. There are two S Sisstfine v [Evenis
ways to create a Roadmap Event: . .
duration to a single day
1. Click and drag directly on the top row of the (so the Start and Finish
Roadmap. dates are the same) will
a. Click and drag your mouse to create a change the Event bar
new bar in the date range you would like into a diamond in the
for your new Event. When you let go of Roadmap.
your mouse click, the Event Information
form will open. c. Click Save, and your new Event will
b. Complete the Information form. appear in your Roadmap.
* Give your new Event a Name.
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Resize and Rearrange Plans in the
Roadmap

uur
1N

o IMPORTANT

You can only resize and rearrange
plans with NO tasks. Once tasks
are added to a plan, it becomes
locked in place in the Roadmap. A
Gantt icon will show on the plan
bar indicating that plan has tasks.
Additionally, when hovering over
the plan bar of a an immovable
plan, a message will also appear in
the tooltip stating"Estimated Plan
dates are calcualted based on the
work plan schedule."

™

Name
User Interface Enhancements

Start
0e,/07/2023

End
08/14/2023

Business Unit
Applications

Status
{1) ©n Track

=
=
=

Estimated Plan dates are calculated
based on the work plan schedule.

You can change the date range of the plans and
Events in your Roadmap by hovering over the ends
of the bars until your cursor changes into a left/right
slider. Then click and drag the end of the bar to the
desired date.
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You can also completely move plans and Events by » Details: Click to access the plan's Plan Details

clicking on a bar, then dragging and dropping the form.
bar to the desired location in the Roadmap. * Financials: Click to access the plan's Financial
Plan.

* Resource Plan: Click to access the plan's
Resource Plan.

* Work Plan: Click to access the plan's Work Plan
list or board.

* Reporting: Click to access the Reporting pages
for the selected plan.

» Delete: Click to delete the current plan.

[}
*

View Plan and Event Information in
the Roadmap

Hover over the bars in the Roadmap to preview
basic Plan information, including the plan name,
start date, and end date. —— ¢

[ HHH o

Hover over an Event bar or diamond to preview
basic Event information, including the Event name,
start date, and end date.

Right-click on a plan bar to access that plan's
Contextual menu. Options in the Contextual menu
include:

* Quick Edit: Click to open the plan's Quick Edit ] ) ]
window. Right-click on an Event bar or diamond to access

- Share With: Click to access the plan's Share that Event's Contextual menu. From the Event
With form. Contextual menu, you can:

+ Comments: Click to access the plan's
Comments thread. You can respond to and make
new comments from this thread.

» Dependencies: Click to access the
Dependencies form for the plan. You can manage = :
dependencies between plans from this form. See *
Portfolio Dependencies: Manage Dependencies '
Between Plans [118] for more information.

» Reorganize: Click to access the Plan Reorganize
form. From this form, you can change the Plan
Type of the plan, and change the plan's parent
plan.

« Edit the Event
¢ Delete the Event

1
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Hover over the gray dependency lines between
plans to view how the plans are connected,
including the To and From Plans.

=
e —

==

L8

[
e
—m

Hover over any blank space in the Roadmap to
view the date.

Group Plans in the Roadmap

Use the Group By menu to select a plan-level field
to group the Plans in your Roadmap. For example,
you could group the plans by Business Unit or Risk.

uﬁ [

Change the Roadmap Bar Colors

Use the Color By menu to select a plan-level field
to use as the color coding method of the bars in
your Roadmap. For example, you could choose to
have the bars colored by Status, or % Done.

Filter the Plans in the Roadmap

Use the Filters menu to apply filters to the
Roadmap to narrow down the plans that are
available in the Roadmap. For example, you may
want to only view plans with a certain Status.

Set the Date Range in the Roadmap

Use the Dates menu to set the date range you
would like to view in the Roadmap. You can select a
date range preset, or set a custom range.

[
[— ]
——m

Select Which Plan Types are Available
in the Roadmap

Use the Plan Types menu to select the kinds of
plans you would like included in your Roadmap. For

example, you may only want to look at Projects and
Epics.
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Save a Roadmap View

After you have made changes to the Roadmap
view, including applying groupings, dates, bar
colors, etc. you can save that view to use again.
To save a Roadmap view:

1. Click on the View menu and select Save View.

The Save View form will open.

2. Complete the Save View form.

Save View x

* View Name: Initially, the current view name

will show. Update to a new name. If updating

a view rather than saving a new view, keep
the name as-is.

* Default View: Check the checkbox if this
is a default view. A default view will open

automatically when you go to the Work Plan.

* Personal View: Check the checkbox if
this is a personal view. It is checked by

default. Administrators may save a view as a

global view for the group by deselecting the
checkbox.
3. Click Save. Your new view will now be
available for use from the View menu.

Save the Roadmap as a Printable
Image
Click the Print icon to save the current Roadmap

view as a printable PNG image. The PNG file will
save to your Downloads folder after it is generated.

Manage Plans in the My
Portfolio List

This article provides a basic overview of how to
manage your portfolio of plans in the OnePlan My
Portfolio Area.

Select Plan Type(s)

The first thing you need to do when working in

the My Portfolio area is select the kinds of plans
you want to work with. Since the My Portfolio

area can contain several plan types, and plan type
hierarchies, the amount of data displayed in the
Portfolio can be a lot to digest. To narrow down the
view to only the plan types you are interested in,
click the Plan Type Menu to select the plan type(s)
you would like to view in the Portfolio grid.

®OnePlan 103



Using OnePlan

Plan Type: Portfolio «

v Portfolio
Yan Type
Frogram
] Epic drogram
All Types roject

Expand and Collapse Plans in the
Portfolio List

As mentioned before, the My Portfolio area can
contain a lot of data. You can use the Expand and
Collapse buttons to quickly navigate through the
different layers of your Portfolio hierarchy, making
the management of all of your plans a little easier.

Click the Expand icon to show all plans and sub-
plans in the Portfolio.

My Portfolio Business Unit
S~ Plan Type: Portfolio + @ = Group By: None » m % -
£ Plan Type Name
(] Portfolio v IData Analytics Transformation (1)
0 Program ~ I Enterprise Data Platform (7)

Project IData Warehouse Migration
Project IP‘sd ctive Maintenance
Epic ICy'I:e\:Ecuntg- Enhancement
Project |\f0\3 Phones

Project ISE\‘.-E\ Upgrades

Project I\mp'o‘.ré User Experience

Epic IDehve’lr'g Agile Sclutions

Click the Collapse icon to minimize the plans.

Business Unit

My Portfolio

o~ Plan Type: Portfolio « 3| @ Group By: None «

Callapse All
& Plan Type Name

= ) Portfolio e IProfesslcna\ Services Delivery (1)
= e Program \> ICustomer Success (3)

= ] Portfolio e IPr’oduct Innovation Portfolio (1)
= e Program > I Digital Marketing Program (3)

Update Plan Information in the
Editable Grid

The Portfolios List is editable. Add any columns to
the view you want to edit. If the field is editable

and you have permission to edit that item, click

on the desired field to change. Certain fields may
not be available for certain plan types, based on
configuration. In that case, you won't be able to edit
the value.

......

You can also bulk-update values in the Portfolio
grid. See Bulk Edit Plan-Level fields from My
Portfolio for instructions.

Recalculate Values

As you are working in the My Portfolio area, and
data is being updated, some data might get out

of sync. You can use the Recalculate function

to recalculate data in the Portfolio on demand.
Click the Recalculate icon to manually recalculate
calculated fields (including rollup fields) in the
Portfolio.

Portfolio Summary
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Comment on Plans

Next to each plan in the Portfolio list is a
Comments icon. Click on the icon to add a
comment or access an existing comment thread for
that plan.

Bulk Edit Plan-Level Fields from
My Portfolio

This article explains how to bulk edit plan-level
fields in the My Portfolio area.

1. First, highlight all of the plans you want
to update by holding down CTRL on your
keyboard, then clicking the desired plans.

2. Then, click the contextual menu (hamburger
icon next to the plan name) and select Bulk
Update. The Edit Plans form will open.

i

3. Inthe Field column, select the field(s) you
would like to update. In the Value column,
select or set the value you would like to update
the selected field(s) to.

4. To update multiple fields for the selected plans,
click Add Field, then select a Field and Value
as described in Step 3. Repeat as needed to
update all desired fields.

5. Click Update to apply the updates to the
selected plan fields.

Edit Plans x

Figkd value

Use the Portfolio Plan
Contextual Menu

Select the contextual menu for a plan to see the
available planning modules and options for that
plan. Based on a plan's type and stage, certain

features may or may not be available.

s SL\a:a Analytics Transformation (1)

l Enterprise Data Platform (7]

Favmene

Favorite

Click Favorite to mark the selected plan as a
favorite. This plan will then be listed in the Favorites
tab of the Plans Panel on your Home Page.

Quick Edit

Select Quick Edit from the plan's contextual menu.
On the right side of the screen, the plan details
form appears, condensed to one column. Scroll up
& down for the plan fields. Click the Expand icon
to open a larger view of the plan details form. The
form is editable and your edits save automatically.
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Bulk Update

You can use the Bulk Update function to quickly
update multiple fields and values for multiple plans
in your Portfolio all at once.

See Bulk Edit Plan-Level Fields from My Portfolio
for instructions on how to use this Bulk Edit
function.

Edit Plans x

Field walue
] -

Shared With

Click Shared With from the contextual menu to
quickly access a plan's Shared With form. The
Shared With form lists all of the users who have
access to a particular plan, along with their plan-
level permissions.

Shared With: Data Warshause Migraticn ®

Tlmca

[

Contribeter

Comments

Click Comments to add a comment or access an
existing comment thread for that plan.

Dependencies

Click Dependencies to access the plan
dependencies form. From this form, you can view
and manage dependencies between your various
plans.

See Portfolio Dependencies: Manage
Dependencies Between Plans for instructions on
how to manage these inter-plan dependencies.

Reorganize

Click Reorganize to reorganize the selected plan
anywhere in your OnePlan group. Using the
Reorganize function, you can change the plan

type of the plan, and its place in your OnePlan
hierarchy. The Reorganize function does not retail
any historical information of the plan's previous type
or location. It is simply a "lift-and-shift" function.

Change Plan Type: Data Warehouse Migration x
Plan Type: Praject v

Farani Plan: Enterprize Data Platform

CANCEL REORGAMIZE
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Plan Type Specific Modules

As mentioned earlier in this section, based on a
plan's type and stage, certain features may or

may not be available. Here we will explore those
optional modules and how to use the Portfolio view
to quickly access these modules for the selected
plan.

* Details: Click Details to jump directly to the
selected plan's Plan Details Form.
* Financials: Click Financials to jump directly to
the selected plan's Financial Plan.
* Resource Plan: Click Resource Plan to jump
directly to the selected plan's Resource Plan.
* Work Plan
« List: Click List to jump directly to the selected
plan's Work Plan List view.
* Board: Click Board to jump directly to the
selected plan's Work Plan Board view.
* Reporting
» Status Reports: Click Status Reports to jump
directly to the selected plan's Status Reports.
* Visualize: Click Visualize to jump directly to
the selected plan's Visualizer.
* Insights: Click Insights to jump directly to the
selected plan's Plan-Level Insights page.
* Dashboard: Click Dashboard to jump directly
to the selected plan's Power Bl Reporting
Dashboard.

Delete

Click Delete to access the Delete and Archive form.

Here, you can either completely delete the selected
plan (including all associated data), or archive the
plan, which enables your administrator the ability to
restore that plan at a later date.

See Delete or Archive a Plan for more information.

Delete Plan

Thiz will delete all plan datal To delste this plan enter 'Data Warshouse
IMigration ' in the box below:

Search for Plans in your
Portfolio

This article explains how to use the Find Plan field
to search for plans in your Portfolio.

IMPORTANT

The Portfolio-level search / Find
Plan field is tied to the Advanced
Portfolio Filtering functionality
released in May 2024. To use

the new Portfolio-level search, you
need to have Advanced Portfolio
Filtering enabled. See Enable
Advanced Portfolio Filtering for
instructions.

1. Enter part, or all, of your desired plan name
into the Find Plan field.

K

NOTE

The search only works for
plan names. It does not
search other plan fields.

2. Click the magnifying glass icon, or press Enter
on your keyboard to search. Plans that match
your search will be displayed in a list for easy
access.
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Use the My Portfolio Pre-Filters

Pre-filters in OnePlan are server-side filters that
reduce the amount of data loaded into the

My Portfolio Area, designed to help improve
performance (especially if the pre-filter is required).
In the example here, the My Portfolio Area has a
Business Unit pre-filter. So, a user would be able
to only load in plans that belong to a selected
Business Unit.

Business Unit

My Portfolio

+ IR Plar | @j
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Prioritize Plans in the My
Portfolio Area

This article explains how to use the Prioritize
function in the My Portfolio Area.

K

NOTE

You cannot use the Prioritize
function when Grouping is on in
the Portfolio.

Click Widgets in the Portfolio header, then select
Prioritize to enable reordering of the plans in your
Portfolio. The Prioritize function will allow you to
drag and drop to reorganize the currently selected
top-level plan types in the Portfolio.

So, for example, you could reorder the Portfolios
in your My Portfolio view in your desired order.
Here, | want to reorder my list of Portfolios, and
have the Brand Management Portfolio moved from
the bottom of the list to just before the Capital
Investment Portfolio. To do this, | will click the
Prioritize icon, and you will see a # column appear
in the view. This means the Prioritize function is
active and | can rearrange my list.

Next, | will select the Brand Management Portfolio
and drag it to the spot just before the Capital
Investment Portfolio.

When | let go of my mouse, the Brand Management
Portfolio is now located before the Capital
Investment Portfolio. | can now turn off Prioritizing
and continue managing my Portoflio as usual.

i
|
i

.gi
[}

The Portfolio Prioritize function is a light version of
what-if-ing. We recommend using the Modeler to
do more robust prioritization and what-if-ing. See
the Modeler section for more information on the
Modeler.
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Add or Remove Columns in the
My Portfolio Area

This article explains how to use the Columns
interface to add and remove columns from your
Portfolio List view.

Click the Select Columns icon to open the Select
Columns form.

B = PlanType Potioko = Growup By Hone = El -
g oo |

Here, you can select the columns you would like
in your view and put them in the desired order. All
available fields/columns are available on the left of
the form, and all applied columns are on the right.

To add a column to the view, select a column from
the left of the form (All Columns) and drag and
drop it to the right side (Selected Columns). You
can also set the order of the columns in your view
from the Select Columns form. Columns on the top
of the Selected Columns list will be on the left side
of the portfolio view, and columns at the bottom

of the list will be on the right of the view. Drag

and drop columns in the Selected Columns list to
rearrange. Then click OK to apply your changes.

Select Columns

All Columns Selected Columns

I\‘Jlen Type

# of Features &mﬂn

# of Backlog Tasks

# of In Progress Tasks Busmess o
# of Late Tasks State

# of Not Started Tasks Status

Select Columns

All Columns

# of Backlog Tasks

# of Features

# of In Progress Tasks
# of Late Tasks

# of Not Started Tasks
# of User Stories

ARTs and Suppliers
Accomplishments

Active Changes

Left Side of Portfolio View

Plan Type
Name

Business Unit
State

Status

Schedule Health
Financial Health
Effort Health

ssue Health

Right Side of Portfolio View

To remove a column from the view, select the
column from the Selected Columns list, and drag
and drop it into the All Columns list. Then click OK

to apply your changes.

Select Columns

All Columns

# of Features

# of In Progress Tasks
# of Late Tasks

# of Not Started Tasks
# of User Stories
ARTs and Suppliers
Accomplishments
Active Changes

Active Changes Trend

Selected Columns

Plan Type

# of Backlog Tasks

Business Unit

State

Status

Schedule Health

Financial Health

Effort Health

# of User Stories
ARTs and Suppliers
Accomplishments

Active Changes

Schedule Health

Financial Health

Effort Health

ssue Health

Group Plans in the Portfolio
List

Click into the Group By menu to select a field to
group the plans by in the Portfolio grid.
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Here is an example of the Portfolio list grouped by

Business Unit.

NOTE

This article does not cover how to
use Legacy Filters.

Add New Filters

o oo 1. Click on the Filters icon " in the Portfolio
My Portfolio ™= header. The filter interface will open on the
© v PlanType: Portioiio ¥ Group By: Eusiness Linit right side of your window.
= e les
F—1 9 VETY
= 4] falic
= L] perational Excallano =
i L 2. Select the Filter Level. Options include:
==® i oo dockonts + Flatten Items (Default): This setting allows
- you to filter on all plan-type hierarchy levels
=89 = i and displays the results in a flat list view
B i « Filter Top Level Only: This setting allows
© .
= you to filter on the top plan type level
= wes 7 < selected and displays the results in a
' hierarchy. Lower-level plans are NOT
filtered. Only top-level plans are filtered.
Filter your Portfolio
This article explains how to use the advanced
Portfolio filtering interface to build and apply filters
to your Portfolio.
Filter Level: Flatten tems .DefaJItjl
o IMPORTANT o Lo O
To use the filtering interface
detailed in this article, your 3. Select a plan field to filter on.
OnePlan administrator needs to 4. Set up the filter parameters. The filter
enable the advanced Portfolio parameter fields in the filter configuration will
filtering features. Seg Engble be generated dynamically based on the field
.Ad:[/an(t:.ed Portfolio Filtering for type of the plan field you selected.
instructions. * Number and Currency fields: If you are
filtering on a Number or Currency field,
you need to select whether you want the
resulting plans to have that field value less
than (<), less than or equal to (<=), greater
110 ®OnePlan
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than (>), greater than or equal to (>=), or
equal to (=) the set value. Then enter in the
value you want to filter your plans on.

S NOTE
For example, | could set up

a filter to view plans that all
3 S NOTE

have a Budget greater than
or equal to $500,000. That For example, | could set

filter would look like this: up a filter to view plans
that belong to the IT and

Operations Business Units.
That filter would look like
this:

* Choice and Multi-Choice fields: If you are T X  Operations
filtering on a Choice or Multi-Choice field,
select the choice value(s) you want to filter

your plans on.
» Date fields: If you are filtering on a Date

field, select the date range you would like to
filter on. You can select whether you want to
filter plans that have a date value before a
set date or after a set date. You can also
check the Today check box to filter plans
either before or after the current date.
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Created Created By

i
]
Il
i

S NOTE S
For example, | could create i

a filter to view plans that
were created before April 1,
2024. That filter would look

like this:
Created

o NOTE

o i For example, | could set
up a filter to view plans
that were created by Erlich

» User fields: If you are filtering on a User Bachman. That filter would
field, select the User you would like to filter look like this:

on. You can also check the Me check box to
filter for plans where you are the user for the
selected field.

Created By

Erlich Bachman

* Yes/No fields: If you are filtering on a
Yes/No field, select whether you want to see
plans where the selected field value is Yes or
No.

112
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S NOTE
For example, | could set up

a filter to view plans that

have Names including the
@ word "improve". That filter

would look like this:

S NOTE
For example, | could set up —

a filter to view plans where

Funding Available equals

Yes. That filter would look

like this: 5. You can set up multiple filters. Click Add Filter
to add another filter to the Portfolio.

Funding Availab

m

o
=)
il
m

=]
1]

Funding Available

I
I

» Text fields: If you are filtering on a Text field,
enter the text value you would like to filter
on.
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Ed [~ ] T
Filter Level: Flatten Items (Default) -
Budget - Remove Filters
To remove a single filter, click the Delete icon next
= T || 506000 v to the desired filter.
X
Business Unit -
IT ¥ Operations % -
Filter Level: Flatten Items (Default) -
Created hd Budget
>= $500,000.00
Before: | 04/01/2024 B O Today
After: fh [ Tocay Approval Status E
Approved Delete Filter
O me
Erlich Bachman To remove all filters, click Clear All.
Funding Available -
Yes hd

6. Once you have all the filters you want, click
Apply Filters to apply your filters to the
Portfolio view.
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X
Filter Level: Flatten Items (Default) -
Budget

== $500,000.00

Approval Status

Approved

Add Filter

Set the Row Height in the My

Portfolio Area

Click the Row Height icon to select the height
of the rows in the Portfolio grid. Options include
Small, Medium, and Large.

m v~ |=

11
|

srmall
v Medium

don (1) Large

Small rows look like this:

Medium rows look like this:

Save, Use, and Manage Views in
the My Portfolio Area

This article explains what Views are in the My
Portfolio area, as well as how to Save, Use, and
Delete Views.

Views in OnePlan retain any filters, groupings, and
columns you have applied to the Portfolio at the
time you saved the View.

Select the View menu drop-down to change views,
save views, and delete views. Global views are
shown in the first section. Only administrators can
save global views. Personal views are shown in the
second section if you have any saved.
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Select and Change Views

. Changing Views in the Portfolio is simple. Click on
Portfolio Summa Iy = the Views menu, and select the desired View from
the drop-down.

-
Compliznce

Save a View
Portfolio Pricritization
1. Click on the Views menu, then select Save
View. The Save View form will open.

ortfolic Summary

FProgram Backlog Progres

(K]

Eroaram Eirancial Summary 2. Give your new View a name.

rogra snclsl -L Iary 3. If you are an Administrator, select if this View
is a Personal View. If the check box is
left unchecked, the View will be global and

=, -\.\_ a1 .
Fr*-’g umma available for all users.

Schedule Summary |§ NOTE

If you do not
~ have Administrator/Owner
2UmiMmary permissions to your OnePlan

group, the Personal View
_ ) option will NOT be available.
rendin d All views that you save will be
personal by default.

FPersonal Portfolio Summary 4. Check the Default check box if you want the
: new View to become the View that loads when
you first access the Portfolio.

-
—— -
Sl WIEW
E‘: =t =T
e | e i W T NF
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Save View

Vizw Nams IT Portfolic Summary

5. Click Save. Your new View is now available in

the Views menu.

Delete a View

1. Select the View you would like to delete from

the Views menu.

Once the View loads into the Portfolio, click the
View menu, then select Delete View.

3.

Personal Portfolio Summary -

Compliznce

Effort Summary
Financial Summary
Portfolio Alignment
Portfolio Prioritization

-
Portfolio Summary

-
=
L]

]

-
LA ]
t
y
]
u
3
i
L]
LA
[
w
B

Schedule Summary
Summary
Trending

Personal Fortfolio Summary

L
o
i
(1K)

L

i}
LK)
1
K]
A}

)

Confirm that you would like to delete the
current View. Now the View will no longer be
available from the Views menu.
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Delete View x

9 Are you sure you want to delete the current view?

Portfolio Dependencies:
Manage Dependencies Between
Plans

This article explains how to build and view
dependencies between plans in your portfolio. This
is a visual link flag that shows on the Portfolios
page, with the Gantt chart showing. The plans
themselves do not get their dates shifted nor other
details changed.

Open Dependencies

From the Portfolios area, click the contextual menu
for the desired plan. Then select Dependencies.
The Dependencies popup will open. You can then
view and edit dependencies directly from popup.

f:;——\.ri—-\. L # I-F
o] [ ) ot W R L
T o
L p= -

_i-\.—r\.i——\.—
INanclals

:’:TH - O
- e it | e e =

118 ®OnePlan



Using OnePlan

o s 00 et

You can also access dependencies from the plan
details form. Click the Dependencies icon == to
open the Dependencies popup. You can then view
and edit dependencies directly from popup.

Add Dependency

1. Click the Add Dependency button * to create
a new depency/link between plans. The Add
Dependency form will open.

2. Complete the Add Dependency form.

* Plan Type: Select the plan type of the plan
you would like to add as a dependency.

* Target Plan: Select the plan you would like
to add as a dependency.

» Direction: Select the direction of the
relationship between the current plan and
the new dependency.

* Type: Select the type of dependency the
new dependency will be.

* Link Type: Select the type of relationship will
exist between the two plans.

* Description: Enter a description for the new
dependency.

3. Click Add to create the dependency.

Add Depedency x

Flan Type: Project

Dependencies Show on Gantt Chart
Show the Gantt. The plans' gantt bars will have
a line with an arrow to signify which plan is
dependent on which, and the link type.

Use the Pivot Chart in the
Portfolio Area

This article explains how to use the Pivot Chart in
the My Portfolio Area.

Access the Pivot Chart

To access the Pivot Chart, click on the Widgets
button in the Portfolio header, then select Pivot
Chart. The Pivot Chart will open in the bottom half
of your window.
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Select the Pivot Chart Row Labels,
Column Labels, and Values

There are a couple of ways that you can add

and remove fields and values from the Portfolio
Pivot Chart. The Pivot Chart interface gives you the
ability to customize the chart so you can analyze
the Portfolio data that is most important to you.

Drag and Drop Fields

The first method for adding or removing fields or
values from the Pivot Chart is to simply drag and
drop the fields.

To add a field to the Pivot Chart, select the field
from the All Fields section, then drag to the desired
location - either Values, Row Labels, or Column
Labels - and drop the field. The Pivot Table will
automatically update with the added field.

Year “ | Cost (Sum)

QJuarter

Month

Plan

# of Backlg...

# of Featur).

Plan

# of In Prog..
# of Late Ta...
# of Not Sta... Cost Type (Fi...
# of User 5t..
Accomplish...

Active Chan...

Active Chan...

Coluvmn labels

Active Issue...
Active [szue...
Active Risks ...
Actual Hour...
Actuals (Plan)
Additional C...

tnnroval st T

To remove a field from the Pivot Chart, select
the field from either the Values, Row Labels, or
Column Labels section, then drag and drop it
into the All Fields section. The Pivot Chart will
automatically update with the field removed.
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Year “ | Cost{Sum)

iJuarter

# of Backldy..

# of Featur..

# of In Prog... m
# of Late Ta... Plan

# of Mot Sta... Cost Type (Fi...
# of User 5t...

Accomplish...

Active Chan...

Active Chan...

Colum labels

Active |ssue...

Active |ssue...

Active Risks ... Quarter I
Month

Actual Hour...
Actuals (Plan)

Additional C...

spnrowval st T

Use the Field Menu

The second method to add or remove fields or
values from the Pivot Chart is to use the Fields
Menu.

To add a field, click on the desired field from the
All Fields section, then select where you would

F

Year Cost (Sum)

Quarter |

Add to Row lzbels

Add to Column labels
Add to Walues
b ) =2 (W
# of In Prog... m
# of Late Ta... Plan
# of Mot 5ta... Cost Type (Fi...
# of User 5t..
Accomplish...
Active Chan...
Active Chan...
Active |ssue...
Active Issue... Year
Active Risks ... Month
Actual Hour...

Actuals (Plan)
Additional C...

tonroval St T

To remove a field, click on the desired field from the
Values, Row Labels, or Column Labels sections,

then select Remove Field. The Pivot Chart will
automatically update with the field removed.

like

to add the field from the menu. The Pivot Table will

automatically update with the added field.
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All fields ———

hMowe up
Year

-

=) = e

Quarte

Month Move 1o beginning

- -
et LI [

Plan

# of Ba Maove 1o Row labels

# of Fe - I

#of In
howve 1o Values
# of La

i ] R

# of Us SoriAfoZ
Accom SortZic A
Active Disable sorting
Active
Active | SR e e
. Lakel filers b
Active |
r t »
Active Yalue filters
Actual Hour... Quarter

Actuals (Plan)
Additional C...

Apnroval st 0 T

Using the Field Menu, you can also rearrange the
field order, relocate the field to a different area of
the Pivot Chart, sort the field values, and apply

filters to the field values.

Configure the Pivot Chart Settings

You can use the Pivot Chart settings to configure
the appearance and layout of your Pivot Chart.

1. Click on the settings gear in the All Fields

header. The Settings form will open.

Select a Layout. Options include:
* Outline

+ Compact (default)

HATEE AR EA ]

[imlll[im‘

* Tabular

Select the Row subtotal position. Options
include:

* First

122
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Select the Column subtotal position. Options
include:
+ First

+ Hide

« Last

Select the Row total position. Options include:

* First

+ Hide

* Last

* Last

Select whether to Show zero as blank or not.
Options include:

* Yes

* No

Click OK to apply your changes to the Pivot
Chart.

Export the Pivot Chart

OnePlan allows you to export the Portfolio Pivot
Chart to many different formats, including:

Excel xlIsx (pivot table definition)
Excel xIsx (all items)
Excel xlsx (visible items)
Excel xml (all items)
Excel xml (visible items)
CSV (all items)

CSV (visible items)

TSV (all items)

TSV (visible items)
HTML (all items)

HTML (visible items)

To export your Pivot Chart:

1.

Click on the Widgets icon in the Portfolio

header, then select Pivot Chart > Export, and

select the format you would like to export to.

2. The file will be saved to your Downloads folder.
Select the Column total position. Options
|ncIL.Jde: o
* First
IR
+ Hide '
@ OnePlan 123
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Use the Gantt in the Portfolio

Area

This article explains how to access and analyze the
Portfolio Gantt.

To access the Gantt click on the Widgets button in
the Portfolio header, then select Gantt. The Gantt
will open in the right half of your window.

. | R P— £ [ |:|

When the Gantt chart is open, additional icons
will show for Gantt view controls including Zoom
In, Zoom Out, and Zoom Fit.

Looking at the Gantt, there are a few items to note:

» Each bar represents a plan in the Portfolio. The
bars' coloring is determined by logic set up by
your OnePlan administrator. The length of the
bars correlates to the duration of the plan.

r.s

* Milestone events are represented by diamonds
on the Gantt bars.

* Relationships between plans are represented by
a gray line connecting two plan bars.

* Hovering your cursor over the bars, diamonds,
and dependency lines will bring up a tooltip,
giving you some general information on the plan,
milestone, or relationship.

Use the Financial Plans Panel in
the My Portfolio Area

This article explains how to access and use the
Portfolio Financial Plans panel.

To access the Resource Plans panel, click on the
Widgets button in the Portfolio header, then select
Resource Plans. The Gantt will open in the right
half of your window. A read-only view of a Global
Resource Plan in the bottom half of the screen.

e
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You have control over the plans that are included
in the Financial Plans panel. When you open the
panel, a new column is added to the Portfolio list |
filled with check boxes. Plans with the check box
checked are included in the Financial Plans panel. [}
Plans with the check box unchecked will not be
included.

Use the Resource Plans Panel
in the My Portfolio Area

To access the Resource Plans panel, click on the
Widgets button in the Portfolio header, then select
Resource Plans. The Gantt will open in the right
half of your window. A read-only view of a Global
Resource Plan in the bottom half of the screen.

A read-only view of the Global Resource Plan in the
bottom half of the screen. The Gantt chart will also
open.

1 "111”

You have control over the plans that are included
in the Resource Plans panel. When you open the
panel, a new column is added to the Portfolio list
filled with checkboxes. Plans with the check box
checked are included in the Resource Plans panel.
Plans with the check box unchecked will not be
included.

'||"||11
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Modeler

Portfolio Modeler Overview

This article provides an introduction to the OnePlan
Modeler app.

To enable it, your administrator will need to install
the "Modeler" app.

https://player.vimeo.com/video/756500504

The new portfolio Modeler allows for advanced Create a Modeler Folder
top down strategic portfolio planning. The Modeler

allows you to: This article explains how to create a folder in the

Modeler app to group and organize your various

+ Create multiple models and scenarios to map models.
out possible ways to meet your goals within set
budgets. See Create a Model Scenario [131] and
Create a Modeler Model [127]. 1. Select New Item > Add Folder. The Add

* Organize multiple models into folders. See Folder form will open.

Create a Modeler Folder [126].

* You can then compare scenarios to find

the optimal plan. See Analyze Model

Scenarios [132]. 0 v + E
* Multiple people can create their own models

using the plans and constraints they pick. Each

model can contain one or more what if scenarios.

You can then share the models with other

people to view and collaborate. See Create a Add M Dd e'
Model Scenario [131] and Create a Modeler
Model [127].

« Analyze your various scenarios using OnePlan's Add Folder
powerful project management and visualization
tools. See Portfolio Modeler Resource Plan [134],
Portfolio Modeler Financial Plan [135], Portfolio .
Modeler Visualizer [132], Portfolio Modeler 2. Enter a name for your new folde.r. Then click
Bubble Chart [133], and Additional Modeler View Add. The new folder is now available.
Options [139].

To create a new folder:

126 ®OnePlan
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Mar

Add Folder x

5T
= Product Development
= Marketing

= Strategic Realization Office

Training

Folder Security

You can share Modeler folders with others on your
team for easy collaboration. To update a folder's

securtiy:

1. Click the hamburger menu next to the desired
folder. Then select Security. The Shared With
form will open.

K

NOTE

The Shared With form
displays all of the people who
the folder is currently shared
with.

2.

3.

Add Model
Add Folder
Security
Edit

Delete Folder

To share the folder with another user, start

'I'....:.,..:.qg

typing their name into the Add User field. Then

select the user from the search results.

Shared With

To remove a user from the folder, click the

Delete icon next to their name.

Create a Modeler Model

This article explains how to create a Modeler

model.

@ OnePlan
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Create a New Model
To create a new model:

1. Select New Item > Add Model. The Add
Model form will open.

O v

Add Folder - =

* Filter: Create an apply filters to refine the
items that are brought into your model. In

2. Complete the Add Model form. this example | applied filters so | am only
* General Tab bringing Projects into my model.

* Name: Enter a name for your model.

* Description: Enter a description for your e o
model.

* Folder: Select the folder where you would
like this model to be stored. =
add Modsl 7 % o - b o

==
* Fields Tab

» Constraint Target Fields: Select the
target field(s) where you want the scenario

rollup values to be less than the selected
' target for your model. In this example |
* Plans Tab chose the plan-level field Budget.

* Filter Plan Lookups?: Select a lookup + Benefit Target Fields: Select the target
field to filter on related plans. In this field(s) where you want the scenario rollup
example, | am filtering on Associated values to be greater than the selected
Key Results, so | am bringing in plans target for your model. In this example |
associated to particular key results. chose the plan-level field Benefits.

+ Initial Sort: Select which field to sort the
items in your model by. In this example
| chose the plan-level field Prioritization
Score as my sort by field.
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Add Model 7%

* Resources/Costs Tab
» Cost Types: Select the cost types you
would like to load in for the financial and
resource data in this model.

NOTE

If you do not select a
resource plan or financial

Copy a Model

You can also copy existing models to use as a base
for a new model.

To copy a model:

1.

Click the hamburger menu next to the model
you want to copy. Then select Copy Model.
The Copy Model form will open.

Enter a name for your new copied model. This
is required, and you cannot progress without
giving your copied model a name.

Review the model settings by clicking Next to
move through the Copy Model form.

If you are happy with the model settings, click
Copy. A copy of the model will be created.

plan cost type, then 2.

the resource plan and/or

financial plan options will

not show in the model.

3.
Em
Click Add to create the model. The model 4.
is now available for analysis. See Create
a Model Scenario [131] and Analyze Model
Scenarios [132] for more information.
@ OnePlan
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Model Security

Multiple people can create their own models using

the plans and constraints they pick. Each model

can contain one or more what if scenarios. You can

then share the models with other people to view
and collaborate.

1.

Click the hamburger menu next to the desired
model. Then select Security. The Shared
With form will open.

K

K

NOTE

The Shared With form
displays all of the users that
the model is currently shared
with.

NOTE

Users who are in the parent
folder Shared With will have
access to all models within
that folder.

K

NOTE

You are only sharing the
selected model with the user.
They will not have access

to other models in the

folder unless you give them
access to each individual
model, or share the folder
with them. See Create a
Modeler Folder [126] for more
information.

3. To remove a user from the folder, click the
Delete icon next to their name.
= Ig NOTE
You can only remove users
Se(: U rit}/ who were added to Shared
With at the model level.
Otherwise you will need
Ed 'I: to edit the folder security
| settings. See Create a
Modeler Folder [126] for more
information.
Delete Model
2. To share the model with another user, start
typing their name into the Add User field. Then e
select the user from the search results. ———
o |
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Create a Model Scenario a. Click the Scenario menu in the header.
Then select Save Scenario. The Save

This article explains how to create a scenario in a Scenario form will open.

Modeler model.
[ | - =) Scenario: Mone * s <2 I
1.  Open the Analyze panel. _ v e
2. Enter your target cost and benefit values in the - ' {50 Bug
Current Target row for the. These fields are
then color coded based on which items are "In" )

or "Out" in the list below.
b. Enter a name for the new scenario. Then

click Save to save the new scenario.

This scenario will now be available in the
Scenario menu, and in the Analyze panel
(see Analyze Model Scenarios [132] for
more information).

'm‘EJ Save Scenario x

» The cost field will be green if the rolled .
up costs of the "In" items is less than the

set target cost value. It will become red if
the rolled up costs become greater than the

target.
+ The benefit field will be green if the rolled up
benefits of the "In" items is greater than the Scena rio: N one ¥

set target benefits value. It will become red if
the rolled up benefits become less than the
target.

« None

3. Check the checkbox next to an item to mark it
as "In" for the scenario. Items that are "In" are

included in the roll up calculation for the cost $ 5 M B Ud ge-t

and benefits.
4. Uncheck the checkbox next to an item to mark
it as "Out" for the scenario. Items that are "Out"

are not included in the roll up calculation for the $4 5M Bu dg et

cost and benefits.

{ = Save Scenario

5. Once you are happy with the target values, .
and the items that are "In" and "Out", save the Malata Cramaria
scenario. To save a scenario:
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IMPORTANT

If you update a scenario (drag
and drop, or update in or out),
and try to navigate away from the
model before saving, you will be
prompted to save before leaving.

Analyze Model Scenarios

This article explains how to use the Analyze
function of the Modeler.

Once you have created a few scenarios in your
model that you are happy with (see Create a Model
Scenario [131]), you can compare scenarios to find
the optimal plan.

To compare the scenarios in your model, click

Analyze = . The Analyze panel will open at the
bottom of the screen.

NOTE

The cumulative comparison charts
will update in real time as you
move plans in / out or drag and
drop to a different estimated start
date.

K

The List view shows a side-by-side comparison of

the Cost and Benefits for all of the scenarios in your

model, making it easy to compare and select the
scenarios that best meet your needs.

The Details view allows you to select two scenarios
from your model to compare the selected plans in
the different scenarios. This way, you can easily
see which plans are most important to your team,
and need to be taken on regardless of the scenario.

The Dashboard view allows you to select two
scenarios from your model and shows you three
bar chart comparisons:

 # of Checked Plans

* The selected Less Than Field (configured by the
Model creator) (Budget in this example)

* The selected Greater Than field (configured by
the Model creator) (Benefits in this example)

Portfolio Modeler Visualizer
The visualizer is available from within the modeler.
See the Visualizer Overview article for more
information on using the OnePlan Visualizer.

From the Dependencies view, you can visualize
dependencies a across plans in your model.

From the Runway view, you can visualize Portfolio
Runways across plans in your model.
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Portfolio Modeler Bubble Chart

This article explains how to access and use the
Modeler strategic bubble chart.

Click on the Charts icon to open the drop down.
Then select Bubble Chart. The chart will open in
the bottom half of the screen.

When you first open the Bubble Chart, it will be

blank. You need to set up the X and Y axis, and the

bubble size values. Follow the instructions in Set
Up the Chart [133].

Set Up the Chart

The Portfolio Modeler Bubble Chart lets you select

fields you want for each axis of the chart to easily
visualize and compare your plans across your
portfolio.

To set up the bubble chart, select fields for the
Xand Y axis, and the bubble size from the drop
downs at the top of the chart. You can also select
to include plans that are "out" in the model. By
default, the bubble chart only displays plans that
are marked as "in" in the model.

Shaw Out Plans:

In this example, | have selected the following
values:

+ X Axis: Budget

* Y Axis: Benefits

* Bubble Size: Prioritization Score
* Show "Out" Plans: Yes

-

Save the Chart View

To save the chart configuration:

1. Select the View drop down, then click Save.
The Save View form will open.

2. Complete the Save View form:
* Name: Enter a name for your view.

* Personal View: Check the checkbox to save

the view as a personal view for your use
only.
3. Click Save.

Save View x

@ OnePlan
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Portfolio Modeler Resource

0
Plan -
This article explains how to access and use the | % Model Resources
Resource Plan from within the Portfolio Modeler. |
Flans k All Resources

The Resource Plan is available from within the
Portfolio Modeler to view your resource availability Plan Lines B
while creating your optimal scenarios.

You can also choose to show all plans, or just the

"in" plans data.
@ NOTE
If you do not select a resource plan -
cost type when creating the model, -
then the resource plan options will
not show in the model. Rezources b
Model Plans
Click on the Resource Plan icon to open the Plan Lines » | % AllFlans
Resource Plan pane in the bottom half of the
screen.
You can also filter on the status of each resource
booking (proposed vs committed).
;:D -
= Resources b
firm oo . p— Elzrs b
Data Selection v Commitiad
When loading the modeler, only resources used in
the 'in" plans will be shown by default. You can use Propose
the options in the Data Selection model to load in
desired resources.
Charts

You can use the resource capacity vs demand chart
to better visualize availability.

Click the Charts icon to open the drop down. Then
select the chart you would like to view. Options

You can use the data selection option to show all include:

resources if needed.
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+ List: Opens the default resource plan grid view.

» Capacity vs Demand: Opens a stacked bar
chart showing resource capacity against demand
over a selected time period.

NOTE

The resource capacity vs
demand chart will update in real
time as you move plans in / out
or drag and drop to a different
estimated start date.

"

Export the Resource Plan

You can export the resource plan grid data to excel
(XLSX or CSV).

Click on the Export icon to open the drop down.
Then select the format you would like to export the
resource plan to.

Al
I'I g I:II

Portfolio Modeler Financial Plan

This article explains how to use the Financial Plan
view in the Portfolio Modeler.

NOTE

If you do not select a financial plan
cost type when creating the model,
then the financial plan options will
not show in the model.

K

Click the Financial Plan icon to view the financial
plans for all items in your model to further analyze
financials while creating various scenarios.

Charts

You can view cumulative financial graphs from
within the modeler. This makes it easier to visualize
cost issues.

Click the Charts icon to open the drop down. Then
select the chart you would like to view. Options
include:

+ List: Opens the default financial plan grid view.

* Cumulative Costs vs. Target: Opens a line and
bar chart comparing cumulative costs to target
benefits or actuals (depending on the cost type
selected in the List view) over a selected time
period.

+ Cumulative Comparison: Opens a line
chart showing cumulative benefits or actuals
(depending on the cost type selected in the List
view) over a selected time period.
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Portfolio Modeler Kanban
Board

This article explains the features and functionality of
the OnePlan Portfolio Modeler Kanban Board.

OnePlan Portfolio Modeler Board is a visual tool
used to create various "what-if" scenarios of plans
within a portfolio. The board includes a series of
columns and/or lanes that represent the different
stages or phases of the plan lifecycle, and it can be
used to display information about each plan, such
as the plan name, owner, status, budget and more.

When using the Kanban in the modeler, all the
changes made are "what-if" changes that do

not affect plan data. This could be used to

organize plans into different lanes and columns (for
example program increments, releases, quarters,
etc.). When you do this, you can add constraints to
each column to model how you could organize your
plans while staying within your selected constraint
(for example points, hours, or budget).

Access the Modeler Kanban Board

To access the Kanban board, simply select the
Board tab in the upper right corner of the Model
window. Once in the Board view, you can either
create a new board scenario (see Create a
Board Scenario [136] for instructions), or select
a previously saved board scenario (see Open a
Saved Board Scenario [138] for instructions).

Create a Board Scenario

The first time you load the Kanban, the plans will be
ordered based on the priority set in the list view.
Only plans marked as "in" will be shown in the
Kanban.

All of the board configuration settings are available
here in the board header.

* Column: Select the plan field want to use for the
columns in the board. For example, | will click
on the Column menu, and select Goals from the
drop-down. Now the Goals plan field will be used
for the columns in the board.

Column: Goals - Lanes: N

-
_—nr— = |
L =i

Enterorise Architecture
~e
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=P =gl
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.® 2 : =

* Lanes: Select the plan field want to use for the
lanes in the board. For example, | will click on
the Lanes menu, and select Product from the
drop-down. Now the board will have swim lanes
to group the cards by the Product they belong to.

» Color By: Select the plan field want to use to
color-code the cards on the board. For example,
I will click on the Color By menu, and select
Overall Health. Now the cards on the board will
be color-coded by the project or epic Overall
Health.

Column: Goals + Lanes: Product + Color By: None + Totals: N

Column: Goals « Lanes: None « Color By:

CUSTOMER SATI

Service Offerini

Dafault Task Typs

Effort Health

CUSTOMER SATISFACTION v None af

# DYNAMICS 365

Approval Status

Assodated Portfolio

Data Warehouse Migra... L\
Enterprise Architaciure
® 330d | Finzncial Healh .
Functional Fit v
User Interface |
Funding Source -
- ure
L 49d e  OFFICE 365 Financial Health
Improve Employes Reteniion Eunctional it
Product Launch S
. " Funding Source
lzzug Healh
Jira Project Names
Lower Cost New Customer Support... C
Metric N
Lower Cost
Obiartive Metric
Objeciive ~ AU
Objzctive
Owverzll Health
WINE
Plan Type
Portfolio
Priarizy Co— @
- Cr [— ]
Process 5tg s i e i
— N ] T
| m— ik =
"'I'ﬂ (= W]
) : :
Frogram
rr——" T CETTESSS——
) s Lk - ]
Risk

* Totals: Select the plan field want to use as
the column totals. For example, | will click on
the Totals menu, and select Benefits from the
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drop-down. Now the column total value is a sum
of the Benefits values of all of the projects and
epics in the column.

Filter 7 : Select plan fields to use as filters
to limit the number of items that appear in
the board. For example, | might set a filter on
the Status field, and only load in projects and
epics that have a Status of On Track.

Zoom - : Select the size of the cards on the
board. Options here include Small, Medium,
and Large. Large is the default size.

Constraints “ : Set the constraint values for
the columns in the board to run some light what-
if scenarios. The constraints are based on the
value you selected for the Totals. So, in the
example I've been using throughout this article,
the Totals, and thus the Constraints, are based
on the Benefits values of the projects and epics
in the board. To set constraints in the board:

1. Click on the Constraints icon, the Edit
[Selected Totals] Constraints form will open.

2. Select the Constraint Goal. Options
include None, Above Constraint, or Below
Constraint. Because in this example | am
working with Benefits as my Total values, |
want to be above the constraint value | will
set, as more benefits from projects and epics
= more money for the organization. So, | will
select Above Constraint.

3. Set the constraint values for each column.
Again, | am working with Benefits in this
example. So for each column, | want to set
the minimum benefits | want to see from
all of the projects and epics in a column.

To set these constraint values, click into the
Constraint field for each column, and enter
the desired value.

Fields = : Select the plan fields you would

like displayed on the cards on the board.

For this example, | will also add the Funding
Available and Overall Health fields to the cards.
To do this, click on the Fields icon, then select
the desired fields (Funding Available and Overall
Health) from the drop-down. The data from the
selected fields will now be displayed on the cards
on the board.

Save a Board Scenario

You can save Kanban board scenarios. The
column, lane selected, and the order of the plan
cards are saved in the scenario.

To save a Kanban board scenario:

1.

Click the Board menu, and select Save Board
from the drop-down menu. The Save Board
form will open.

Enter a name for your board scenario in the
Board Name field. Then click Save to save
your board scenario. The new board scenario
will now be available from the Board menu.

Save Board x

Board Namse Goals/Product Sc:‘\‘a-\d

Board: None -

Open a Saved Board Scenario
To open a previously saved board scenario:

Click the Board menu, and select the scenario
you would like to open.
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[rntea P

Delete a Board Scenario
To delete a previously saved board scenario:

1. Click the Board menu, and select the scenario
you would like to delete.

NOTE

You must open the board
scenario to delete it.

[rntea P

::::—mz—m_o

2. Click the Board menu again, and select Delete
Board. The Delete Board confirmation will
open. Click Yes to delete the board scenario.
When you return to the Board menu, the
deleted scenario will no longer be available.

SEIMOSG0 4 coicaN BCEmES senmacs

Delete Board x

9 Are you sure you want to delete the current board?

Board: No b

Additional Modeler View
Options
This article explains the additional view options

available in the Modeler to further analyze your
models.

In addition to the compare scenario function (see
Analyze Model Scenarios [132]), the Modeler has
additional view options available to help you further
analyze your models.

Gantt

The Gantt can be used to shift projects in the
timeline to build your roadmap.

Pivot Table

The Pivot Table is available to get a high level
overview of selected data to help you further
investigate your different scenarios.
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Quick Edit

Open the plan Quick Edit menu to easily modify
plan details as needed from the modeler.
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Work Plan Grid

Access the Work Plan Video Length - 4:17
This article explains how to access the Work Plan https://player.vimeo.com/video/757670914
for your plan.
Video Length - 0:36 Save the Work Plan
After you make changes to your plan, you will need
https://player.vimeo.com/video/757677433 to click the Save button to save those changes.

From the Home Page

From the home page, in the Plans panel, click the -
quick edit menu next to the desired plan. Go to

Work Plan and select either List or Board.

*1 © ~ | EH O

The work plan will not save right away, allowing

= users to review their plans prior to saving. The
*® ‘o save button also allows users to revert the plan (not
e o save) if they do not like the changes they made
m E g The save button Improves performance when
R editing a work plan since it will not have to wait for
= auto save.
Add Work Items
From the My Portfolio Area
From the My Portfolio area, locate the desired
plan. Click the quick edit menu. Go to Work Plan
and select either List or Board. NOTE

You cannot add new work items
e T S T S when Grouping is on.

Click the Add Item button to add tasks, or other
work items to your work plan. OnePlan supports
many kinds of work items to best suit your work
method.

Work Plan List Header Buttons

and Menus

This article explains the icons and functionality of
the header in the Work Plan List page. Depending
on the work type selected, the icons may be
different, as certain functionality applies only to
certain work type.
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Fl | ¢ -+ @ 2 | view
g~ (@ -] B O
- - Name
. _ o Support Customer using Mobile
Add Task
I'i".ll EEI T e Scope

. - - - Determine project scoping
Add Backlog

Secure core resources

P — - Secure project sponsorship
Add Risks
Define preliminary resources
M JE— Scope complete
1 l‘-'l.d'j SakaiTa
e Analysis/Software Requirements
g ) — - Conduct needs analysis
1.1 Add Changes
Draft preliminary software specifications
2, i i - Review software specifications/budget with team
12 Add Key Decisions > :
Develop preliminary budget
| ns=rt |—:r\.ﬂ Incorporate feedback on software specifications
2=l LIS
1.2
-

Click the Collapse icon to minimize the work items.
You can also add items from the form at the bottom

of the screen.

1y
+
1l
)
)
...
&1
5
d

o -
prame

Support Customer using Mobile

sa

asscoB8s
LCLELEEETTEEr

> Scope

> Analysis/Software Requirements

R

Design

Development

Expand and Collapse Work Items festing

Training
Documentation

Pilot
NOTE

You cannot expand or collapse
your work plan if Grouping is on.

Deployment

R "V

Post Implementation Review

Indent and Outdent Work Items

Use the Indent and Outdent icons to build out the
work breakdown structure (WBS). Indenting makes
an item a child item.

Click the Expand icon to show all work items and
sub-items in the Work Plan.
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o IMPORTANT i il
To indent or outdent the tasks,
you must sort the WBS column Support Customer using Mobile
first. Once the tasks are in WBS 1 = “~  Scope
order, you will be able to indent " = Determine project scoping
and outdent tasks. - =
1.3 = Secure project sponsorship
1.4 = Define praliminary resources
1.5 = Scope complete
I; = Document lessons leamed I
S NOTE
You cannot indent or outdent work
items when Grouping is on. 2 @ =]
Support Customer using Mobile
1 = Scope
11 = Determine project scoping
S N OTE 1.2 = Secure core resources
When you indent or outdent 12 = Secure preject spensorshi
a work item with Timesheet 14 = Define prefiminary resources
Hours, a message will prompt s = Scope camplete
you to recalculate your schedule [ = e e ]
to update timesheet hour
calculations. This serves as a
helpful reminder, ensuring that Link and Unlink Work Items

users are aware of the potential
impact on timesheet hours and
prompting them to recalculate for
accurate scheduling information.

In the example below, Document lessons learned
is at the same level as Scope. When we indent

Document lessons learned, it becomes a child of
Scope. Notice the WBS order number has changes

NOTE

It is best practice to sort the WBS
column before you link tasks.

To link items:

from 2o 1.6, indicating that Documenting 1. Hold down the CTRL key to select two items.

lessons learned is the sixth child of Scope. 2

the dependent item.

Click the Link icon. The second item becomes

@ OnePlan
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m
4
(]
4
)
m
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|

ssecene

4 Support Customer using Mobile )

\ Scope

®
sssoow

Determine project scoping -

Secure core resgurces

Secure project sponsorship

Define preliminary resources Undo and Redo
Click the Undo and Redo icons to undo or redo
actions as needed.

[
T 1 {11

To unlink items:

1. Select the dependent task only.
2. Click the Unlink icon.

v Support Customer using Mobile
1 = ~ Scope
1. = Determing project scoping
- = Request Updates
1.3 = Secure project sponsorship
14 = Define preliminary resources 1. Click the Updates icon.

2. Complete the Request Update form. Click

Send Update Request button when ready.

» Tasks: Select either Selected Tasks or
Tasks Assigned to Me. You may want
to select Tasks Assigned to Me to send
yourself regular reminders to update your
status.

+ Select Fields: Use the drop down menu to
choose which fields you want updated by the

= recipient(s).

» Schedule: Select either Send Now, Daily
(specific days & time), or Monthly (specific
day of the month).

* Enter a Message: This message will be in
the email body requesting updates.

If using the Link icon, the relationship is
automatically Finish-to-Start relationship with 0 lag
days. If you want to specify different link type or

lag time, select the parent item and open the Quick
Edit window. Go to the Dependencies tab to make
your changes.

VAT Vi

Open the Resources Panel

Click the Resources icon to open the Resources
panel for the plan. You can then drag and drop
resources from the panel onto Work Items to assign
the resources to the item.
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o

Request Update »

Review Status Updates

1. Click the Status Updates icon. The Status

Updates pop-up will open.

2. In the Status Updates pop-up, you can view
all of your status updates.

a. Check the check box next to the desired
updates to select. You can select multiple
updates at a time.

b. Click Accept to accept the selected
updates, or Reject to reject the selected
updates.

View Menu

Select the View menu drop down to change views,
save views, and delete views. Global views show
in the first section. Only administrators can save
global views. Personal views show in the second
section, if you have any saved.

See Modify and save Views in the Work Plan
Grid [159] for instructions to edit, save, and delete
views.

Planning +

z

Flanning

Ganit

Complated Tasks

Effort

Planning Q4

Apply Filters

Global Views

Personal Views

Click the Filters icon to select and apply filters to
the Work Plan Grid. You can select multiple filters.

Click Clear Filters to clear all filters.

3 NOTE
As of February 2024, you can

filter your Work Plan on Assigned

Resources. This improvement
enhances the filtering options,
providing a more refined and

efficient way to focus on work
items associated with specific

resources.

@ OnePlan
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Clear Filtars

Fame 4
% Done ’
Actual Cost 4
Actual Revenue 4

Group Work Items

Click the Group By icon to select a field to group

the work items by in the grid.

K

NOTE

When grouping is enabled,
scheduling actions such as drag
and drop, indenting, adding

work items, etc., are temporarily
disabled to maintain the integrity of
the grouped view.

L |
H
4
[T
1l

Open the Gantt

Select the Gantt icon to show the Gantt chart.
Select it again to close the Gantt chart.

When the Gantt chart is open, additional icons will
show for Gantt view controls including: Zoom In,
Zoom Out, Scroll To, and Zoom Fit.

(T

Sub Plans

Click the Sub Plans icon. The Select Sub Plans
form will open.

If the current plan has sub plans, you can load them
into the current Work Plan. Check the check box
next to the sub plans you would like to add. Click
Load Sub Plans. The selected sub plans will be
added to the current Work Plan Grid.
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= @

Select Sub Plans x

* World-Class Customer Support
Support Customer using Mobile
Framework to port applications t...
Service interface to support Rest...
Fabrikam
Counter the Heartbleed web sec...

* |mprove Infrastructure
VOIP Phones
Microsoft Teams Integration and...
Al for remote Weather Stations

Server Upgrades

-

LOAD SUB PLANS

Connected Systems

You may have additional systems integrated with
OnePlan, such as Project Desktop, Project for
the Web, Azure DevOps, etc. If so, a Connected
Systems icon will show on the header to connect
this plan to its integrated counterpart in the other
system.

e L1

Project Start Date

Click the Project Start Date icon to adjust the
selected project start date. You can select a new
date and choose to move manual and constrained
tasks or not. Automatic tasks will automatically be
rescheduled.

Plan Start Date X

Recalculate

Click the Recalculate icon to manually recalculate
calculated fields in the Work Plan.

| N,

Set the Plan Start Date

This article explains how to set or update the plan
start date for your plan.

The start date for your plan will determine the
default start date for the tasks in your schedule.
In order for the OnePlan work plan to work as
expected, you need to ensure that the plan start
date is set properly.

Check the Estimated Start Date

When you first create a new plan, ensure you check
the Estimated Start Date field in the Plan Details
form. This will determine the default start date for
the tasks in your schedule.

@ NOTE
If there is no Estimated Start Date

in the Plan Details, the plan start
date will default to the date the
plan was created.
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Once you add tasks into the Work Plan, you cannot
update the Estimated Start Date field in the Plan
Details. If you need to update the plan start date
after the plan already has tasks in the schedule,
you need to use the Plan Start Date icon in the
Work Planner.

Update the Plan Start Date

If you need to update the plan start date, use the
Plan Start Date icon in the Work Planner.

1. Click the Plan Start Date icon in the Work
Planner header. The Plan Start Date form will
open.

|Support Customer wsing Mabite

T [

2. Complete the Plan Start Date form:

« Start Date: Select a new date using the
calendar popup.

» Update Tasks: Check the checkbox to
have the scheduling engine run through
the schedule and update manual and
constrained task dates based on the new
plan start date.

Plan Start Date x

3. Click Change. The plan start date will update
to your new set date.

Build a To Do List in the Work

Plan

This article explains how to manually build a to-do
list of tasks using the To Do view in the OnePlan
Work Planner.

Using the OnePlan Work Plan to create and
manage your to-do list lets you identify organize
prioritize and assign due dates. Also, having your
to-do list in OnePlan gives you the added benefit

of being able to assign notify and share tasks with
your team in one centralized location. You can even
use OnePlan to request and receive status updates
from your team.

To Do lists in OnePlan have the following features:

» Tasks are manually scheduled, meaning the you
have control over the task due dates.

» Tasks are not linked, meaning the tasks are not
dependent on each other.

» Tasks use the Fixed Duration/Effort Driven task
type.

If you are interested in more advanced work

plan scheduling techniques, such as creating a
schedule with dependencies or using different task
types, see Build a Basic Schedule in the Work
Plan [150] or Build an Advanced Schedule in the
Work Plan [151].

Video Length - 10:44

This video walks you through the entire process
of creating a to-do list using the OnePlan Work
Planner.

https://player.vimeo.com/video/770831576

Create a New Plan

A project needs to exist in the portfolio before you
can create any work plan. If there is no project, then
it needs to be created.

To create a project from the portfolios view:

1. Click the new item icon, select New Project.

2. Choose a parent plan from the drop down
list. In this example, | will select World Class
Customer Support.

3. Enter a name for your new plan. In this
example, | am creating "OnePlan Academy To
Do List".

4. Click Add Plan. The new plan, OnePlan
Academy Training To Do List is now a child
plan of World Class Customer Support, and
is available in this organization's portfolio.
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NOTE

The plan's Quick Edit form will
open after it is created. Leave
this open for the next section
in this procedure.

K

For more information on creating new plans in
OnePlan, see Create a New Plan [77].

Check the Plan Details

There are a few simple but important plan details
you need to verify or change before you start

to create your to-do list: the Default Task Type,
Default Task Mode, and plan Estimated Start
Date.

1.  Go to your new plan's Plan Details form. From

the Quick Edit form, click the hamburger menu,

then select Details.

2. Locate the Default Task Type field. Ensure it is

set to Fixed Duration/Effort Driven.

3. Locate the Default Task Mode field. Change it

to Manual Schedule.

K

NOTE

Changing the task mode to
Manual Schedule allows you
to manually enter task due
dates, which is ideal for a to-
do list.

4. Locate the Estimated Start Date field. Ensure
this is set to your desired date. This will
determine the default start date for the tasks
in your schedule.

K

NOTE

If there is no Estimated Start
Date in the Plan Details, then
tasks created in your to-do list
will start on the date the plan
was created.

For more information on managing Plan Details,
see Plan Details Overview [85].

Prepare the Work Plan

Select Work Plan > List to access the work
plan list view.

2. Confirm that the Work Type is set to Schedule.
If not, click on the Work Type menu and select
Schedule.

3. Click on the View menu and select To Do.

NOTE

To Do is an out-of-the-box
OnePlan view.

For your first time entering the To Do view, click
on the Filters menu and select Clear Filters to
ensure there are no filters applied to your work
plan.

Add Tasks to the Work Plan

Now that the Work Plan is ready to go, it is time to
create a list of tasks. There are a few methods to
add new tasks to the Work Plan in OnePlan:

Using the New Item Field

1. Enter the name of the new item in the New
Task field.

2. Press Enter on your keyboard to add the new
task to the bottom of the Work Plan.

3. Edit the Item details as needed.

Using the New Item Header Icon

1. Click the New Item icon. A blank task will be
added to the bottom of the Work Plan.

2. Enter the name of the new task in
the Name field.

3. Edit the item details as needed.

Using the task Quick Edit menu

1. Select the Quick Edit menu for a task.
2. Select Add... > Task Above or Task Below.
3. Enter the name of the new task in

the Name field.

4. Edit the item details as needed.

@ OnePlan
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o IMPORTANT

Notice, there are no due dates for
the tasks because this has been
manually scheduled. You will need
to manually enter due dates.

For more information on creating work items in the
Work Planner, see Create work items in the Work
Plan Grid [161].

Add Due Dates to Tasks

Including task due dates in a OnePlan to-do list
clearly communicates what is expected to be done
and by when for ourselves and the other team
members needed to complete a particular task.

Let's take a look at how to include due dates in a
to-do list for this to-do list:

1. Click into the Due Date field for the desired
task. The calendar form will appear.

2. Select the desired due date using the calendar.

@ NOTE
Notice that you can add the

dates to to-do list items that
end before the to-do list item
above. This is because this is
a manually scheduled list.

S NOTE
In this example, | know all of the

due dates for the tasks in the list,
but it is okay if you do not add

a due date right away. You can
add the due date that you know,
and then add other due dates later
for these items. That way you're
able to create the full list of to-do
list tasks without having to wait
for all of the information like those
due dates to get a clear picture of
Thing that needs to get done to
complete the tasks in the one plan
to-do lists

S NOTE
As you enter tasks due dates, the

final due date of the entire to do
list project will become the latest
due date of the task that has a due
date.

Assign Resources to Tasks

Now we're ready to assign resources to tasks for
The one plan Academy training to do list. | plan

to assign and deliver some of the tasks but | also
need help from other resources in the organization
to successfully complete all of them by the Target
due dates because I'm using OnePlan to create my
to-do list. | can assign resources from the one plan
Resource Center to these tasks.

Build a Basic Schedule in the
Work Plan

This article explains how to manually build your
plan's schedule of tasks. You will navigate to the
Grid page. Refer to the next article for the steps
how to publish a MS Project schedule of tasks.
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Navigate to the Schedule Grid
From the Portfolios page, open the Work Type

menu and select Schedule. E : g
: -B E=
. % N = - ¢ =9
2. Click on the contextual menu = next to the
task you want to split. Then select Split Task
from the drop-down.
Add new Tasks = =
See Create work items in the Work Plan Grid [161] g : g
for instructions to add tasks. ho : s =
View and edit Tasks s =
See View and edit work items from the Work Plan e T g
Grid [162] for instructions to edit tasks.
Your original task will become a parent
Build an Advanced Schedule in item, and will now have two sub-items. The
scheduling engine will retain the original dates
the Work Plan and duration from the original task for each
sub-item, and evenly split the effort from the
Sp'lt a Task in the Work Plan original task between the two sub-items.
This article explains how to split a task into two
sub-items in the OnePlan Work Plan. o B
@ NOTE i =
To split a task, you must sort the = B : . Eo
WBS column first. Once the tasks
are in WBS order, you will be able You can update the Start and Due dates, Effort,
to split tasks. Duration, Assigned Resources, Status, etc. for
each sub-item. These values will roll up to
the parent item and will be accounted for in a
linked schedule.
1.  Ensure the WBS column is in your Work
Planner view. Then, click the WBS column -
header to sort the Work Planner into WBS — ol A -
order. St
3. Click Save = to save the split task in your
schedule.
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Manage Plans in the WOI'k P|an * Indent: Click to indent the current item. The
indented item will become a child of the item

Grid above it.

Contextual Menu

Right-click a Work Item or click = on a Work Item S NOTE

you must sort the WBS column

* Quick Edit: Click to open the Quick Edit window. first. Once the tasks are in WBS
See View and edit work items from the Work Plan order, you will be able to indent
Grid [162] for more detail. and outdent tasks.

* Bulk Update: Click to open the Edit Tasks form.

See Bulk Update Work Items in the Work Plan * Outdent: Click to outdent the current item.
Grid [161] for instructions on bulk updating work
items.

+ Advanced Edit: Click to open the Advanced Edit NOTE
window. See View and edit work items from the S To indent or outdent the tasks,
Work Plan Grid [162] for more detail. you must sort the WBS column

» Cut: Click to copy and remove the current work first. Once the tasks are in WBS
item. order, you will be able to indent

» Paste: Click to paste a work item currently and outdent tasks.
loaded in your clipboard.

* Copy: Click to copy the current work item. « Delete: Click to delete the current item.

» Split Task: Click to split the current work item
into two sub-items.

E NOTE
To split a task, you must sort

the WBS column first. Once the
tasks are in WBS order, you will
be able to split tasks.

» Add: Select an action from the Add drop-down.
Options include: Task Above, Task Below,
Milestone, Subtask, Successor, Predecessor.

NOTE
To add tasks, you must sort

the WBS column first. Once the
tasks are in WBS order, you will
be able to add tasks.

« If you select Subtask, another menu will open.
Select the kind of Work Item you would like to
add as a subtask from the menu. Options will
vary based on the Work Types available in your
OnePlan configuration.

» Covert to milestone: Click to convert the current
work item into a milestone.
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Editable Grid

Click a field to edit the value.

Move work items

Drag and drop work items to the desired location.

NOTE

To drag and drop tasks, you must
sort the WBS column first. Once
the tasks are in WBS order, you
will be able to drag and drop tasks.

K

1]

Work item icons

* Notes: Click the Notes icon to open the Notes
form.

+ Comments: Click the Comments icon to open
the Comments form.

» Activities: Click the Activities icon to open the
Activities board.

Scope

Notes
Enter notes into the Notes form.

Comments
Enter comments into the Comments form.

Commenting On:
Plan: Support Customer using Mobile

Activities
Move, add, and edit work item activities in the
Activities board.

@ OnePlan
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— [ — | i Mk
Assign Colors to Work Items in - ¢

the Work Plan Grid

This article explains how to assign colors to work
items in the work planner for easy categorization
and visual identification.

You can even group your tasks by color. Click on
the Group By icon, and select Color from the drop-
down. The items in your work plan will be grouped
by the colors you applied to them.

Categorizing your tasks by color is simple using the
Work Plan grid. First, make sure that you add the e
Color column to the view. '

- °

|ona a“ e —_—— p— g

3 L

: = -

[ - o

o Assign Resources to Work

Items in the Work Plan Grid

To apply a color to a task, click into the Color field This article explains how to assign teams of
for the item, then select a color from the palate. resources to Work Items in the Work Plan Grid /

List.

From the Resource Panel

1. Click the Resources icon in the Work Plan
header. The Resources panel will open on the
right side of the screen.

esecee
L]

o

soeemoe

Apply colors to all of your tasks for easy, visual
categorization.

eseo oo
H H

L]
scsesn

o

2. Select the desired resource from the list, then
drag and drop the resource to the desired Work
Item.
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NOTE

It is helpful to have the
Assigned Resources column
added to your Work Planner
view so you can easily see
which resources are assigned
to which tasks.

eogo o9 eee
b ]
sesececense

®

From the Assigned Resource Field

1. Click in the Assigned Resources field for the
desired Work Item. The Resource selection
menu will open.

2. Select a resource from your team. You may
also type in a new name of a resource. After
you do so, the project plan will be shared with
them.

K

NOTE

You may want to review and
adjust their permissions after
adding a new resource to your
plan.

(1]

Assign Teams to Work Items in
the Work Plan Grid

This article explains how to assign teams of
resources to Work Items in the Work Plan Grid /
List.

If you assign a work item to a team, all users in the
team will be added to the shared with for your plan.

If a team is assigned to a work item, cost and rate
calculations will use the cost and rate set on the
team (in the resource center). Individual resource
costs and rates will not be used when assigning
teams to work items. This includes the plan level
rate tables that can be created for a plan.

From the Resource Panel

1. Click the Resources icon in the Work Plan
header. The Resources panel will open on the
right side of the screen. Then click the Teams
tab.

a0e 0

-]

2. Select the desired team from the list, then drag
and drop the team to the desired Work Item.

K

NOTE

It is helpful to have the
Assigned Resources column
added to your Work Planner
view so you can easily see
which resources are assigned
to which tasks.

ae

From the Assigned Resource Field

1. Click in the Assigned Resources field for the
desired Work Item. The Resource selection
menu will open.
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2. Select a team from the list. You may also type
in a new name of a team. After you do so, the
project plan will be shared with that team.

K

NOTE

You may want to review and
adjust the team's permissions
after adding a new team to
your plan.

(OGO

Recalculate cost in the Work
Plan Grid

The recalculate button recalculates anything that is
related to cost including Timesheets.

* In certain scenarios, recalculating financials or
timesheets hours may be needed. Clicking this
button will update the values to the most current.

. O
= —
= =
=n —
=a o _—
= [ ] —
== —

Group Tasks in the Work Plan
Grid
This article explains how to use the grouping

feature in the Work Plan to organize work items in
your Work Plan Grid.

Apply a Single Grouping

To apply a single grouping to your Work Plan, click
on the Group By icon, then select the field you
want to group the work items by.

Data Warshouse Migration

- oo

Once the grouping is applied, headers with each
group will appear in the Work Plan, and the
work items will be sorted based on the grouping
selected. In the example below, the Work Plan is
grouped by Status.

{1 AR

Apply Multiple Level Grouping

As of the May 2024 release, you can group the
work plan by up to three levels for streamlined
organization of work items.

To apply multiple-level grouping to your Work

Plan, click on the Group By icon, then select the
fields you want to group the work items by. The
grouping hierarchy will stack from left (the top of
the hierarchy) to right (the bottom of the hierarchy).
So, the first field you select will be at the top of the
grouping hierarchy. Then each additional field you
add will become a child of the previous field.

In the example below, the Work Plan is grouped

by Status (the top level of grouping), then by
Remaining Effort (the second level of grouping),
and finally by Priority (the bottom level of grouping).
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Create Local Plan Fields in the
Work Plan

This article explains how to create and manage
local plan fields in the Work Planner.

Plan Managers can create local plan fields to

Select Columns

All Columns Selected Columns
Actual Cost Name

Actual Revenue Status

Baseline % Done Duration

Baseline Due Start

Baseline Effort Due

Baseline Remaining Effort Deadline

Baseline Start Effort

Business Value Assigned Resources
Calendar % Done

-

e . . . 3. Here you will see a list of all existing local
capture additional information for work items. These ; . : :
fields are exclusive to your plan and serve for plan f|e|d§ (.'f avallablg). You can also edit and
internal reference only. Local plan fields will not be delete IeX|s|t|n|g Io]ga:c;‘lelﬁSJIXLndhﬁ_relaT?rﬁreate
included in the OData feed or in any reports. anew foca ;:_)an 1%, C.IC leld. The

New Task Field form will open.

0 IMPORTANT
You can create up to 10 local fields =
per plan.
1. Click the Columns icon. The Select Columns
form will open.
Bohnshas e
ez
2. Click Local Plan Fields. The Edit Fields form
will open.
4. Complete the New Task Field form.

a. Give your new local plan field a Name.

b. (Optional) enter a description for your field.
This description will appear as a tooltip
when you hover your mouse over the field
in the Work Plan.

c. Select the field type. Options include:
* Text
» Date
* Number
» Currency
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* YesNo

* Choice

» User

» Multichoice

Click Close. You will return to the Select
Columns form. The new local plan field will
automatically be added to your Work Plan view.
You can drag and drop the fields in the Select
Columns window to rearrange your view.

The field configuration form will change
dynamically based on your selection. See
Create and Edit Plan Fields for more
information on the different field types and

Select Columns

their configuration. All Columns 1
d. Check the Required check box if the field ot Stae
is required. pact

e. Check the Read Only check box if the
field is read-only.

f.  Select the Work Types this local plan fields
will be available for.

nactive

tem Type

Local Field Example
MSP WBS

Mew Task Field x Milestone
Mitigation

Mode

Click Save. You will return to the Edit Fields
form. Your new local plan field will now be
available in the list of all local fields for the
current plan.

Edit Fields ]

=)

Selected Columns

Status

Duration

Start

Due

Deadline

Effort

Assigned Resources

% Done

- | Text Local Field Example

s
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Modify and Save Views in the
|§ NOTE Work Plan Grid

If you do not save a Work

PI);n view with your local Select the View menu drop-down to change views,

plan fields, they will then save views, and delete views. Views are listed in

become a\’/ailable in the alphabetical order. Global views have a globe icon
next to them. Only administrators can save global

All Columns section of the . 4 :

views. Personal views have a person icon next to
Select Columns form, so you .

them, if you have any saved.

can add them back into your
Work Plan at any time.

- - ,"_'
: view:  Planning Group
Select Columns ]
e : S I [N ) [
-—'.'j SaNCed aC :uul a
=
All Columns Selected Columns
Fixed Revenue Name :; -\-;l.‘-;
Health Status Status
mpact Duration e e ol
Pl e penp e R Lo B ) e
nactive Start
tem Type Due _
i '\_:\'E".
Local Field Example b Deadline
MSP WEBS Effort
T eitieo | Dot
Milestone Assigned Resources ur .I'_i: =] .ﬁ
Mitigation . % Done
ETROMT
- e
gt
7. Click Ok. Now you can enter data into the local Elzrning
= —

plan field right from your Work Plan.

0 IMPORTANT

We strongly recommend
saving a view with your local
plan fields. See Modify and — s
Save Views in the Work Plan - i
Grid for instructions.

s
P
g
"

racking
3

GUTORIOCARIOIS
ih

T
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T
iTi
e

g§ ®e°s goss goo sesss @ see
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Modify View

Make changes to the view, such as adding
columns, arranging columns, etc. Whether or not
the Timeline, Gantt, and Activities show is a saved
with the view.

Add and remove columns

To add or remove a column from the view, right-
click in any column header. Expand the Columns
sub-heading. The columns already in the view
marked with a check. The remaining available fields
are listed. Select or deselect the columns to show
or hide in the view. Newly added columns show on
the far right.

a8
[ J < |

a

a a

Arrange column order

To arrange the columns, click on the column
heading and drag the column to the desired
location. Let go of the mouse to drop the column
in that spot.

Y

Select additional Work Plan Grid
options

Open the Grid options menu. Select the desired
Grid options to show.

NOTE: Only the Gantt and Timeline can be saved
in a view. All other Grid options must be applied
when working in the Grid.

T

Save a view

Make any changes to the view, such as adding
columns, arranging columns, etc.

1.  On the View menu, select Save View. The

Save View form will open.

2. Complete the Save View form.

a. View Name: Initially, the current view
name will show. Update to a new name. If
updating a view rather than saving a new
view, keep the name as-is.

b. View Scope: Set the scope for the new
view. Options include:

* Global - All Plans: This view will
be available for all users in all plans
in your OnePlan Work Planner. Only
Administrators can save Global views.

* Personal - All Plans: This view will only
be available for you across all plans in
your OnePlan Work Planner.

» This Plan: This view will only be
available for the current plan. You want
to use this option when you use local
plan fields in the plan.

c. Default View: Check the checkbox if this
is a default view. A default view will open
automatically when you go to the Work
Plan.

3. Click Save. Your new view will now be
available from the Views menu.

-

’f.

Delete a view
Navigate to the view you want to delete.

1.  On the View menu, select Delete View.
Deleting a global view deletes it for everyone.
2. Confirm deletion.
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New Task icon

Create work items in the Work 1. Click the New Item icon. A blank work item wil
Plan Grid be added to the bottom of the Work Plan.

+ If in the Schedule view: Select the item
type you would like to add from the drop
down. Options include Add Task, Add
Backlog, Add Issues, Add Risks, Add
Changes, Add Key Decisions, or Insert
Item.

* If you select Insert Item, use the pop-up to
locate and select an existing item to add to
the current Work Plan.

2. Enter the name of the new item in the Name
field.
3. Edit the item details as needed.

This article explains how to create and edit work
items from the Work Plan Grid.

New item quick entry

1. If in the Schedule view: Select the item type
you would like to add from the drop down.
Options include Tasks, Backlog, Issues,
Risks, Changes, Key Decisions.

2. Enter the name of the new item in the New
Item field.

3. Press Enter on your keyboard to add the new
item to the bottom of the Work Plan.

4. Edit the Item details as needed. [=]- Ve Plareion ¥ ®

|Suppart Customar using Mobile

B

Eappert Castamar uing Makile

Bulk Update Work Items in the
Work Plan Grid

This article explains how to bulk update Work Items
in the OnePlan Work Plan Grid / List.

Using the bulk update feature, you can quickly

update many values for multiple Work Items

including general ltem data, the Mode and

Scheduling Mode of the ltems, and single select
I%: user fields for the ltems.

=]

To bulk update Work Items:

1. Select multiple Work Items from the List view

The newly created task appears at the end of the
either using Control+click or Shift+click.

plan (after the last task).
2. Right-click or click = to open the contextual
menu for one of the selected Work ltems.
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3.

4.

Select Bulk Update. The Edit Tasks form will

open.

Complete the Edit Tasks form.

* Field: Select the Work field you would like to
update.

* Value: Set the value you would like to
update the selected Work field to.

* Add Field: If you would like to update more
than one field for the selected tasks, click
Add Field. This will add another set of Field
and Value fields to the Edit Task form.

Edit Tasks x|

Field value

Click Update to update the selected tasks.

View and edit work items from
the Work Plan Grid

This article explains how to view and edit work
items from the Work Plan Grid.

Work item contextual menu

Right click a work item to open the item contextual
menu.

Quick Edit

General tab

The General tab shows general item information
like:

* Item Information
* Item Description
* Item Schedule
* Item Effort

* ltem Financials

162
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Dependencies tab

See all item dependencies. Click the Add (+) icon
e to add a dependency, or the Remove icon to
] remove dependencies.

Task Information -
Name: Development complete % =
Health Status: (1) On Track
Charge Type: seners Resources Dependencies =
Status: Cornpleted Tl
Priority: {3) Normal Task Type Lag
Task Description . Assign development staff  Finish to Start 0 days
Developer testing (prim...  Finish to Start 0 days
Notes tab
Add and edit notes on the item as needed.
Task Schedule - w =
Start: 05/19/2021
Due: 05/19/2021 T e Peemmes e
Actual Start: 05/07/2020 B I U T T I~ N~ —
Actual Finish:
% Done:
Task Effort a
Effort: a
Timesheet Hours: 0
Remaining Effort: . Advanced Edit
Resources tab
See all item resources. Click Add new to add a
resource. Click Remove to remove a resource. .
e General tab
Genersl  Resources  Dependencies  Notes Your fields may differ per your environment's
configuration.
+ Add new
Resource Name Unite * Name
* Percent Complete
Jack Barker 100 % « Duration
» Start and Finish Dates
» Effort
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Predecessors tab

Here you see any existing predecessor
relationships, for which this item is the predecessor/
dependent task. To add a new link, click the Add
new button. To remove a relationship, click the
Remove button.

Successors tab

Here you see any existing successor relationships,
for which this item is the successor task. To add a
new link, click the Add new button. To remove a
relationship, click the Remove button.

Resources tab

Here you see the assigned resource(s). You may
change the resource assigned and you may update
% units. Click next to the resource name or the %
units to activate the drop down menus.

Advanced tab

View or edit the following fields as needed.
Your fields may differ per your environment's
configuration.

» Calendar

» Manually Scheduled: checkbox
» Scheduling Mode

+ WBS Code

» Constraint Type

» Constraint Date

» Status

+ Complete

» Work Type

* lteration

» Estimated Cost

» Estimated Revenue
+ Etc.
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Notes Tab
Add and edit notes on the task as needed.

Review and Approve Updates to
the Work Plan

This article explains how to review and accept or
reject changes to work plan.

When changes are made to a work item or work
plan - either from a Team Member's My Work list or

If approved, click Accept. The updated values
will be added to the work plan. If rejected, click
Reject. The updated values will not be added
to the work plan.

Name New Value Qld Value
Due 4/5/2022

Start 3/31/2022
% Done 100 50
Complete Yes No

Status Completed

Training

o -

OnePlan Acadhemy

Get Started with OnePlan 2
Tina Shirk
4/14/2022

3/29/2022

Waiting for Approval

Review Updates All At Once

1.

Click the Status Updates icon from the work
plan header. The Status Updates window will
open.

from the work plan itself - the changes are sentout ~ 2. Review the updates. Updates values are
for review and approval. highlighed in blue.
3. To accept changes, check the checkbox next
You can either review the updates individually, or all to the desired updates and click Accept. The
at once from the Status Updates window. updated values will be added to the work plan.
To reject changes, check the checkboc next
Review Updates Individually to the desired updates and click Reject. The
updated values will not be added to the work
1. Expand the work items. Items that have plan.
updates will have check marks next to them.
2. Click on the check mark for the desired work -
item. The Update Status window will open. Ipesiring
3. R.evu.ew the. updates. Updates values are
highlighed in blue.
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Status Approval in My Work

If a work item update came from a Team Member's
My Work, once you approve or reject an update

in the work plan, the Status Approval state will
update in the Team Member's My Work list.

» Open circle: Pending
» Green checkmark: Approved
* Gray X: Rejected

Get Started with OnePlan Academy

a Find Your Way Around

What are Work Types and How

do | Use Them?

This article explains what work types are and how
to use them.

Your OnePlan group may have different work types
configured per your business process. You may not
have any extra work types configured.

Video Length - 00:36

https://player.vimeo.com/video/757683724

What are work types?

By default, OnePlan comes with Tasks, Schedules,
Issues, Risks, Backlogs, and Key Decisions the
default work types. A work type is a category of the
way work is done, such as with different scheduling
methods, processes, etc.

Work types are configurable to align to your
business needs, which is done by the Admin. When
looking at the Work Plan pages, views are saved
for that specific work type.The additional work type
items show in Timesheets and My Work.

Navigate to the Work Plan

Navigate to the Work Plan. Regardless whether you
are viewing the List or Board, you can select the
work types. You may have a task schedule, whether
built in the Work Plan directly or integrated from
another tool, such as Project Desktop or Project

for the Web. But, to track other work that needs to
be done, select the appropriate work type, such as
Issues. Add the items to the Work Plan for that work

type.

Work Type: Schedule

bl L

Add and manage work items

Add and manage work items for the selected work
type. There is a default view per work type. You
may save views as needed per work type.

See Create work items in the Work Plan Grid [161]
and Manage Plans in the Work Plan Grid [152]

for further detail and instructions on creating and
managing work items.

— |
=

All work items, from the various work types show in
the My Work and Timesheet pages as well.
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NOTE

When the Backlog List App is
added to your OnePlan group, a
new work type called Backlog gets
created. The fields and views are
also added.

K

Manual and Automatic

scheduling

Tasks can either be manually or automatically
scheduled.

Automatically scheduled tasks' start and end
dates are automatically updated based on the
task constraints, dependencies (predecessors or
successors), and position in the plan hierarchy.
This means that a task start and end date can be
updated as soon as the task is added to a plan.

Manually scheduled tasks are manually adjusted by
the user.

By default, tasks are automatically scheduled. To
manually schedule a task, go to the task contextual
menu > Advanced Edit > Advanced and check
the Manually Scheduled check box.

You can also set automatic or manual scheduling at
the plan level. Add the Default Task Mode column
to the view (right-click then select Default Task
Mode). Then select Auto Schedule or Manual
Schedule.

To exclude a task from scheduling, Go to the task
contextual menu > Advanced Edit > Advanced
and check the Inactive check box. Inactive

tasks do not push their linked tasks or rollup their
attributes to parent events.

Information x

Project scheduling direction

Currently, OnePlan supports forward project
scheduling.

Forward scheduled projects:

+ are scheduled out from a specified start date

+ tasks are scheduled as soon as possible (ASAP)

+ the project start date is mandatory

+ the project end date is equal to the latest end
date of its tasks

* The OnePlan scheduling engine creates a
base Start no earlier than constraint from the
project start date that is inherited by all tasks.
This means any task with no restrictions will
automatically start on the project start date.

The project scheduling direction used in the work
planner effects how automatically scheduled tasks
interact with each other.

Scheduling Mode (aka Task
Type)

The scheduling mode (also called task type) is

a mathematical formula used by the OnePlan
work plan to automate scheduling as you build
and adjust your work plan. The scheduling mode
calculation uses three task values:

» Duration: How long the task will take. Measured
in days by default.
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+ Effort: How many total hours are estimated to do
the task. Default effort is 8 hours Effort = 1 day S NOTE

Duration.

» Units: The percent a resource is allocated to a

To set the default task type at the
plan level, see Set Default Task

task. Default 100% allocation of one resource = 8
hours Effort, or 1 day Duration. Type at the Plan Level [171].

IMPORTANT

Duration, Effort, and Units are all
based on the calendar applied to
a given task. The default calendar
is set to 1 day = 8 hours = 100%
allocation for 1 day, with a 40
hour work week. However, you
can apply custom calendars which
can change these values, and
thus change the Duration, Effort,
and Units calculations in the work
planner.

To set the scheduling mode at the
task level, see Set the Scheduling
Mode (Task Type) at the Task
Level [171].

Available Scheduling Modes / Task
Types

Fixed Duration / Effort Driven (Default)

0 IMPORTANT
This is the default scheduling

The scheduling mode defines which task properties mode in the OnePlan work plan.
are fixed (provided by user) and which ones should We highly recommend that you
be calculated. You may set the scheduling mode at use Fixed Duration / Effort Driven
the plan level, which will set the default for each scheduling, unless you have a
new task in your plan, or change individual tasks as specific need for a different
needed. scheduling mode.

There is also an Effort Driven setting that fixes
the task effort value. When set, it tells the event to
preserve its effort value and recalculate the other

properties.

K

NOTE

At the plan level, scheduling mode
is referred to as the Task Type.
See How do | add the Default
Task Type field? to add the
Default Task Type field to your
OnePlan group. When you set the
scheduling mode / task type at the
plan level, all new tasks added to
the plan will automatically be set
to the selected scheduling mode /
task type.

In this mode, tasks are set to the Fixed Duration
scheduling mode with the Effort Driven setting on.

Information
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This means that task duration and effort are fixed
and provided by the user. Resource assignment
units are calculated by OnePlan. So, tasks will
always recalculate assignment units whenever
there are changes to the duration or effort.

This video demonstrates how the Fixed Duration /
Effort Driven scheduling mode functions in the work
plan.

https://player.vimeo.com/video/728897898

Fixed Duration / Non Effort Driven

In this mode, tasks are set to the Fixed Duration
scheduling mode with the Effort Driven setting off.

NOTE

Calculations provided by this mode
work only if the task has at least
one resource assigned.

K

Information x

CALENDAR | Genera MANUALLY SCHEDULED

SCHEDUUING MODE Fixed Duratic

CONSTRAINT TYPE CONSTRAINT DATE

ROLLUP INACTIVE

This means the task has fixed start and end dates
and duration, but its effort is computed dynamically
based on the assigned resources, and/or

its resource assignment units are computed
dynamically based on the provided effort.

Changes to the effort will cause assignment units
recalculation.

Changes to the assignments will cause
recalculation of the effort.

NOTE

When a work item is set to "fixed
duration" (and not effort-driven),
removing all assigned resources
will automatically set the effort to
zero.

K

This video demonstrates how the Fixed Duration /
Non Effort Driven scheduling mode functions in the
work plan.

https://player.vimeo.com/video/728897951

Fixed Units / Effort Driven

In this mode, tasks are set to the Fixed Units
scheduling mode with the Effort Driven setting on.

K

NOTE

Calculations provided by this mode
work only if the event has at least
one resource assigned.

Information x

CALENDAR | Genera MANUALLY SCHEDULED

SCHEDULING MODE EFFORT DRIVEN | v

Fixed Units

CONSTRAINT TYPE

CONSTRAINT DATE

ROLLUP INACTIVE

This means that the task assignment units and
effort are are provided by the user. Duration is
calculated by OnePlan. So, tasks will recalculate
duration if there are changes to the units.

Fixed Units / Non Effort Driven

In this mode, tasks are set to the Fixed Units
scheduling mode with the Effort Driven setting off.
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NOTE

Calculations provided by this mode
work only if the event has at least
one resource assigned.

K

Information X
B ADVANCED @

CALENDAR | General MANUALLY SCHEDULED

SCHEDULING MODE EFFORT DRIVEN

Fixed Units

CONSTRAINT TYPE

CONSTRAINT DATE

ROLLUP INACTIVE

This means the task has fixed assignment units,
but its duration is computed dynamically based on
the provided effort, and/or its effort is computed
dynamically based on the provided duration.

Changes to the duration will cause recalculation of
the effort.

Changes to the effort will cause recalculation of the
duration.

This video demonstrates how the Fixed Units / Non
Effort Driven scheduling mode functions in the work
plan.

https://player.vimeo.com/video/728922166

Fixed Effort / Non Effort Driven

In this mode, tasks are set to the Fixed Effort
scheduling mode with the Effort Driven setting off.

IMPORTANT

Do not enable the Effort Driven
setting in this mode.

NOTE

Calculations provided by this mode
work only if the event has at least
one resource assigned.

K

Information x

RESOURCES ~ ADVANCED | ]

CALENDAR | Genera MANUALLY SCHEDULED

SCHEDULING MODE | Fixed Effort

EFFORT DRIVEN

CONSTRAINT TYPE

CONSTRAINT DATE

ROLLUP INACTIVE

This means the task has a fixed effort, but its
duration is computed dynamically based on the
provided assignment units. and/or its assignment
units are computed dynamically based on the
provided duration.

Changes to the units will cause recalculation of the
duration. The more resources that are assigned to
the task, the less the duration will be.

Changes to the duration will cause recalculation of
the units.

This video demonstrates how the Fixed Effort / Non
Effort Driven scheduling mode functions in the work
planner.

https://player.vimeo.com/video/728934946

Normal / Non Effort Driven

The task is scheduled based on information

about its start / end dates. The effort (work

hours) and assignment units (percentage usage of
the resource assigned) are not calculated in this
mode.
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IMPORTANT

Do not enable the Effort Driven
setting in this mode.

IMPORTANT

In most cases, do not use this
scheduling mode. The normal
scheduling mode is intended to be
used if you are using the work plan
to build out a backlog or task list,
or if you are importing data into
OnePlan from another scheduling
tool like Microsoft Project, where
the work is being managed.

Set Default Task Type at the

Plan Level

This article explains how to set the default task type
for your work plan at the plan level. This means that
every new task created in the work plan will have
the set default task type.

You can change this at the individual task level
if necessary. See Set the Scheduling Mode (Task
Type) at the Task Level [171].

See Scheduling Mode (aka Task Type) [167] for
information about how each task type functions in
the work planner.

In the Portfolios page, you may add the field Default
Task Type to your view. Then, select the default
task type for your plan. If the Default Task Type field
is not available, ask your administrator to add it to
your OnePlan group.

You may also set the Default Task Type on the Plan
Details form or Quick Edit form, if the field has been
added to your form.

Set the Scheduling Mode (Task
Type) at the Task Level

This article explains how to set the scheduling
mode for individual tasks in the work planner.

See Scheduling Mode (aka Task Type) [167] for
information about how each scheduling mode
functions in the work planner.

1. Click on the Quick Edit menu. Go to
Advanced Edit > Advanced.

2. Inthe Scheduling Mode field, select the
desired scheduling mode from the drop down.

3. Optional. Check the Effort Driven check box
to enable effort driven scheduling.

4. Click Save.
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Constraints

A constraint defines the schedulable date range
for a task. The date range is created by the
constraint date and constraint type. The constraint
type restricts the event start / end dates to

be not earlier than, not later than or equal to the
provided constraint date.

OnePlan constraint types include:

* Must start on: the task must start on the date
provided.

* Must finish on: the task must end on the date
provided.

« Start no earlier than: the task has to start
on or after the date provided. Used in forward
scheduled projects.

+ Start no later than: the task has to start before
(or on) the date provided. Used in backward
scheduled projects.

* Finish no earlier than: the task has to finish
on or after the date provided. Used in forward
scheduled projects.

* Finish no later than: the task has to finish
before (or on) the date provided. Used in
backward scheduled projects.

To set up constraints:

1. Go to the task contextual menu > Advanced
Edit > Advanced.

2. Select the constraint type from the Constraint
Type menu.

3. Set the constraint date in the Constraint Date
field.

4. Click SAVE.

Information x

GENERAL PREDECESSORS ~ SUCCESSORS RESOURCES ~ ADVANCED I

CALENDAR | Default calen ‘ S EE L

SCHEDULING MODE | Normal ‘ EFFORT DRIVEN

CONSTRAINT TYPE ‘ CONSTRAINT DATE

ROLLUP None

Start no earlier than 3 days
Start no later than 6 days
Finish no earlier than 5 days
Finish no later than 1 day 0311

Task Dependencies
This article explains task

dependencies in the OnePlan work planner.

When an scheduled task changes, its linked

tasks will be rescheduled automatically. In forward
scheduled projects, successors react to changes
made in their predecessors.

How dependent tasks update is based on
the dependency type:

» Finish-to-Start: a successor task cannot have a
start date before the end date of the predecessor

task.

» Start-to-Start: a successor task cannot have a
start date before the start date of the predecessor

task.

¢ Finish-to-Finish: a successor task cannot have
an end date before the end date of the
predecessor task.
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» Start-to-Finish: a successor task cannot have an
end date before the start date of the predecessor

task.

Set Task Dependencies
To set task dependencies in the work planner:

1. Select the desired tasks. You can hold down
the CTRL key on your keyboard and select
multiple tasks at once.

2. Click the Link icon to set dependencies
between the selected tasks. The default
dependency type is Finish to Start.

g - Q@ - =

Suppert Customer using Mobile
Scope
Determine project scoping
Secure cone resources
Secure project sponsarship
Define preliminary rescurces

Scope complete

R Analysis/Software Requirements

° Conduct needs analysis

1o
|

Set Lead and Lag

You can also set a lag or lead value for task
dependencies. In OnePlan, the lag value defaults
to days. Lag will delay a succeeding event by the
set number of days. Lead is a negative lag value
(e.g. -2 days), and will accelerate the succeeding
event by the set number of days.

1 day lag

Sucessor

Predecessor

2 days lead

To set up or edit the dependency types and lag:

1. Go to the task contextual menu > Advanced
Edit > Predecessors or Successors.
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OR go to the task contextual menu > Quick
Edit > Dependency.
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2. Inthe Lag field, select the lag (a positive value)
or lead (a negative value) time (in days).
3. Click Save.

Edit Task Dependencies

To edit task dependencies:

1. Go to the task contextual menu > Advanced
Edit > Predecessors or Successors.
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° o8

OR go to the task contextual menu > Quick
Edit > Dependency.
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2. Update the dependency Name, Type, or Lag
fields.
3. Click Save.

Remove Task Dependencies
To remove dependencies between tasks:

1. Select the desired tasks. You can hold down
the CTRL key on your keyboard and select
multiple tasks at once.

2. Click the Unlink icon to remove any
dependencies between the selected tasks.

2~ @~ =]

Support Customer using Mobile

Scope

Determine project scoping

Secure core resources

Secure project sponsorship
Define preliminary resources
Scope complete

Analysis/Software Requirements

° Conduct needs analysis

Task hierarchy

When scheduling tasks, the scheduling engine
takes the task hierarchy into account following
these two principles:

» Each task inherits its parent (summary) task
restrictions (dependencies and constraints).

* A summary task start date and end date should
match the minimum start date and maximum end
date of its children respectively. The summary
task effort equals the sum of the effort of all its
children. The summary task % completed value
equals the completed duration divided by the
total duration of all children.

The scheduling engine recalculates summary task
when their children are updated. Further, children
tasks will react to changes to constraints and
dependencies of their parents.

Grid options - Show Sprints

This article explains how to enable and use the
Sprints feature in the Work Plan Grid.

Enable sprints pane

In the Grid Options menu, select Show Sprints.
The Sprints pane will open at the top of the Grid.

Add one sprint
To add a single sprint:

1. Click the Add (+) icon. Select Add 1 Sprint.

The New Sprint form will open.

2. Complete the New Sprint form:

* Iteration Name: Enter the name of the
sprint.

+ lteration Start: Select the sprint start date.

* lteration End: Select the sprint end date.

* Target Points: Set the target points for the
sprint.

* Target Hours: Set the target hours for the
sprint.

» Global Iteration: Check the check box if
this is a global sprint in your OnePlan
environment.

3. Click SAVE. The new sprint will show in the

Sprints pane.
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Add multiple sprints

To add a multiple sprints:

1. Click the Add (+) icon. Select Add Multiple
Sprints. The New Sprint form will open.
2. Complete the New Sprint form:

Start On: Select the start date of the first
sprint.

Days Per Iteration: Set the number of days
in each sprint

Number Of Sprints: Set the number of
sprints you want to add.

Default Points: Set the default target points
for each sprint.

Default Hours: Set the default target hours
for each sprint.

Global Sprint: Check the check box if
these are global sprints in your OnePlan
environment.

3. Click SAVE.

Grid options - Shared With
(build plan team)

The Shared With window is where you can manage

your team. You may add team members and
manage the security permissions for your plan.

Open Shared With

Open the Grid Options menu. Select Shared with.

You may also access the Shared With window

via the plan contextual menu from elsewhere (i.e.

Portfolios, Plan Menu, etc.).

Work Type: Schedule «

.......

The plan team shows with each user's Name, Email

address and Access level.

@ OnePlan
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Add User

Add a user to your plan by typing their name
into the Add User space. Once you type 3 or

more letters, matching users will show for selection

based on the directory of users in the Resource
Center.

Newly added users will be added to the team as
Reader. Adjust the access level as necessary.

Delete User

To delete a user, click the red dash the the left
of the user. This does not delete the user from
OnePlan, just from your plan.

Edit Access

Click in the Access column to change a team
member's access level. Select the desired level.
(see User Permissions [23])

IMPORTANT

What users are able to access

and do with shared plans is
dependent on the plan permissions
you set, and their OnePlan
environment permissions. Higher
user permissions will outweigh and
restrictions set on the plan level.
See OnePlan Plan Permission
Hierarchy [83] for details on what

a user can expect.

Create Work Plan Notifications

This article explains how to create Work Plan
notifications from the OnePlan Work Planner.

Work Plan notifications are separate from general
OnePlan notifications and can be configured by
plan owners directly from their plans.

Create a Work Plan Notification
To configure Work Plan notifications:

1. From a plan's Work Plan List view, click
the Grid Options menu > Notifications. The
Notifications form will open. If there are
already notifications configured for this plan,
or there are global Work Plan notifications
configured, they will be listed on this screen.

L]
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2.

3.

NOTE

If you are configuring task
notifications for the very

first time, you may receive
the warning message shown
in the image below stating

"A schedule for Work Plan
Notifications has not been set
up. Please create a schedule
in the configuration page".
Your OnePlan administrator
needs to configure and enable
the Task Notification schedule
in the OnePlan configuration

page.

Click Add Notification €, and the Add
Notification form will open.

Add Notification x

Trigger

o e -

Complete the Add Notification form.

a.

Complete the What section of the form.

i. Select a trigger from the Trigger drop-
down. Options include When a Field
Changes or When a Date Passes.
The form changes dynamically based
on your choice.

ii. If you select When a Field Changes,
two additional fields and a check box
will appear.

» First, select a field from the Select
a Field drop-down. When there are
changes to the selected field, a
notification will be triggered.

* Next, set a value in the Value field.
This field will either be a number
field or a drop-down based on the
field you selected. This setting will
trigger the notification when the
field value is set to the selected
value.

* If you want a notification to trigger
when the selected field changes at
all (you do not care about the value
it changes to), leave the Value field
blank and check the Any Value
checkbox.

Trigger

When

ii. If you select When a Date Passes,
one additional field will appear.
» Select a date field from the Select
a Field drop-down. When the date
in the selected field passes, a
notification will be triggered.

(Optional) add filters to your natification. If

you would like to further refine the tasks

that will trigger a notification, you can

add filters. For example, you only want a

notification to trigger when a task is 50%

complete and is At Risk.

i. Select afield to filter on from the
drop-down. The filter parameters will

@ OnePlan
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C.

dynamically appear once you select a
field.

Select an inequality from the drop-
down. Options in this drop-down will
change based on the field selected,
but will always include Equal and Not
Equal.

Select a value to filter from the drop-
down. This field will either be a
number field or a drop-down based on
the field you selected. This setting will
filter tasks when a field value is set to
the selected value.

[ v [ + add e © acd groug

.

NOTE

As of December 15,
2023, Work Plan
notifications can be
filtered based on the
milestone field. This is
helpful if you only want
to trigger a notification on
milestones in your work
plan.

K
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Complete the Notification section of the
form.

Select when the notification will

send an email to the set recipients
from the When drop-down. Options
include Immediately (will send out

a notification once the trigger
parameters are met and will only send
the notification once), Daily (will send
out the notification once the trigger

parameters are met, and will continue
to send out the notification once a day
until the task has been updated) and
Weekly (will send out the notification
once the trigger parameters are met,
and will continue to send out the
notification once a week on the
specified day until the task has been
updated).
* If you select Weekly, the Day
of Week field will appear. Select
the day of the week you want
the notification to be sent to the
recipients.

When: Weekly

Select the natification recipients from
the To drop-down. Options include
Owner(s) of Plan (will send the
notification to all users with Owner
permissions in the plan's Share With
form), Field (will send the notification
to users based on the Work field
selected), Specific User (will send
the notification to the specific user(s)
selected), and Specific Team (will
send the notification to the users who
are part of the selected team(s)).

+ If you select Field, the Select Field
field will appear. Select the Work
field to set the recipients of the
notification. Options here include
Assigned Resources.

Tor Field

* If you select Specific User, the
Select User field will appear. Select
the desired user(s) you want to
receive the notification.

D Specific User

178

@ OnePlan



Using OnePlan

* If you select Specific Team, the
Select Team field will appear.
Select the desired team(s) you want
to receive the notification.

. Specific Team

iii. Enter a subject for the notification
email.

iv. (Optional) select the Work fields that
you would like to include in the
notification email. This will append the
selected fields and their values to the
bottom of the notification email.

v. Draft the body of the notification
email.

d. From the Global field, select whether the
new notification will be a global Work
Plan notification or not. If you select Yes,
the notification will be available across
all plans in your OnePlan environment. If
you select No, the notification will only be
available in the current plan.

Glohbal -

4. Click Save. Your new notification is now active.

Edit a Work Plan Notification

To edit an existing Work Plan notification:

1. From a plan's Work Plan List view, click
the Grid Options menu > Notifications. The
Notifications form will open.
2. Click the Edit icon [# next to the desired
notification. The Edit Notification form will
~open.

hd o

O

3. Update the notification settings as necessary.
4. Click Save to save your updates.

Edit Notification *®

Trigg
wih,
- ==

Delete a Work Plan Notification
To delete a Work Plan naotification:

1. From a plan's Work Plan List view, click
the Grid Options menu > Notifications. The
Notifications form will open.

2. Click the Delete ™ icon next to the desired
notification. The Delete Notification pop-up will
appear.

o

o

3. Click Yes to delete the notification.
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Delete Notification x

9 Are you sure you want to delete the selected notification?

Use Activities in the Work Plan

This article explains how to use Activities in the
OnePlan work planner.

Open the Activities pane to add multiple activities
for a selected task. Activities allow for smaller
pieces of work to be tracked, that don't need to be
a full task in the plan. This allows agile planning of
work within the overall plan/schedule.

Video Length - 3:09

https://player.vimeo.com/video/761090855
Show Activities

1. Select a task.
2. Inthe Grid Options menu, select Show
Activities.
3. The Activities pane opens on the bottom half of
the screen.
4. Add a new activity.
a. Type into the Add Activity field, then hit
the Enter key.
b. Click the Add icon (+). A new activity card
will open in the NOT STARTED lane.

g

Edit Activities

1. Right click on the desired activity card. Select
Edit task. The Edit task form will open.

2. Update the Edit task form.
* Name: Enter the name of the activity.

Description: Enter a description for the
activity.

Resources: Select resources to assign to
the activity.

State: Select the state the activity is in.

_.-—'—'_'_'_* '

...I

Delete Activities

Right click on the desired activity card and select
Remove task.

New task

& Resource >
- e n >
i Re e task

Update the Activity status

Update status by right clicking on the
activity card
Right click on the desired activity card. Go to

Change column, and select the desired activity
status.

Update status by drag and drop

Select the desired activity card. Drag and drop the
card to the desired location.
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Assign the Activity to a resource

1. Right click on the desired activity card. Go to
Resources.

2. Select the desired resources from the project
team to assign to the activity. You can select
multiple resources.

NOT STARTED (1) |

| [
v
L

Grid options - Resources

This article explains how to enable and use the
Resources options in the Work Plan Grid.

Show Resource Usage

To enable the Resource Usage pane, go to the
Grid Options menu. Go to Resources > Show
Resource Usage. The Resource Usage pane will
open at the bottom of the Grid. The Gantt chart will
also open.

W'
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Show Resource Plan

To enable the Resource Plan pane, go to the
Grid Options menu. Go to Resources > Show
Resource Plan. The Resource Plan pane will
open at the bottom of the Grid.

Grid options - Export

This article explains how to export the Work Plan
Grid view to Excel or Microsoft Project XML. You

must first select Export. Then, you may select the
format you want it to export.

Exporting Work Plan Grid view

fiil

When exporting, it will export the visible work items
on the page. This allows you to collapse / expand
and filter out the work items you don't want in your
export.

Export a Work Plan Schedule to

Use in Microsoft Project

This article explains how to export a work plan
schedule from OnePlan to use in Microsoft Project.

The OnePlan work plan allows users to export the
work plan schedule as an XML file that can be
imported into Microsoft Project. This allows you to
build a schedule in OnePlan, and then import it into
Project Desktop to manage the schedule.

Export the Work Plan Schedule

Go to the Grid Options menu > Export >
Microsoft Project XML.

See Grid options - Export [181] for more
information.

Open the Schedule in Microsoft
Project

Follow the steps detailed in Opening Project XML
Files from Microsoft.

@ OnePlan 181


https://docs.microsoft.com/en-us/office-project/xml-data-interchange/saving-and-opening-projects-in-xml-format?msclkid=1f95194dcfd911ec881a52df722cb22d&amp;view=project-client-2016#opening-project-xml-files
https://docs.microsoft.com/en-us/office-project/xml-data-interchange/saving-and-opening-projects-in-xml-format?msclkid=1f95194dcfd911ec881a52df722cb22d&amp;view=project-client-2016#opening-project-xml-files

Using OnePlan

Use the Work Plan Gantt

This article explains how to show the Gantt chart for Work Type: Schedule ~ D
your plan schedule of tasks. You must first select -
Show Gantt. Then, you may also select Show Assigned Resources )
Baseline and/or Show Critical Path. Rate Table

L
(]
I
-
.l
Al
Tl
o

E NOTE Show Sprints
The Gantt control requires start e

and duef/finish dates for tasks in
order to properly display the Gantt. Resources

Video Length - 1:15

https://player.vimeo.com/video/761090751
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Show Gantt

Click the Gnatt icon in the Work Plan Grid header to
show the Gnatt.

When the Gantt is shown, three additional icons Show the Work Plan Critical
show on your header. Click the icons to Zoom In, Path

Zoom Out, Scroll To (which will shift the dates to
the selected task), or Zoom Fit.

This article explains how to show the work plan
critical path in the OnePlan Gantt.

Mes o . Video Length - 1:22
% https://player.vimeo.com/video/761090946
o To show the critical path in the work plan:
Show Baseline or Critical Path 1. (Optional) Open the Gantt chart view by
Click the Options menu. Go to Gantt > Show clicking on the Gantt icon in the work plan
Baseline to show the baseline in the Gantt chart. header.

Go to Gantt > Show Critical Path to show the
critical path in the Gantt chart. ' - = - =

I

2.  Open the Grid Options menu, then select
Gantt > Show Critical path. Work items on
the critical path for your work plan will be
highlighted in red in both the work plan grid
and the Gantt chart.
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Work Plan Baseline Basics

This article explains the basics of saving baselines
of your work plan in OnePlan.

Video Length - 1:46
https://player.vimeo.com/video/761117635

Now that you have worked with your team and
stakeholders to create an agree on the Project's
schedule. It's time to start executing the plan before
you start tracking actual progress against the plan a
common best practice is to save a baseline of the
original plan.

A baseline is a snapshot of the original project
schedule based on the initial understanding of
how the project will be delivered by the project
team. The reason it's important is because it's like
a handshake between the project manager team
and stakeholders. Once you have a baseline in
place. You can determine how well the project is
performing versus the original plan.

Out of the box, OnePlan saves the following five
fields for each task to the baseline:

1. % Done: % Done tracks percent complete.
Remember the percent done in an original
baseline should be zero percent because no
actual progress is tracked at this point in the
schedule.

2. Start Date

3. Finish Date

4. Effort: Effort is typically measured in the
estimated hours needed to complete the task.

5. Remaining Effort: Remaining effort is how
many hours are left once work starts on the
tasks. Because there should be no associated
actuals when an initial baseline is saved,
remaining effort should equal the estimated
effort. That way, you can track your actual
progress against the original plan to determine
how the project is performing at the task level
as well as overall project performance.

To save a baseline of your entire project schedule
(or all of the tasks in the schedule), See Save a
Baseline for All Tasks [183] for instructions and
more information.

To save a baseline of a few selected tasks, see
Save a Baseline for Selected Tasks [184] for
instructions and more information.

Save a Baseline for All Tasks

This article explains how to save a baseline for all
tasks in your work plan schedule.

Video Length - 3:10
https://player.vimeo.com/video/761117687

To save the Baseline:

1. Go to the grid options menu = and select
Save Baseline. The Save Baseline form will
open.

Complete the Save Baseline form.
» Baseline Method: Select All Tasks.
+ Baseline: Select Baseline (0).

K

NOTE

OnePlan allows you to save
up to 11 baselines.
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K

NOTE

Baseline (0) is where one
plan captures and stores
data used for reporting
purposes. So it's really
important that when you
save your Baseline, save
Baseline (0).

NOTE

The other baselines are
important because they are

Save a Baseline for Selected

Tasks

This article explains how to save a baseline for
selected tasks in your work plan schedule.

Video Length - 1:59
https://player.vimeo.com/video/761117560

A situation where you may want to baseline
selected tasks is if, for example, a new project
scope was identified by your team that needed to
be added to the project schedule, thus adding a
couple new tasks. These tasks have been added
and networked into the schedule with resources

associated with it notice that because there is no
baseline for these tasks. There are no baseline
start dates or due dates or baseline effort. Rather
than baselighting the entire schedule again, there is
an opportunity to baseline selected tasks.

then used for historical
purposes to compare the
project performance against
the current Baseline.

3. Click Save. You will be asked if you want to
save the current Baseline. Click, Yes, and then
OnePlan saves the Baseline.

To baseline selected tasks:

1. Select the desired tasks from the work plan list.
You can select multiple tasks by holding down
the CTRL key and clicking.

NOTE 2. Go to the grid option menu > Save
S . Baseline. The Save Baseline form will open.
We also recommend saving an 3. Complete the Save Baseline form.

additional baseline (Baseline (1)
in this example). Baseline (1)
now becomes something that you
can save for historical purposes.
Additional baselines give you that
history that you'll be able to save,
should you encounter situation
where you need to rebaseline and
then at that point you would use

» Baseline Method: Select Selected Tasks.
+ Baseline: Select Baseline (0).

K

NOTE

Saving the selected tasks
to Baseline (0) will add
these tasks to the original

Baseline (0) to be the baseline for baseline.
taking another snapshot of your
schedule.

NOTE

K

Baseline (0) is where one
plan captures and stores
data used for reporting
purposes. So it's really
important that when you
save your Baseline, save
Baseline (0).

To show your saved baseline in the Gantt:

*  Go to the grid option menu and select Gantt
> Show Baseline. The Gantt will open. You
should see gray bars beneath the original
Gantt bars and that show you that Baseline (0)
has been captured.
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2. Select Show Timeline. The plan timeline will
NOTE open in the work plan grid.
S OnePlan allows you to save
up to 11 baselines. [_j]
S NOTE
The other baselines are
important because they are = —
then used for historical - -
purposes to compare the
project performance against Add Items to the Timeline
the current Baseline.
1. Add the Show in timeline column to the work
4. Click Save. Then click Yes in the popup to plan grid. See Add and remove columns [160]
save the baseline. The selected tasks have for instructions to add a column.
been added to the original Baseline (0). 2. In the Show in timeline column in the work
plan, check the check box next to the desired
tasks to add them into the timeline. You should
see the timeline populate with tasks.
NOTE . .
S We also recommend saving an Grid options - Replace
additional baseline (Baseline (2) Resources
in this example). Baseline (2)
now becomes something that you Replace a resource across all tasks in
can save for historical purposes. a plan

Additional baselines give you that
history that you'll be able to save, 1
should you encounter situation
where you need to rebaseline and
then at that point you would use

Open the Grid Options menu. Go to Replace
Resources > All Tasks. The Resource
Replace form will open.

2. I he R Repl form.
Baseline (0) to be the Baseline for Complete the Resource Replace form
. a. Select a resource to replace from
taking another snapshot of your
schedule. the Resource to Replace drop down.
b. Select a replacement resource:
* Replace By Match: Select a resource
from the list.
. . * Search for Replacement: Search for
U_se the WOl'k Plan Tlme_llne and select the name of a specific
This article describes how to use the timeline resource.
feature of the OnePlan work plan. 3. Click REPLACE.
The following video provides a demonstration of the
OnePlan timeline feature, including why you would
use it, and how to use it.
https://player.vimeo.com/video/730008576
Open the Timeline
1. Click the Grid Options menu.
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Replace a resource in selected tasks

Create a rate table

1.

Click the Add (+) icon. The Add Table form will
open.

1. Select the desired work items from the Plan 2. Complete the Add Table form.
Grid. You can select multiple work items by * Table Name: Enter the name of the new rate
holding down the CTRL key. table.
2. Open the Grid Options menu. Go to Replace 3. Click ADD.
Resources > Selected Task(s). The Resource 4. Add resources to the rate table.
Replace form will open. » Search for a resource by entering the role
3. Complete the Resource Replace form. or name into the Add Resource field. Search
a. Select a resource to replace from results will appear under the field. Select the
the Resource to Replace drop down. desired resource.
b. Select a replacement resource: 5. Edit the Rate for each resource as necessary.
* Replace By Match: Select a resource  Click the Rate field for the desired resource
from the list. and enter the new rate.
« Search for Replacement: Search for 6. Click SAVE.
and select the name of a specific
resource.
4. Click REPLACE.
E ; j:\
° P
N\
°
Grid options - Rate Table
This article explains how to create, edit, delete, and
apply plan-level rate tables.
Open the Grid Options menu. Select Rate Table.
The Rate Tables form will open.
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Rate Tables x Rate Tables x

Eo‘;; e I Table 1

Resource Name Base Rate

Peter Gregory $200.00

H
™
B Eb

Erlich bachman $180.00
v [ s t $200.00

[ - EEERFES ® e
Taths Mama Tabis —

Rate Table: o {
e e ©@cdit Teble x

Teb ok L
2ble Name: Table 1.2
ase Rate
$200.00 $200.00
Ci SAVE 4
Rate Tables x®
Rae Tables x - D | bl | Tablel2 - Z W =
Tabie ! - & H =B Resource Name Base Rate Rate
fate ° j Peter Gregory $200.00 $180.00
= [i]  Erlich bachman $200.00 $190.00
8] =
. W  Support $200.00 $220.00
| Suppart
Project Manager $200.00 $180.00

Edit a rate table Delete a rate table
1. Select a rate table from the Table drop down.
2. Click the Edit icon. The Edit Table form will 1. Select arate table from the Table drop down.
2. Click the Delete icon.
open. ) .
3. Complete the Edit Table form. 3. Confirm the deletion.
* Table Name: Edit the name of the rate table.
4. C“Ck SAVE Rate Tables x
5. Update the resources and resource Rates as - @ [ 1 er] -
necessary.
NOTE: To remove a resource, click the Delete | e R a
icon next to the desired resource. e Y
. [u] Erlich bachman $200.00 $190.00
6. Click SAVE. -
[l Support $200.00 $220.00
[i] Project Manager $200.0, $180.00

Delete Table x

e Are you sure you want to delete that table?
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Apply a rate table

Once you have created rate tables, you can apply
those new rates to various tasks within a project.

1. Right click on any column header in the grid.

2. Go to Columns and select Rate Table. The
Rate Table column will be added to the far
right of the grid.

Juration

W item Type
S— M Columns >
i B Mitigation !
I © Hide column
0 |
m B MSP WBS
m t2 Sort ascending
o |
B FPoints
o 13 Sort descending |
B FPriority
Multi sort b
W Probability
5 days
M Rate Table
10d
B Remaining Cost

B Remaining Effort

3. (Optional) Drag and drop the Rate Table
column to the desired location.

4. Within the Rate Table column, select the rate
table you would like to apply to the tasks.

Service interface to support Rest APt (UL

- Analysis/Software Requirements

Work Plan Versioning Overview

This article gives an overview of the Versioning
function of the OnePlan work plan.

Video Length - 1:08
https://player.vimeo.com/video/760017411

Versioning in OnePlan is the creation and
management of multiple work plans, all of which
have the same general structure and function, but
are improved, upgraded, or customized. Versioning
safeguards from you losing your work, allows you to
experiment and return to previous versions.

With the versioning function, you can save a new
version of your plan, open a previous version of
your plan, and restore an earlier version of your
plan you are working on (which will overwrite your
current work with the selected version). When

you create a version of your work plan, the work
plan structure, resources, tasks, and task data are
saved.

Versioning in the Work Plan Grid allows you to save
up to 10versions of your work plan, so it is best
practice to save versions when major changes have
been made to the work plan.

Save Work Plan Versions

This article explains how to save a version of your
work plan.

Video Length - 00:30
https://player.vimeo.com/video/760017454

To save a version of your work plan:

1. Click on the Hamburger menu. Go
to Versions > Save Version. The Save
Version form will open.

2. Name the version and click Save Version to
save the version.

Version Naming Best Practices

We recommend that you include the Date, project
name, major version number in the name when
saving a version.

Open Work Plan Versions

This article describes how to open a previous
version of your work plan.

Video Length - 00:43
https://player.vimeo.com/video/760017482

To open a previously saved version:

1. Click on the Hamburger menu. Go
to Versions > Open Version. The Open
Version form will open.

2. Select the desired version and select Open
Version to open the version in the Work Plan
Grid.
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3. A notification will appear across the top of the
Work Plan Grid detailing the version you are
editing.

Restore Work Plan Versions

This article describes how to restore a previous
version of your work plan.

Video Length - 00:33

https://player.vimeo.com/video/760017543

To restore a previous version of the Work Plan Grid:

1. First, follow Open Work Plan Versions [188] to
open your desired work plan version.

2. Click on the Hamburger menu. Go
to Versions > Restore Version.

3. Click Yes on the Version pop up to confirm the
restore.

Delete Work Plan Versions

This article describes how to delete a saved version
of your work plan.

Video Length - 00:36
https://player.vimeo.com/video/760017765
To delete a saved version of your work plan:

1. Click on the Hamburger menu. Go
to Versions > Open Version. The Open
Version form will open.

2. Click Delete ™ next to the version you would
like to delete.

Work Plan Templates Overview

This article provides an overview of OnePlan work
plan templates.

Video Length - 00:54
https://player.vimeo.com/video/760321716

In general, a template is anything that determines
or serves as a pattern. In OnePlan, you can save
the structure of a work plan to use when creating
other new work plans. This is especially helpful if
your projects generally follow a similar path, and
thus require a standard work plan structure.

Plan templates can be used across all work types.

Plan templates can only be saved and imported
from the Schedule work type view. When you save
a template from the Schedule work type view, all
work type items in all work types in the plan will be
saved. Timesheet data will not be saved.

There do not need to be any items in the Schedule
work type to save a new template.

Save a template
https://player.vimeo.com/video/760321808
To save a template:

1. Configure the work types as desired.

2. Go to the Schedule work type view.

3. Click the hamburger menu next to the Work
Type menu.

4. Click Save Template. The Save Template
form will open.

5. Complete the Save Template form.
* TemplateName: Enter the template name.

NOTE

It is best practice to include
"template" in the name of
your templates. This makes
it easier to locate in the
Bulk Plan Cleanup tool if
you would like to delete

the template. See Delete a
template.

* Description: Enter a description for the
template.
» Category: Enter a catgory tag to make
searching for the template easier.
* Personal: Check the check box if the
template is a personal template.
6. Click Save to save the new template.
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© [Work Type: Schedule v] | = (3]

Save Template x

Insert a Work Plan Template

This article describes how to insert a work plan
template into your Work Planner.

S NOTE
When you insert a template, the

rollup / plan summary calculations
will run automatically.

To insert a template into the Work Planner:

1. Go to the Schedule work type view.
2. Grid Optionsinsert Template. The Insert
Template window will open.

Insert an Organization Template

If your organization has created a set of
standardized templates for you to use, you can
find those in the Organization tab of the Insert
Template form.

v om e o e i F

1. Search for and select the template you would

like to use.
2. Select where you would like to insert the

template into your work plan from the Location

drop-down menu. Options include End of

Project, Under Selected Task (As Child), or

After Selected Task.

F:- e /

Click Next.

4. |If applicable, review and update field mappings
from the template to the corresponding fields in

your existing work plan.
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Map Fields

5. Click Next.

6. If applicable, review and update resource
mappings from the template to the
corresponding resources in your existing work
plan.

Magp Resources x

7. Click Insert. The work plan template will
append to your work plan.

Insert a Personal Template

If you have created and saved work plan templates
for your own use, you can fond those templates in
the Personal tab of the Insert Template form.

1. Search for and select the template you would
like to use.

2. Select where you would like to insert the
template into your work plan from the Location

drop-down menu. Options include End of
Project, Under Selected Task (As Child), or
After Selected Task.

3. Click Next.

4. If applicable, review and update field mappings
from the template to the corresponding fields in
your existing work plan.

5. Click Next.

6. If applicable, review and update resource
mappings from the template to the
corresponding resources in your existing work
plan.

7. Click Insert. The work plan template will
append to your work plan.

Insert an Online Template
OnePlan offers a robust library of work plan

templates that you can access from the Online tab
of the Insert Template form.
6 e S |
CE (e

1. Search for and select the template you would
like to use.

2. Select where you would like to insert the

template into your work plan from the Location

drop-down menu. Options include End of

Project, Under Selected Task (As Child), or

After Selected Task.

Click Next.

4. |If applicable, review and update field mappings
from the template to the corresponding fields in
your existing work plan.

5. Click Next.

6. If applicable, review and update resource
mappings from the template to the
corresponding resources in your existing work
plan.

7. Click Insert. The work plan template will
append to your work plan.

w
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Import a Template

If you want to import a OnePlan work plan template
file that someone has shared with you, you can do
that from the Import tab of the Insert Template
form.

1. Select the type of template you would like
to import. Options include OnePlan Template
(use if you exported a OnePlan work plan
template JSON file), or CSV (use if you have
a work plan template in a spreadsheet format).
Then click Next.

Figure 1. Import a OnePlan Template
Screen

Figure 2. Import a CSV Template
Screen

2. Click Select File. A file browser will open.

3. Search for and select the desired work plan
template file. Then click Open. This will upload
the template into OnePlan.

Once the template has been successfully
uploaded, select where you would like to insert
the template into your work plan from the
Location drop-down menu. Options include
End of Project, Under Selected Task (As
Child), or After Selected Task.

Click Next.

If applicable, review and update field mappings
from the template to the corresponding fields in
your existing work plan.

Click Next.

If applicable, review and update resource
mappings from the template to the
corresponding resources in your existing work
plan.

Click Insert. The work plan template will
append to your work plan.

Generate a Template with Al

You can use Sofia, OnePlan's Al helper, to quickly
create new work plan templates from the Al tab of
the Insert Template form.

1.

In the text field, describe the type of template
you are looking for, and OnePlan Al will
suggest possible options. For example, you
could enter "l need a software development
template for building an e-commerce platform,”"
and the Al will generate work plan template
options for you to use.
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2. After the template has been generated, review
the template. Click Keep to use the template.
Or click Try Again to generate a new template
until you find a template you want to use.

3. Select where you would like to insert the
template into your work plan from the Location
drop-down menu. Options include End of
Project, Under Selected Task (As Child), or
After Selected Task.

4. Click Next.

5. If applicable, review and update field mappings
from the template to the corresponding fields in
your existing work plan.

6. Click Next.

7. If applicable, review and update resource
mappings from the template to the
corresponding resources in your existing work
plan.

8. Click Insert. The work plan template will
append to your work plan.

Import Work Plan Templates

This article explains how to import templates into
your OnePlan work plan template library.

You can upload Excel work plan templates (CSV),
or OnePlan work plan templates (JSON) to use as
a base for building your OnePlan work plans. The
import function can be especially helpful if you need
to import work items from another system instead of
manually creating them.

o IMPORTANT
For the CSV import, most field
types can be imported (text,
choice, date, etc). You can
also import resource assignments.
Currently, you can only import a
flat list of tasks (no hierarchy or

predecessors/successors).

S NOTE
When importing dates, dates

should be in the YYYY-MM-DD
format. If they are not in this
format, you will recieve the
following error: 'String was not
recognized as a valid DateTime'.

Import a Template

If you want to import a OnePlan work plan template
file that someone has shared with you, you can do
that from the Import tab of the Insert Template
form.

1. Select the type of template you would like
to import. Options include OnePlan Template
(use if you exported a OnePlan work plan
template JSON file), or CSV (use if you have
a work plan template in a spreadsheet format).
Then click Next.
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Figure 3. Import a OnePlan Template
Screen

Figure 4. Import a CSV Template
Screen

2. Click Select File. A file browser will open.

3. Search for and select the desired work plan
template file. Then click Open. This will upload
the template into OnePlan.

4. Once the template has been successfully
uploaded, select where you would like to insert
the template into your work plan from the
Location drop-down menu. Options include
End of Project, Under Selected Task (As
Child), or After Selected Task.

5. Click Next.

6. If applicable, review and update field mappings
from the template to the corresponding fields in
your existing work plan.

7. Click Next.

8. If applicable, review and update resource
mappings from the template to the
corresponding resources in your existing work
plan.

9. Click Insert. The work plan template will
append to your work plan.

Export Work Plan Templates

This article explains how to export work plan
templates from the Work Planner.

Exporting work plan templates allows you to easily
share your templates with other OnePlan users.

To export a work plan template:

1. Select the Grid Options menu
Work Plan.

> Export >

e wsing Mobike

2. A JSON file will download to your Downloads
folder. The JSON file is your work plan
template that you can share with other
OnePlan users.

Edit a template

This article explains how to edit work plan
templates.

To edit a template:

1. Go to the Schedule work type view.
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2. Select the Grid Options menu > Insert

Template. The Insert Template form will open.

3. Locate the desired template. Click on the edit

icon < next to the desired template. The Edit
Template form will open.

4. Update the template information as desired.

Edit Template x

5. To update the template work plan, click Edit
Plan. The template work plan will open.

6. Edit the template work plan as desired.

7. Click Save =
plan.

to save any changes to the work

Delete a template

You can use the Bulk Plan Cleanup tool in the
Admin pages to delete a template. See \What are
the Tools options? for instructions on using the tool.

NOTE

Only users with administrative
permissions can use the Bulk Plan
Cleanup tool.

K

NOTE

It is best practice to include
"template" in the name of your
templates. This makes it easier to
locate in the Bulk Plan Cleanup
tool if you would like to delete the
template.

K

Work Plan Check Schedule

This article explanins how to use the Check
Schedule feature of the OnePlan work planner.

The Check Schedule feature in the OnePlan work
planner runs backend checks with the database to
ensure your schedule data's integrity.

A scenario when you would want to use the Check
Schedule button is after you import a work plan
template into your work plan. Check Schedule will
check your schedule and repair any errors that
could occur when importing a template - such as
date errors.

You may also want to run Check Schedule on your
schedule when you bring data into OnePlan via an
integration. Again, Check Schedule will check your
data and repair errors.

To run a schedule check:

1. Click on the grid options menu. Then select
Check Schedule.
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2.

The schedule check will run. Once it is
complete, click Ok in the Check popup that
appears.

Check x

Your schedule has fixes that need to be saved. Be
sure to save your changes.

Save your work plan to save any adjustments
made during the check.
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Work Plan Board

10. (Optional) Edit constraints for the selected tile

Use the Work Plan Board

This article explains how to use the features of the
Work Plan Board. The information in this article

is applicable whether you created your schedule
in the Grid page or published your schedule from
another connected tool, such as Microsoft Project
or Project for the Web.

1.

total value (see number 5). Options are None,
Below Constraint, and Above Constraint.
(Optional) Load any sub-plans into the board
view by selecting the Sub-Plans icon.

Open the Work Plan Board e i e
Go to the Work Plan Board page for your plan m—z: E_.'
via the Work Plan drop down menu. All the work e
items/bookings show in the board columns (swim e
lanes) and lanes (if applicable) based on each ey
item's status. Erer—
T

If you have saved board views, select that view
from the Views drop down. You can also create and
save board views. See Save board views [197].

Otherwise, you can configure the board view for
the current session. Options vary based on your

Save Board Views
To save a board view for future use:

1.

Configure the board as desired.

organization's OnePlan configuration: 2. Expand the View drop down and select Save
View. The Save View form will open.

1. Select the desired Work Type. 3. Complete the Save View form.

2. Select the Column field view. + View Name: Enter the name of the view.

3. (Optional) Select the Lanes field view. + Default View: Check the check box if the

4. (Optional) Select the Color By field view. This new view is a default view. This means when
options changes the color of the tile headers opening the work plan board, this will be the
based on the item's status. view.

5. Select the Totals value. This will sum the » Personal View: Check the check box if the
selected value from each item in each row. The new view is a personal view. This means the
total value appears in the right of each column view will only be available in your instance of
header. OnePlan.

6. (Optional) Apply a filter to narrow the items in 4. Click SAVE.

the board. Select one or more filters from the
Filters drop down.

7. (Optional) Set the size of the tiles for your
view. Select a size from the Zoom drop down.
Options are Small, Medium, and Large. Default
setting is large.

8. (Optional) Select one or more task fields to
display on the tiles from the Fields drop down.

9. (Optional) Turn on visual links between
dependent tasks by clicking the Dependencies
icon.

Drag and Drop to Update Booking
Status

To move a booking status, simply select the desired
item tile, then drag and drop the tile into the correct
location.

@ OnePlan
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View and Add Comments

Click on the Comment icon on the desired tile.

The Comments window will open. Any comments

already added will show. Add a new comment and -

hit the Enter key to save. Comments show with you Task Information v
made the comment and a date/time stamp.

Task Description hd
Task Schedule v
Task Effort =
Task Financials v

Resources Tab
View and manage the assigned resource(s).

» Update the resource allocation % units. Click
Edit a Booking into the Units field and change the resource's
Select Edit to view the booking information and allocation.
update any fields on the Booking Information
window as needed.

Select Delete to delete the booking.

Resource Name Units

(93]

)
o

&

Dinesh Chugtai

General Tab
The General Tab is divided into several topics:
Predecessors Tab

» Task Information: View and edit general task .
View task predecessors.

information such as task name, status, and

priority.
* Task Description: View and edit the task

description.
» Task Schedule: View and edit the task schedule NOTE

information such as start and due dates. You cannot edit task predecessors
» Task Effort: View and edit task effort information or dependencies from the Board.

including effort estimates, timesheet hours, and
remaining effort.

» Task Financials: View and edit task financial
information like estimated budget, estimated and
actual costs, and profits.

The fields within each topic will vary based on your
organization's configuration.
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% [
Provide user support an.. Finish to Start 0

Notes Tab

Add and edit notes on the task as needed.
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Resource Plans Overview

This article an overview of the OnePlan
Resource Plans. OnePlan has both plan-level and
organization-wide resource planning capabilities.

Global Resource Plan

The Global Resource Plan shows all resource
allocation across all the plans. This is a useful page
for managers to review allocation across multiple
plans.

If your organization is using the Negotiations
feature, the email notifications contain a link to

the Resource Plan page, filtered for that plan's
resources. You can also navigate to the page
directly via the Resource Plan icon on the OnePlan
navigation menu.

B nla|lm B o
A

Global Resource Plan Overview Video (03:52)

https://player.vimeo.com/video/791263430

Plan-Level Resource Plan

The plan-level Resource Plan shows resource
allocation for a particular plan.

Plan-Level Resource Plan Overview Video (04:39)

https://player.vimeo.com/video/790470410

Resource Plans

Pre-filters

Select a pre-filter to review desired resource types.
Pre-filters are configured by your administrator. Pre-
filters can be required or optional. When pre-filters
are required, no resources will be displayed in

the Global Resource Plan page until a pre-filter is
applied.

Resource Plan

Committed =

Resource Type Pre-Filter

You can filter the Global Resource Planner by
Resource Type so you can view either individual
resource allocations or team allocations.

IMPORTANT

You can only view Resources

or Teams allocations. You cannot
view both at the same time.

Resource Type Business Unit Status

Resource Plan

Committed + @ &£ Ii@_‘ = Hours E

Blank
s Jan 2023

Resource Resources
ed

Committ...
eams

M S b Amanda ...

Resource Manager Pre-Filter

The resource manager pre-filter is a server-side
filter that loads resources into the Resource

Plan area and/or Resource Center area based on
user permissions and Resource Managers admin
settings. See How the Resource Manager pre-filter
works for more information.

Ilcon Menu

m
4

Scheduled View: Default View *  Hours b -
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Icons listed in order from left to right:

Icon Name

Scheduled ~ Cost Types
Menu

Add
Booking

Candidates
List

View: [Resource Summary ¥ Views

Hour Planning
Units Mode
Menu

Description

Toggle between
Resource Plan cost
types. Cost Types
are configured

per business use
case. These allow
for analysis of

how resources are
initially planned
compared to how
they are actually
assigned and work.

Click this icon to
launch the booking
form.

Click the icon to
toggle showing the
Candidates List on
the bottom half

of the screen.

See How do |

use the Resource
Pane? [217] for
more details.

Select

the View menu drop
down to change
views, save views,
and delete views.

Select Hours,
% (Percent), or
FTE (Full Time
Equivalent).

Icon Name Description
- Modify Settings in this menu
View Menu include:

* Dates: Select

the desired date

range of periods.

Note that the

"Totals" column

will calculate

based off the date
range selected if
the planning unit
mode is % or FTE.

Filter: Select a

filters to narrow

what shows in
the page. Select

Clear Filters to

remove all filter

selections.

* Group By: Select
a field to group
the resources
by that field.
Resource-level
choice fields (such
as Department
and Role) are
available for
grouping.

* Compare To:
Select cost type
comparisons to
view in the grid.

- Resource Options in this menu
Plan include:
Advanced
Menu * Delegates: Only
available if
negotiations
are enabled.

The Resource
Manager can
assign delegates
to approve on
their behalf, such
as their team or
department.

* Legend:
Describes the
meaning of the
color heat map for
the resource plan
details. The colors
are based on their
percentage of
availability utilized.

* Copy Values:
Click to copy
resource plan
data from one
cost type to
another. See Copy
Resource Plan
Values [216] for
more information.
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Icon Name
Refresh

Description

Click to update
the data in your
resource plan.

Resource Plan Details
The bookings are grouped under each resource.

Public rows (if the public/private feature is enabled)
show.

The summary rows show the total allocation for
each resource. The colors are based on their
percentage of availability utilized (how much of their
time is taken).

Resource Plan Color Legend:

* Green Cell: Less than 100% Availability Used

+ Light Green Cell: 100% Availability Used

* Yellow Cell: Greater than 100% --- to --- Less
than or Equal to 110% Availability Used

» Orange Cell: Greater than 110% --- to --- Less
than 120% Availability Used

* Red Cell: Greater than 120% Availability Used

* Green Tab: Resource requirement 100% fulfilled

* Yellow Tab: Resource requirement is greater than
80% -- to -- less than 100% fulfilled

* Orange Tab: Resource requirement is greater
than 60% -- to -- less than 80% fulfilled

* Red Tab: Resource requirement less than 60%
fulfilled

legend x
100% Allocated

< T10% Allocated

< 120% Allocated

Reguirements:
100% Fullfilled

< 100% Fullfilled
= 80% Fullfiilled

< 60% Fullfilled

Resource Plan Details and Candidates
List

If you show the Candidates List in the lower half

of the screen, each resource's summary row shows
remaining availability. The color legend is the same
as noted above. See Resource Plan Candidates
List Overview [217] for more information about the
candidates list.
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Resource Approvals with Negotiations
When the Negotiations feature is enabled, the
additional status and approval columns show.

See How is resource planning done with the
Negotiations feature enabled? [210] for more
information about the notifications and approvals
with negotiations.

Use the One Plan Resource
Planner Basics

This article describes the basics for using the
OnePlan Resource Planner.

https://www.youtube.com/embed/MN1w5clhoDw

]
Il
:

i

——

1. Resource Plan Cost Types

Here we see Resource Plan Cost Types. Resource
Plan Cost Types allow organizations to calculate,
evaluate and monitor how resources are being
allocated. There are possible (and often likely)
differences between how our resources’ time is
initially planned, booked onto specific work, and
then actually spent. The Resource Plan allows
multiple types so you may analyze the differences.
You can toggle from one type to another.

The reason these groupings are called “cost”
types is because the resource plan hours may be
converted to costs when they are imported into
the financial plan. The rate for each resource,
according to their role or other cost category factor
would be multiplied by the number of hours to get
the financial value of that resource’s time.

Your organization may have similar or different
cost types depending on business use cases and
configuration. Here are some example use cases
that may apply.

» The Committed Hours cost type would be the
initial plan generally estimated at a high level.
This is also referred to as top-down planning.

» The Scheduled Hours cost type would be the
totals from the detailed task schedule. You could
import the task schedule hours into this resource
plan cost type.

» The Actual Hours cost type would be the
time spent on this plan. You could import the
timesheet hours into this resource plan cost type.

Read more about Resource Plan Cost Types:

* Resource Plan Cost Types

2. Totals

The totals show per resource. The calculated total
will vary based on the planning mode. The totals
are based on which periods are showing in the
view.

» Hours: The sum of hours allocated in the visible
time periods.

* %: The average percentage of time of a full time
person, based on the number of working days in
the visible time periods.

» FTE: The average count of a full time person,
based on the number of working days in the
visible time periods.

Read more about Resource Plan Totals:

* Resource Planning Units Mode

3. Time-Phased Resource Allocation
Resource usage is viewed and/or edited per time
period shown. Based on the Dates menu selection,
resource usage may be summed up or broken

out in more or less details (i.e. monthly, quarterly,

yearly).
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Read more about Resource Allocation:

* Build a Resource Plan
* Add a Booking to a Resource Plan
« Add a Resource to a Resource Plan

4. Candidates List

The Candidates List shows in the lower half of your
screen. This is where you can see how else the
resources are allocated. This is beneficial to first
see who is already booked or has availability before
or after adding to your plan.

By default, the current plan’s resources will show.
Expand any resource to see where else that
resource is being utilized.

The colors signify the percentage of the resource’s
remaining availability. So, for example, the color will
shift from green to yellow to orange to red as the
resource becomes overbooked beyond capacity.

Read more about the Candidates List:

* Resource Plan Candidates List Overview

* Find Resources with the Candidates List

* Replace a Resource with the Candidates List
+ Fulfill a Resource with the Candidates List

Build a Resource Plan

This article explains how to build a OnePlan
Resource Plan at the plan level.

NOTE

The plan-level resource plan will
then roll up to the Global Resource
Plan for the Resource Manager to
review.

K

A Resource Plan is for high-level allocation of
resources to your plan. This is not yet detailed
task planning. For example, rather than build out
a detailed schedule of tasks for John, you would
instead commit John 50% of his time for the next
four months.

Later, after the Resource Plan is built, you will
import the Labor costs into your Financial Plan,
based on the resource plan. Also, for portfolio
analysis, you will be able to assess which plans
to move forward and when based on the resource
needs across all plans compared to the overall
availability of your resources.

IMPORTANT

This article assumes the
Negotiations feature is
DISABLED / not in use. See
How is resource planning done
with the Negotiations feature
enabled? [210] for the specific
differences if the Negotiations
feature is enabled.

1. Navigate to the Resource Plan
Module

Navigate to the Resource Plan page for your plan, if
not already there, by clicking Resource Plan in the
Header.

2. Select the Resource Plan Cost Type
Before booking resources to your plan, be sure
you are viewing the correct cost type if your
environment has multiple. Select the desired cost
type from the drop-down menu.

K

NOTE

Resources must be assigned a
role to import their timesheet
(actual) hours into the resource
plan.

L
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3. Select the Period Length and Date :
Range

1. Click the Resource Plan View Options menu in
the header. Then select Dates.

2. Select the desired period length (monthly vs
quarterly vs yearly) and date range to which

Booking Dates: Set the date range for the
allocation. Select a From and To month and year.
Allocation Type: Enter the value in ONE of

the allocation types: Hours Per Month, %
Allocation, or Total Hours. If you select Total
Hours, the hours will be divided evenly across the
time selected between the booking dates.

you will be adding resource allocations. Click Add when done.

@ NOTE
If you enter hours values into

larger periods, such as into
quarters or years, then switch
to months, the values will be
split across the months based
on the calendar working days
per month/periods.

3. Click Apply to apply the set date range to the
resource plan view.

1.

4. Add Resources or Teams to the
Resource Plan

In OnePlan, there are two ways to add resources or
teams to your Resource Plan:

Add a Booking to a Resource Plan

Bookings in OnePlan is a way to quickly allocate
resources or teams to your resource plan. Bookings
are set for a certain time period and will allocate the
resource or team evenly across that time period.

Click Add Booking . The Booking form will open.
Complete the form.

» Select Resource: Begin typing the resource
(either named or generic) or team name.
Available matching resources and teams will
show. Make your selection. You can select
multiple resources and teams so you can make
bookings for multiple resources at once.

* (if applicable) Select Plan: Select the plan where
you would like to add the booking.

Add Booking x

Booking Dates

From: May 2022 To: May 2022

Allocation Type

1
o]

1)
o]

1)

Add a Resource to a Resource Plan

Open the Candidates List. Find and select the
desired resource (whether a named resource
or generic), or team. See Find Resources with
the Candidates List [218].

Click the Add button.
The resource will be added to the resource
plan above. Allocate the newly added resource
as needed.
. [ ! ]
° e
e -
- o m wm ma
) B Joe [omw ww o)
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5. Add Resource or Team Allocations

to the Resource Plan S NOTE
There are two ways to add time allocations for When you add time
resources or teams in your resource plan: allocations to teams of
resources, the time will
Manually Enter Time Allocations into automatically be split among
the Resource Plan the team based on how their
individual time is allocated
1. Verify you have the preferred planning mode to the team itself (see
selected (Hours, %, or FTE). This determines Allocate Resources to Teams
how the allocation values are displayed and (Total Percentage and Time-
calculated in the resource plan. Phased Allocation) for more

information.)

itted ) View: Resource Summary »  [5]

com T ]
. - =
T v Pl Total “a . . S

2. Add allocations manually into the Resource
Plan. Click into a cell in the resource plan grid
and type in the allocation.

You can manually change/

override the automatic split

by clicking into a cell in the

resource plan and manually
R typing in the preferred

e - :— allocation.

Use the Allocation feature to Bulk Add
Time Allocations

If desired, you may allocate time to your resources

via the booking form rather than manually entering

values. Select the row menu for a resource in the
resource plan.

1. Click the Row Options menu (ellipsis) for the
desired resource. Then select Allocate. The
Bookings form will open.

O D o o D5 Jack Barker

B T Erlich Bachman

0 ommen Peter Gregory [
0 Delate Resource Ryan Howard
0 Allocate Jian Yang

M Log Jared Dunn

2. Complete the Bookings form.
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Select Resource: Begin typing the resource
(either named or generic) or team name.
Available matching resources and teams will
show. Make your selection.

(if applicable) Select Plan: Select the plan
where you would like to add the booking.
Booking Dates: Set the date range for the
allocation. Select a From and To month and
year.

Allocation Type: Enter the value in ONE

of the allocation types: Hours Per Month,
% Allocation, or Total Hours. If you select
Total Hours, the hours will be divided

evenly across the time selected between the
booking dates.

Click Addto add the resource allocation.

NOTE
Whatever is entered in the

booking form will overwrite
any existing resource
allocation for the time between
the booking dates.

Add Booking x

4

NOTE
The value in the total column is

based on the periods shown in
the view and the type of planning
mode (hours, %, or FTE). Any
periods not selected will not be
included in the total.

If you have % selected, the value for the totals

column would include the months/periods with no

values & those with values.

5 E Committed Hours + Dates: May 2019 - Jun 2019
ITALS MAY 2019 UM 2019
E
|

7. Update the Status of Resource
Rows

Each resource plan rows has statuses, either
Proposed or Committed. When a row is first
added, the default status is Proposed, which
shows as a blue dot. Then, when ready, the row
can be changed to Committed, which shows as
a green check mark. There are additional row
statuses for organizations using the Negotiation
feature.

6. Review Resource Totals

To update the row status for a resource, click on the

status icon next to the desired resource, then select

There is a Totals column that shows the "total" per
resource.

the desired status from the drop-down.
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€y [[E ~ PlanTotal
e © = Project Manager
e @@ & Gavin Belson
e ©@ = Business Analyst
e «© = Richard Hendricks

Jack Barker

Erlich Bachman

Peter Gregory &

8. Set a Resource Row as Public or

Private

If the Public/Private feature is enabled, an
additional column shows whether each row is
Private or Public.

Rasource
@ |[GH =~ Plan Total
® Ty Q‘ Project Manager
ol |= Gavin Belsan
|l = |& Business Analyst
o Ty 'Q‘ Richard Hendricks
e |lo |& Jack Barker

When a row is Private, that means that the row

is not visible in reports or the Global Resource
Plan. Think of Private rows as drafts. They are only
available for the plan managers and owners to view
and edit.

Private rows are indicated by <.

When a row is Public, that means that row is
available for reporting and visible in the Global
Resource Plan. Think of Public rows as published
data. They are available for anyone (with the proper
permissions) to see.

Public rows are indicated by = .

Click on the icon to toggle between Private and
Public for each row.

You can change all rows from Private to Public
at once by clicking the Public/Private icon in the
column header.

282033

9. Add Notes and Comments to
Resource Rows

Add a Comment to a Resource Row

Comments allow you and your colleagues to

have an asynchronous discussion on resource
allocations in your resource plan. These comments
will remain in a thread, and the thread will appear
on the Home Page "Conversations" panel for quick
access.

To add a comment to a resource row, click the Row
Options menu (ellipsis) for the desired resource.
Then select Comments. The Comments thread will
open on the right side of the screen. You will be
able to see the existing conversation and can add a
comment to the thread.

I
N K

Once there are comments on a resource row, a
speech bubble will appear next to the resource
name.

°© « &

Gawin Belson [=]

Add a Note to a Resource Row

Notes allow you to add additional information to
your resource allocations. Notes live in the resource
plan, and nowhere else in OnePlan.
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To add a note to a resource row, click the Row
Options menu (ellipsis) for the desired resource.
Then select Notes. The Notes form will open. Type
out your notes in the Notes form, then click Save.

Once there are notes on a resource row, a sticky
note will appear next to the resource name.

e o = Richard Hendricks ]

10. Delete a Resource from your

Resource Plan

To remove a resource from your resource

plan, click the Row Options menu (ellipsis) for
the desired resource. Then select Delete. A
confirmation will pop up. Click Yes to delete the
resource.

ID:lt:l Warehouse Migration

How does a Resource Manager

Review Resource Plans?

This article explains how to review and update
resource allocation across all plans.

As a Resource Manager for a team or department
of resources, you would want to verify your team
isn't overbooked. You may also want to commit
specific named users to plans where generic role
placeholders had been used.

Navigate to Resource Plans

Navigate to Resource Plans via the main
navigation. This shows all resource plans across
all plans. Based on the planning units mode (%,
hours, or FTE), you see the total per resource. The
colors show whether the resource is booked under,
at, over their capacity.

Adjust Commitments

Group, filter, and adjust view as needed. For
example, group by role. Expand a role, such as
Business Analyst. Then, expand the resources
within the group to see to which plans the
resources are allocated. You can drag a plan to a
different resource to commit someone else to that
plan.

NOTE: Resources must be assigned a role to
import their timesheet hours into the resource plan.

@ OnePlan
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How the Resource Manager pre-

filter works

This article explains how the Resource Manager
pre-filter works for users set as resource managers
in OnePlan admin. Resource managers are off by
default. To set up resource managers, see How do |
set Resource Managers?.

The resource manager pre-filter is a server-side
filter that loads resources into the Resource Plan
area and/or Resource Center area based on
user permissions and Resource Managers admin
settings.

Owners and Managers

Users with Owner or Manager permissions can
view all resources in their OnePlan group, and
can use the pre-filter to narrow down the list of
resources in the Resource Plan area. The pre-
filter is based on the Method set in the Resource
Managers settings.

For example, Owners or Managers who are set as
resource managers using a Business Unit method,
the users will see a Business Unit filter in the
Resource Plan area.

Resource Plan

Committed ~ View: Resource Plans by Business Unit = Hewirs

Contributors

Users with Contributor permissions do not have
access to other resources in their group. However,
as a resource manager, Contributors can see the
resources they manage in the Resource Plan area
and Resource Center area.

For example, if a Contributor is designated as a
resource manager for IT, they will be able to view all
of the IT resources in the Resource Plan area and
Resource Center area. But, they cannot view any
other resources.

IT Tina Shirk

View: Resourc

Resource Plan

Committed & Plans by Business Lnit

7

[}

= P Business Analyst Business Analyst

¥ Erlich Bachman Business Analyst

N

¥ Gavin Belson Project Manager

-1 b Project Manager Project Manager

= ¥ Russ Hannerman Business Analyst

Candidates List "My Resources" Filter

When opening the candidates list, no resources
will be loaded by default. If you have resource
managers setup, clicking my resources will now
show just the resources you are the manager of.
This ensures fast loading of the candidate grid
when the logged in user has permissions to all
users in the system.

How is resource planning done
with the Negotiations feature
enabled?

This article explains how to use the Resource
Planner in OnePlan when the Negotiations feature
is enabled.

https://player.vimeo.com/video/792275326
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Your administrator would enable the Negotiations
feature and select the resource manager settings.
Typically, the resource manager is a functional or
departmental manager, but could vary based on
business use case.

If Negotiations are enabled after initial setup of your
OnePlan environment, previous time data in the
Resource Plan will not change.

Time proposed in the Resource Plan will remain
proposed and will now need to be approved by
the Project Manager (PM) and Resource Manager
(RM).

Time committed in the Resource Plan will remain
in a committed state, and does not need approval
from the PM and RM. However, the PM and RM
approval icons will remain blank in the Resource
Plan.

Resource Plan Differences

Row Status & Approver Status
Columns

Unlike in the regular resource plan view, you

cannot manually change the status of the row.

With Negotiations feature, initially a new row has a
status of Draft, shown as a white circle. The primary
difference in process is that the Plan Owner (shown
as a “P" column) and the Resource Manager for
that row (shown as an “R” column) both need to
agree/approve for the row to be fully committed.

RESOUACE FLAR

Process for the Plan Owner

The plan owner follows the same steps and use the
same tools to build out the resource plan.

1. Select a single or multiple rows.

2. Click the submit icon.

3. Your column will show as a green check-mark.
The other column will show as a blue question
mark for pending approval. And the row status
changes from draft to proposed. Any rows
marked as private will change to public.

P R @ RESOURCE
] De @ K Worat
V] Daniel Williams
[ ] Lori Weston
Rejected

Alternatively, select the status column for a row and
select Waiting Approval, Approved, or Rejected.

Process for the Resource Manager

Resource Manager Email Notification

As the Resource Manager for the requested
resource(s), you will receive email notifications
when the Plan Owner submits their Resource Plan
row(s). The details of the request show, and include
a link to "View Request." The link takes you to the
All Plans Resource Plan page
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eama O
®nePlan = ;
= \ Resource Manager Requests Task
e o Reassignment
T If a resource is overbooked or does not have
e T ] any availability for a particular task, the Resource
ot ot Wt ' P Manager can recommend a replacement resource

Resource Manager Updates to Resource
Plan

The Resource Manager approves the resource plan
allocation via the Resource Plans page.

1. Select a single or multiple rows.

2. Click the approve icon.

3. Your column will also show a green check-
mark. And the row status changes from
proposed to committed now that both have
agreed.

If either the Plan Owner or Resource Manager
makes a change to the resource plan, the row
status changes back to Proposed. The new value
shows. The previous value shows in parenthesis.

Hours » ommitted Hours » Dates: May

0-[=]- -
o PR RESOURLE .J?.“/:'I

A = Daniel Wilkams
e o & = DV Losgistics Merge 27520

* Lo Westan

for tasks within a project.

NOTE: Ensure you are looking at Scheduled
resources.

Business Unit

Resource Plan

Scheduled +

View: [Resource Summary *  Hours -

1]
4

1. Locate the overbooked resource. Expand the
resource until their assigned tasks are visible.
Select the task that you would like to reassign.

2. Open the Resource pane.

3. Search for and select a replacement resource
in the Resource pane.

NOTE: You may also need to select the project
in the top pane to search for a replacement
resource.

4. If applicable, Deselect the project in the top
pane. Make sure the task is still selected.

5. Click Replace Resource.

" & @ = )G Logistics Merges 19400 7
2 wekm
e & @ = sgistics Merger 3 7404 b dlan Yang Product Devalopment  Duvelopsr
1 Mattew Wiley
= Bulkd bullding 12400
o ; Hours = Committed Hours = Dates: hay g
- ]
AL
R RESOURCE
COMMITTE
Y, * Daniel Williams
Find B * *
e o |m DG Logistics Merge
A | ™ LoriWaston Pog Bines Ayt % " Businass Anslyat
& @ [ G Logistics Merge: 184.00 b & Suppert 5% Sapport
Q- wem b Jared Dunn 0% Product Dyvalopmant  Support
PS5 Duveleper ™ Preduct Divalupmant  Davalopsr
I o o © ||31 G Logistizs Morga ” a o
q [ ——" AT Fredos Divelopmens  Davalopie I
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A status update notification will appear on the
affected project indicating the suggested change for
Plan Owner to review and approve.

Plan Owner Email Notification

When the Resource Manager either approves or
rejects a resource request, the Plan Owner will be
notified via email.

®nePlan

Hi Daniel Williams
Your resource requests for project DG Logistics Merger have been fulfilled and

approved.

Name Start Finish Hours  Notes

| need Wo on this prc
important.

‘Wo Fat 6/1/2019 7/1/2019 19040 oject - it's super
Daniel
Williams

B/1/2019 9/1/2019 275.20

tact Wo Fat if you have any questions.

Thank yau,
OnePlan

Delegates

The Resource Manager & Delegates settings are
managed by your admin. If you are a Resource
Manager (such as for a specific department, role, or
other), you can also assign delegates to review and
approve resource plans.

Click the Delegates icon. Any groups, such as your
department, for which you are the manager, will be
listed. Designate any delegates as needed.

Reporting

When looking at Resource Plan information in
reports, there is a status field, to be able to report
on the approval status of each resource request.

Compare Resource Plan Types

This article explains how to use the compare
feature in the OnePlan Resource Planner to
analyze differences between how your resources’
time is initially planned, booked onto specific work,
and then actually spent.

Enable the Compare To View

To enable the Compare To View in the Resource
Planner (both the Global Resource Plan and Plan-
Level Resource Plans):

1. Click on the Modify View menu. Select
Compare To, then select the comparison you
would like to view in the Resource Plan. You
can compare the current Resource Plan Cost
Type with other available Resource Plan Types
in your OnePlan group, checking whether it is
greater or less than them.

Compare To View Enabled:

s

2. Go back to the Modify View menu. Select
Variance, then select how you would like
to view the variance between the compared
Resource Plan Types. Options include None
(not showing the variance), Value (based on
the currently selected Planning Units Mode),
and Percent.

Variance Enabled:

®OnePlan 213



Using OnePlan

Changes to the Resource Plan with
the Compare To View Enabled

Enabling the Compare To view in the Resource
Planner triggers several changes to the Resource
Plan.

* In the updated Resource Plan, each row
will feature two columns: one for the current
Resource Plan Type allocations and another for
the allocations of the other Resource Plan Type.
The data in the second column, representing the

other Type, is view-only.
- . "-:E_

» Depending on the chosen comparison, the
Resource Plan will highlight differences between
Types. You can set it to highlight when the other
Type is either greater or less than the current
one.

o oy
L | L]

1

e

' o~ 3=
heduled P ol
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Scheduled = Commitied
- Fm et o | e o ! | | PR B |

- —_
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sCnedule o =l 2L

- —_
heduled o hasts
SCnedau=a > =l 22

In this example, | have the Scheduled <
Committed comparison enabled. This means the
Resource Planner will highlight the Committed
column whenever the Committed allocations are
higher than the Scheduled allocations.

* If you enabled Variance, an additional column
will appear to show the variance between the

two Resource Plan Types. Depending on your
selected comparison, this Variance column will
highlight differences between the Types. You
can configure the Resource Plan to highlight
the Variance cell where the other Type is either
greater or less than the current one.

A = -

* When comparing, the ellipsis will be disabled
for resources that are not in the originally
selected type. This adjustment ensures that
only selectable resources within the chosen
resource plan type are available, improving clarity
and preventing unintended selections during the
comparison process.

* When comparing Resource Plan Types, the
public/private column does not display. This is
designed to reduce confusion by streamlining
the view and minimizing unnecessary details
regarding the status of resource bookings.

Add a Booking to a Resource

Plan

Bookings in OnePlan is a way to quickly allocate
resources or teams to your resource plan. Bookings
are set for a certain time period and will allocate the
resource or team evenly across that time period.

Click Add Booking ©. The Booking form will open.
Complete the form.

+ Select Resource: Begin typing the resource
(either named or generic) or team name.
Available matching resources and teams will
show. Make your selection. You can select
multiple resources and teams so you can make
bookings for multiple resources at once.

* (if applicable) Select Plan: Select the plan where
you would like to add the booking.

* Booking Dates: Set the date range for the
allocation. Select a From and To month and year.

» Allocation Type: Enter the value in ONE of
the allocation types: Hours Per Month, %
Allocation, or Total Hours. If you select Total
Hours, the hours will be divided evenly across the
time selected between the booking dates.

Click Add when done.
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Add Booking x

Booking Dates

From: May 2022 Tor | May 2022

Allocation Type

Add a Resource to a Resource
Plan

This article explains how to add a resource to a
resource plan in the Resource Planner.

1.  Open the Candidates List. Find and select the
desired resource (whether a named resource
or generic), or team. See Find Resources with
the Candidates List [218].

2. Click the Add button.

3. The resource will be added to the resource
plan above. Allocate the newly added resource

as needed.
. [ ! ]
° e
e -
v A T e o0
)| R Joa [ mm wew oo

Resource Planning Units Mode

This article describes the different planning units
modes available in the OnePlan Resource Planner.

Planning Units Modes Definitions

Select Hours: The number of hours a resource is
assigned to a task.

% (Percent): The percentage of a resource's time
is dedicated to a specific task.

FTE (Full Time Equivalent): The amount of
capacity or availability of an individual to work
during a specified time period.

Switching between Modes

To switch between planning units, click on the
Planning Units menu and select the desired mode
from the drop down. The Resource Plan will
recalculate the allocation values based on the
planning units selected.

Resource Plan
Committed View: Default View »  Hours® [E » ==

Tozal: Hoe: . Feb 2

Resource Plan Cost Types

This article explains resource cost types used in the
OnePlan Resource Planner.

https://player.vimeo.com/video/791979373

Select the Cost Types drop down menu to toggle

to another cost type. Cost types allow organizations
to calculate, evaluate and monitor how resources
are being allocated. There are possible (and often
likely) differences between how our resources’

time is initially planned, booked onto specific

work, and then actually spent. The Resource Plan
allows multiple cost types so you may analyze the
differences. You can toggle from one cost type to
another.

The reason these groupings are called “cost”
types is because the resource plan hours may be
converted to costs when they are imported into
the financial plan. The rate for each resource,
according to their role or other cost category factor
would be multiplied by the number of hours to get
the financial value of that resource’s time.

Your organization may have similar or different
cost types depending on business use cases and
configuration. See Cost Type Settings to configure
custom cost types.

Here are some example use cases that may apply.
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+ Committed Hours would be the initial plan 1. Select Copy Values from the drop down. The
generally estimated at a high level. This is also Copy Resource Plan form will open
referred to as top-down planning.

» Scheduled Hours cost type would be the totals
from the detailed task schedule. You could import

the task schedule hours into this resource plan w
cost type.
» Timesheet Hours cost type would be the

time spent on this plan. You could import the ™
timesheet hours into this resource plan cost type. =

NOTE: Resources must be assigned a role to
import their timesheet hours into the resource plan.

Committed -

) 2. Complete the Copy Resource Plan form.
i) L= * Select Type: Select the cost type you would
like to copy the resource plan data from.
« Start: Select the start date for the date range
- you would like to copy data from.
ST :':I * End: Select the end date for the date range
you would like to copy data from.
» Copy Custom Fields: Check the check
—_ box if you would like to copy over custom
5 resource plan fields.

Copy Resource Plan X

Copy Resource Plan Values

The OnePlan Resource Plan allows users to copy

tart: May 2022
resource plan data from one cost type to another.

S NOTE
The copy function only copies over -
time data. To replicate a resource

plan from one cost type into ) . .
another, use the Import function. 3. Click Copy. Then click Yes to confirm the copy.

See Import a Resource Plan [217].

To copy resource plan data from one cost type to
another:
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o

Copy Resource Plan

Are you sure you want to copy Resource Plans? This wil
overwrite anything in the selected date range.

Resource Plan Candidates List

Overview
This article provides an overview of the Candidates
List features as part of building, analyzing, and
modifying resource plans in OnePlan.

Import a Resource Plan

When needed, resource allocation can be imported

from elsewhere in the system. For example, the

timesheet hours can be imported into a resource

plan cost type, such as Actual Hours. If no

applicable import option has been configured by
your admin, the import icon will not show. See Cost

Type Settings to configure the import settings.

Be sure you’re in the right cost type, then click

Import.

Export a Resource Plan

To export a resource plan, first select the view
settings, such as cost type, unit mode, dates,

filters, etc. Then select your desired format from the
Export menu.

A

https://player.vimeo.com/video/791943604

Who does these actions varies between

organizations. Sometimes it’'s the plan owner,
project manager, scrum master, etc. Sometimes

it is the department or functional manager who

determines the best assigned persons to a plan.

Show/Hide the Candidates List

The Candidates List may be toggled on/off by
clicking on the Candidates List icon in the icon

menu.

K

NOTE

When opening the candidates
grid, no resources will be loaded
by default. If you have resource
managers set up, clicking My
Resources will show just the
resources you are the manager of.
If you select a filter that returns
more than 500 resources, only the
first 500 will be loaded. You will

be notified to apply more filters to
narrow your results. This ensures
fast loading of the candidate grid
when the logged-in user has
permissions to all users in the
system.

@ OnePlan
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Resource Plan Details and Candidates
List
If you show the Candidates List in the lower half of

the screen, each resource or team's summary row
shows the remaining availability.

- 1T

* Dl Wiliara i T Va0

i Scirsm

Candidates List Header Icons and
Menus

» Add Resource: Select a resource from the
candidates list. Then click the Add Resource
icon to add the selected resource to the resource
plan.

* Find Resource Search Bar: Search for
resources by hame using this search bar.

* Resource Type Menu: Select which type of
resource you would like to view - either individual
resources, or teams of resources.

* Find Resource Menu: Select a search method
from the drop-down. See Find Resources with
the Candidates List [218] for more information.

* Replace Resource: Replace or Fulfill resources
in the resource plan. See Replace a Resource
with the Candidates List [219] and Fulfill a
Resource with the Candidates List [220] for
detailed instructions.

» Group By: Group the resources in the
candidates list by a resource filed from the drop-
down.

+ Filter: Filter the resources shown in the
candidates list using a filter from the drop-down.

» Charts: Select a visualization to view resource
capacity. Options include the List (default), and
the Capacity v. Demand chart. The Capacity v.
Demand chart shows resource availability in a
stacked bar chart.

idi
ifi
IJJ

. =

|H

Find Resources with the
Candidates List

https://player.vimeo.com/video/791947929

1. Open the Candidates List.

-

2. Click the Resource Type menu, and select
the resource type you want to view in the
Candidates List. Options include Resources or
Teams.

i Froject Mansger

3. Click the Find Resources drop-down filtered
menu to expand. Select a field to search. The
results will be filtered accordingly.

K

NOTE

Options in the Find
Resources menu will change
based on the Resource Type
selected.

If you selected Resources in the Resource
Type menu, the options in the Find Resources
menu will include:

218 ®OnePlan
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+ Best Match: locates resources from your
resource pool based on role and availability.

S NOTE
You MUST select a

resource in the Resource
Plan above for the Best
Match search function to
work.

» By Current Plan: shows the current plan's
resources.

» Search by Name: begin typing a resource
name to search.

+ Generics: shows generic resources from the

Resource Center.

+ By Business Unit: filters resources based
on your organization's departments.

» By Calendar: filters resources based on
your organization's calendars.

* By Role: filters resources based on your
organization's roles.

+ Other: each additional resource-level field
(if any) that has been configured for your
organization will also show as an available
field for searching.

If you selected Teams in the Resource Type

menu, the options in the Find Resources

menu will include:

+ Best Match: locates resources from your
resource pool based on role and availability.

S NOTE
You MUST select a

resource in the Resource
Plan above for the Best
Match search function to
work.

» By Current Plan: shows the current plan's
teams.

» Search by Name: begin typing a team name
to search.

» Al Teams: shows all teams from the
Resource Center.

» By Business Unit: filters teams based on
your organization's departments.

+ By Calendar: filters teams based on your
organization's calendars.

* By Role: filters teams based on your
organization's roles.

+ Other: each additional resource-level field
(if any) that has been configured for your
organization will also show as an available
field for searching.

Replace a Resource with the
Candidates List

https://player.vimeo.com/video/791950240

Multiple reasons may require the plan's resources
to be replaced by other resources. Two common
reasons include:

+ Initially, a plan may have generic placeholders,
such as by role, for who is needed, and then later
a specific named person will be assigned to that
plan.

* One person who was allocated to a plan may be
overbooked, so another person with availability
may be replaced to do the work instead.

To replace a resource:

1. Open the Candidates List. Find and select
the desired replacement resource (whether a
named resource or generic), or team. See Find
Resources with the Candidates List [218].

2. Select the resource or team to be replaced in
the resource plan.

. Click Replace Resource.
4. Inthe popup, Click Replace.

ol - N
i — ]

8 ]
— . “ 200 " £

®OnePlan 219


https://player.vimeo.com/video/791950240

Using OnePlan

The resource will be swapped with the new
replacement in the resource plan above. The
allocation will stay the same. The status will return
to proposed and the row will return to private (if
public/private entries are turned on).

---------

Fulfill a Resource with the
Candidates List

https://player.vimeo.com/video/791953197

If a plan has resource placeholders, such as roles,
you can fulfill the resource requirement with one or
more named resources, or a team of resources.

K

NOTE

You can fulfill resource
requirements on both generic and
named resources.

If you want to fulfill resources in the global
Resource Plan page, set the page view to
Resource Requirements.

1. Select the resource in the resource plan.
NOTE: If in the global Resource Plan page,
expand the desired project to view the
requested resources.

2. Open the Candidates List.

3. Inthe Candidates List, filter for named
resources or teams, such as by role, to
fulfill the resource requirement. See Find
Resources. Select the desired resource.

4. Click Replace Resource.

5. In the popup, click Fulfill.

6. To assign another resource to fulfill the
resource requirement, repeat steps 1-5.

The placeholder resource now has named
resources assigned to fulfill the resource
requirement.

The resource details will show the original resource
requirement, and the remaining resources needed
to fulfill the requirements (in hours, FTE, or %).
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Financial Plans

Financial Plan Overview (Video)

The following video provides an introduction to the
OnePlan Financial Planner, including a tour of the
menus and buttons, as well as an explanation of
how to create a basic financial plan.

Video length: 6:50

https://player.vimeo.com/video/755263208

How do | build a Financial Plan?

This article explains how to build a OnePlan
Financial Plan. Be sure to read the previous articles
in this chapter to get familiar with the Financial Plan
terminology and menu options.

1. Navigate to the Financials Module

Navigate to the Financials page for your plan, if not
already there, by clicking Financials in the Header.

2. Select Your Cost Type

Before adding financial details, be sure you are
viewing the correct cost type. Select the desired
cost type from the drop down menu.

Budget + | [l -
Budget
Forecast e
[ Actuals al
Benefits

3. Select Currency

Before adding financial details, be sure you have
the correct currency selected, if your organization
has multiple currencies configured. Select the
desired currency from the drop down menu.

Budget v [l = Dates: Apr 2019 — Apr 2020

COST CATEGORY Euro “NSE TYPE NOTES

4. Select Time Period Length & Date
Range
Select the desired time period length (monthly vs

quarterly vs yearly) and date range that you will be
adding financial values. Click the Apply button.

<5 Compare To: None = e

Start Erd

Last Year - 2018 A - - 2020 v -

chizlas Jan Feb Mar Jan Fab Mar
MNext Year

Apr May Jun m May Jun
Next § Years

Jul Aug Sep Jul Aug Sep

Oct Moy Dec Qct A= Dec

If you enter values into larger periods of time, such
as into quarters or years, then switch to months, the
values will be equally split across the months.

5. Add Financial Values

Add the cost values for the applicable cost
categories and time periods. You can use the tab
button and arrow keys for quicker entry into the
cells.
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5.1. Totals

1. There is a Totals column that show the total

per cost category and each summary level row,

such as Plan Total.

2. There is also a total row at the top of each time

period column.

3. There is also a Period Total column to the far
right of the Financial Planner that shows the
totals of the time frame selected shown. You
may choose to view only a few months in the
Financial Planner, but the plan may be longer
than the select view period.

6. Add Detail Row

To track multiple rows for the same cost categories,
use the Add Detail feature.

1. Select the menu icon for a cost category row,
then Add Detail.

2. The cost category becomes a summary level
row. Enter your costs on the child row.

3. To distinguish multiple rows within a cost
category, you would typically enter details
into the additional cost category fields to
distinguish.

4. Repeat steps 1-3 for each additional detail row.

The Add Detail option is only available if Grouping
is OFF.

Rather than manually entering labor costs manually,
you can import the labor financial values from
elsewhere in the system. Your environment may
be configured for each Financial Plan cost type to
import labor costs. If no Import 'From' is configured
for that cost type, the Import button will not show.
An example use case could be that the Resource
Plan hours imports into the Budget cost type,

the resource schedule imports into the Forecast
cost type, and the timesheet hours import into the
Actuals cost type.

Build the Resource Plan. Then back in the
Financials page, import the Resource Plan. The
hours are multiplied by the rate (rates are managed
in the admin settings) and converted to costs for
each labor cost category. Typically, the labor cost
categories are roles or something similar. Though,
as OnePlan is flexible, another use of labor cost
categories may be configured for your environment.
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7.1. Resource Plan Hours

e —
- -

7.2. Import Costs

Df.

Import Costs

Are you sure yolsant to impon costs from Resource Flanner. This process may take
some tima?

Be sure you're in the right cost type, then click on
Import Costs. Verify the import by clicking the Yes
button.

8. Copy Costs

res Dates: 0 Compare Te: Non=
° o[]
°
[
© CE
T

You may copy costs from one cost type to another
cost type. For example, once the budget is finalized
and approved, you may want to maintain the
ongoing estimated costs in the Forecast cost type.
Or, as the plan is actively incurring costs, you can
copy the original Budget into the Actuals cost type,
then update as needed for each time period.

1. Go to the destination cost type.

2. Click the Copy Costs icon.

3. Select the source cost type and date range.
4. \Verify to copy costs.

The values from all cost categories from the source
cost type will copy into the destination cost type.

How do | get around the

Financial Planner?

This article explains the navigation and terminology
of the OnePlan Financial Planner.

Heading
B
The Heading bar is where you may access the

details of your plan and toggle between different
planning modules for your plan.

Ilcon Menu

You will use these icons and menu options to
change how your financial plan shows and to
compare your financials for your plan.

Terminology & Use

'H. kam
o]
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1. Cost Types

Click the Cost Types drop down. Cost types allow
organizations to calculate, evaluate and monitor
what financial costs are planned, actually spent,
and also financial gains. You can toggle from one
cost type to another. A cost type may be editable
or not. If not, the data is likely being imported from
another financial system for reference.

Your organization may have similar or different
cost types depending on business use cases and
configuration. Here are some common general
uses that may apply.

A Budget is the initial plan for what is estimated

to be spent on this initiative. Expected costs are
entered into cost categories. A cost category is

how costs or gains are broken out into smaller
defined categories. These are often organized as
whether they are labor costs, and also whether they
fall into expense type buckets, such as capital or
operational expenses.

Once the Budget gets approved and a plan moves
forward in the process, The Forecast costs are
often used as the ongoing expected or estimated
costs, updated as the plan or initiative continues.
The forecast costs can be entered manually, or
copied from another cost type, such as Budget.
Then, updated as needed.

The Actuals cost type shows what has already
been spent on the plan.

Another common example of a cost type is
Benefits. This is where you would track what is
expected to be gained from this plan. Notice the
cost categories would be different in terms of what
is gained vs another cost type for financials spent.

2. Cost Categories

Cost Categories, including Labor Cost Categories
- Expected costs/financial values are entered into
various cost categories. A cost category is how
costs or gains are broken out into smaller defined
classifications or groupings. The cost categories
may differ per cost type. For labor cost categories,
the number of hours entered into the Resource
Plan can be imported as costs, calculated as hours
X rate.

3. Cost Category Fields

The Cost Category Fields allow cost categories
to be further grouped and clarified (i.e Expense
Type & Description shown in the example above).
Users may add detail rows to cost categories
with additional information in the additional fields
columns.

4. Cost Totals

The totals show per cost category, and than
summary total for the whole plan.

5. Time-phased Cost Details

Costs are viewed and/or edited per time period
shown. Based on the Dates menu selection, costs
may be summed up or broken out in more or less
details (i.e. daily, monthly, quarterly, yearly).

How do | use the OnePlan
Financial Planner?

This article contains a video that shows how the
Financial Planner works and how to use it.

Topics include:

* Financial Plan terminology and navigation
* Menu options

* How to build a plan

* How to import

* How to export

* How to copy cost types

https://www.youtube.com/embed/djTSipZkQWc
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What are the Financial Plan

menu options?

This articles explains the various menu options for
viewing and building financial plans.

Submit

Select a row in the financial plan. Click the Submit
button. If approvals are turned off, the row status
will change to submitted. Should any data in

the row change, the status will change back to
unsubmitted.

Cost Types
1 Budget v QI ~
JRY
Forecast
— Actuals
— Revenue

Select the Cost Types drop down menu to toggle
to another cost type. When viewing any additional
cost types or comparing cost types, the one
selected in the Cost Types drop down menu is the
one that remains editable (if it's an editable cost

type).

Additional Cost Types

Budget = | E ! =D - Dates: Jul 2018 - Dex 20714 Compare To; None
ol EXFENSE THFE Z5CRIFT

Achls SlinGE

= Fun neiclotd 263,500.00 7550000

v Labor #12.000.80 33.000.00

Should you want to see two or more cost types
side-by- side, select the cost type from the
Additional Cost Types button. Note, your main cost
type is the editable one, whereas the additional cost
type(s) will be view only. You would go to that other
cost type to update it if needed. Each cost type
selected will show side-by-side in the Totals section
and each time-phased period.
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Currencies Monthly
Dates: Jul 2016 - Dec 2013 = Compare Ta: None = | -
Usb = Date Zaoen Quarer  Yoar Stant End
USsD Last Year - 2018 v - - 2018 . -
E Thi Jan  Feb  Mar Jan  Feb  Mar
GBP Mext Year
Apr May Jun Apr May Jun
! Mext 5 Years
MXN Jul Aug Sep Jul Aug Sep

CAD Gancal Oct Moy Dec Oct Mow

Quarterly

usp - Date JUL 2018 AUG 2018 SEP 2018
u BUDGET BUDGET BUDGET Dates: jul 2078 Compare To: None H -
Zooen: Month uarie Year Slar End
GBP \ 75,500.00 38,000.00 44,000.00
Last Yaar - iy i) v - - 218 v -+
MXN 33,000.00 33,000.00 39,000.00 Ser
Q1 Q2 Q1 Q2
CAD B,000.00 £.000,00 8,000.00 Next Yaar — . o
Jan, Fab, Mar  Apr, May, Jur Jan. Fab. Mar  Apr, May, Jun
A A g o T = Moxl 5 Yoars
25.000.00 25.000.00 25.000.00
ho Q4 Q3
I oty Jul, A, Sep REEEESTE N Jul, Aug, Sap EECSERTREE
,000.00
JUL 208 AUG 2018 SEP 2018
BUDGET BUDGE BUDGET Dates: Jul 2018 - Dec 2019 % Compare Ta: None » | -
CAD - Dat
Zoom; Month  Quarter Start End
52.850.00 26,600.00 30,800.00
usn Last Year - ms-2m v - W15-200 v| =+
GBP 23.100.00 23.100.00 27.300.00 e

o CEMY A & ; 2018 2016 2017
N / 5,600.00 5,600.00 5,600.00 Nt Veor
17,500.00 17,500.00 17,50000 ! Mext 5 Yaars PUSCE 2019 2020 2018 m 2020

i 2021 2022 2023 2021 2022 2023
420000

Show Hidden Cost Categories

If your organization uses different currencies & has
. 3 Budget « i - CAD = Dates: Jul 2018 ~ Dec 2019

them configured, you can toggle between them

here. The currency conversions are configured by

the admin. Enter costs in the preferred currency.

When you toggle to a different currency, the values :
will adjust per the currency conversion tables.

EXPEMSE TYPE JESCFTION

Dates - —
Change the Date Range of your view as needed. Tl an Expenies

Select one of the preset date ranges such as Last :

Year, This Year, Next Year, or Next 5 Years. = Captx
Or, set a custom range, zoom to Months, Quarters, g

or Years, then select the time frame desired. Then,
click the Apply button.
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To see which rows are hidden or add them

back in to your financial plan, click Show Hidden
Categories to toggle showing them or not. The rows
that were hidden are greyed out.

Tranvel and Expanses

o" unc Deatail

st Dddbeim
Expansis

1. To show a row in the plan that had been
hidden, click the menu for a hidden row and
then Show Row.

2. To hide a row in the plan, click the menu for a
row and then Hide Row.

Compare To (Cost Type)

Compare To: None ¥

None L

Budget < Forecast D

Budget > Forecast 5>

Budget < Actuals 53
Budget > Actuals
Budget < Revenue

Budget > Revenue

Compare values across two cost types. Select
Compare To, then two cost types to compare. You
may only compare two cost types at a time.

24,100.00 30,450.00 30,800,000 31.640.00 26.600.00 27,440.00
20,600.00 23,100.00 27,300,00 28,140.00 23,100.00 23,940.00
15,0000 0000 0000 - 17,500,00 -

The values for both cost types will show side-by-
side. Note, your main cost type is the editable
one, whereas the comparison cost type(s) will be
view only. If you change a value in the main

cost type, the colors will update according to the
variance rules in real-time. You would go to that
other comparison cost type to update it if needed.
Each cost type selected will show side-by-side in
the Totals section and each time-phased period.
The carrot direction determines whether the greater
than or less than will determine the logic for the
color scale green or red. In the example above
"Budget < Forecast," the forecast column will turn
yellow then red when the forecast is greater than
the budget cost type. Here is the formula for when
the colors change:

The calculation currently is [value1-value2|/
((value+value2)/2)*100

Colors are (based on the percentage variance):

e >120% red

* >110% Orange
* >100% yellow
* <=100% green

Variance

Compare To: Budget < Forecast w -

Mo

&

BUDGET FORECAST VAR il FORECAST

30.450.00 Percant 10.00

17.500.00 17,500.00 - 17.500.00 17,500.00

26,600,00 1,840.00

23,100.00 27, 300,00 28,140.00

5600.00 5,600:00
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When comparing cost types, you may select a type
of variance to show. Select the Variance drop down
for the options: None, Value, or Percent. When a
variance type is selected, the colored cells become
the variance column rather than the comparison
cost type column.

Grouping

. % No Group

i zroup By Expense Type

To change the grouping select either No Group or
Group By " ". The default grouping field (if
any) is set by your admin. Typically, the additional
choice Cost Category fields are available to select
for grouping.

Copy Cost Type
Ql_l 4 e e e i i

You may copy costs to another cost type as well.
For example, once the budget is finalized and
approved, you may want to maintain the ongoing
estimated costs in the Forecast cost type. Or, as
the plan is active incurring costs, you can copy
the original budget into the Actuals cost type, then
update as needed for each time period. You can
copy from any one cost type to another.

Go to the destination cost type.

Click the Copy Costs icon.

Select the source cost type and date range.
Verify to copy costs. The values from all cost
categories from the source cost type will copy
into the destination cost type.

S

Import Costs

When needed, costs can be imported from
elsewhere in the system. For example, importing
the committed resource plan hours into budgeted
labor costs, or timesheet actual hours into the
actual labor costs. Rather than manually entering
labor costs, build the Resource Plan. Here the
resource plan is filled out. Then back in the
Financials page, import the hours, which are
converted to costs with each role’s rate.

Be sure you’re in the right cost type, then click on
Import Costs & Yes.
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Export Costs
A

To export, first select the desired cost type, dates,
and content to view. Then select your desired
format from the Export menu.

@ OnePlan
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Create, Update, and Submit
Status Reports

This article explains how to open, update, and
submit status reports. This article assumes that
your OnePlan Administrator has already configured
Status Reports for your OnePlan environment.

One of the nice things about OnePlan is that you
can centralize all your work and initiatives into One
Plan and allow managers to create and submit a
standard status report.

Access Your Status Report

There are several ways you can access your status
reports:

* Home Page - Insights: If a status report is
due or ready for submission and approval you'l
notice it in your insights. Here you see | have
a message that some of my plans have status
reports that are due. Click on View Details to
see all of the status reports that require your
attention. Then click View Plan to access the
status report for that plan.

Py

* Home Page - Plans: Or you can navigate to your
plans by clicking the hamburger, go to reporting
and select status reports to display the status
report that requires my attention (scroll to the
lower part of the report to show that | need
to update the status based on the information
that has already been entered into OnePlan (like
project information and financials.)

Trurssas gt 11 2020
Welcome back, Deborah Rath

gk

B

* My Portfolio: Or, if you have access to your

organization’s portfolio, you can navigate to the
portfolio view (click portfolio view), find your plan
within the portfolio view, again, clicking on the
hamburger, click reporting click status reports.

Status Report Area: We have a status report
view here on the main navigation menu. If you
click here, you're going to see a view that shows
you a view of all open reports that you need to
complete, review or submit to management for
approval or, if you are in the manager role, have
reports waiting for you to approve and send back
to your PMs

5

* Plan - Reports Tab: If you are working in a plan,

you can also access the status report by clicking
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on the Reports tab, and selecting Status Reports
from the drop-down menu.

B X

Details Financials Resource Plan Work Plan Reporting v

Effort Assigned Resources % Done
Insights

21/2024 678.8 hours 1 Dashboard

Create a New Status Report

If you have not created a status report for your

plan previously, and are running the report for the
very first time, you will need to click Create Report.
This will run the status report and generate a new
report for you. The status report will then run on
the schedule set up on the back end of OnePlan by
your Administrator.

Click to create status report

Update Your Status Report

The first thing you'll see in the upper right hand
corner is that you can have snapshots of these
status reports. From this drop-down, you can
access all of your current and historical status
reports. In this example, the status report for
1/25/2024 is Pending, and needs to be reviewed,
updated, and submitted.

Report: 01/25/2024
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@nePlar

Basically what OnePlan does is it generates a
status report based on the current data in your
plan. What’s nice about this is that you can actually
come into your pending status report and make
modifications before you submit it. Any changes
that you make in the status report will also be
reflected in the plan itself, so your data is accurate
across the board.

You are able to edit any editable field available in
the status report. So, for this example, | may need
to update the Status Health of my plan before |
submit this report. | can simply click into the Status
Health field, and select the correct value. This
updated Status Health value will also be reflected
in the live plan as well.

T e T ==

Perhaps | need to update the Forecast value in
this status report. | can click into the Forecast field
and update this value. Again, this value will also be
updated in the plan itself.

Finally, maybe | would like to add some additional
comments into the status report, | can enter those
comments into the Additional Comments field, and
those comments will be tracked as your plan

progresses and future status reports are generated.

Submit Your Status Report

Once you have your status report set up and
updated the data, you can now submit this report
to your manager.

To submit the status report, simply click Submit.
Then confirm the submission in the pop-up. The
status report will be sent off to the required
reviewers for their review and approval.

|15 Apps for Metra Transit Autharity

Once submitted, OnePlan will lock down the status
report so now you can no longer update, add or
make changes to this status report.

Recall Your Status Report

You can recall a status report before a manager
approves it. So if you forgot something, you can
come back and recall it. As soon as a manager
approves it, that report becomes the official status
report for that period.

To recall a status report, simply click Recall.
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Export Your Status Report

Once your status report has been approved, you
may want to export the report so you can share
it with other stakeholders who may not be using
OnePlan. You can export the report as a Word
document, PDF, or in an email.

To export a status report, click Export, then select
your desired format from the drop-down. The report
will then download into your downloads folder, or an
email will generate.

Fxport Rep«
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How do | access Power Bl

dashboards/reports?

This article explains how to view the OnePlan
reporting dashboard in OnePlan. You may also go
into PowerBl online to access the reports as well.

If you don't see anything on the Dashboard page,
your admin may need to configure the Dashboard
for your OnePlan Portfolios Dashboard page and/or
Plan Dashboard page.

See Set up the Reporting Dashboard for
instructions to set up the OnePlan reporting
dashboard.

Portfolio Dashboard

Navigate to the Portfolios module. Select
Dashboard view. The report opens. You may need
to authenticate for Power BI. Click Sign-In. If you
don't yet have a PowerBI license, you can start a
trial of PowerBI.

Ll

=)

Select the various tabs to see additional reporting
details. Select filters as needed. Click on visuals to
further dive into the data.

Plan Dashboard
From the Portfolios List page, open the contextual
menu for a plan. Select Dashboard.

@ OnePlan
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4.
View Plan Insights
This article describes how to access and view plan- g

level insights. Insights notify you about plan items
that require attention. Insight scores are generated
S0 managers can easily track compliance to best
practices.

Open Plan Insights

1. Go to your desired plan.
2. From the plan navigation, select Reporting >
Insights. The plan insights page will open.

Er

Insight Descriptions

In the insights page, you can view all plan insights
and the plan compliance score.

Plan Compliance Score: Calculates the
number of open (information, warnings, or
problems) compliance insights divided the total
number compliance insights.

Insights List: Lists all insights for the current

plan.

Trigger Level Filter:Allows you to filter the

insights list by insight type. Types include:

* Success: The item has been addressed and
completed. Marked with the green circle with
a check icon.

* Information: The item is for information only.
There are no actions that need to be taken.
Marked with the blue circle with an ! icon.

* Warnings: The item is an issue, but is not
urgent. If not addressed, the warning will
be escalated to a problem. Marked with the
yellow triangle with an !'icon.

* Problems: The item is causing issues for
the plan and must be addressed. Marked the
red circle with an X icon.

NOTE: Items marked with the shield icon are
compliance insights and are counted in the
plan compliance score.

Insight Category Filter: Allows you to filter

insights by categories*.

NOTE: Categories are customizable and will

vary.

Refresh Insights: Refreshes the insights list in

real time.

uuuuuuuuuu
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Visualizer Overview Get Around the Visualizer

This article provides an overview of the Visualizer The dots represent plans. You can select how the

module for OnePlan Reporting. dots are colored based certain plan data such as #
of Backlog Tasks, % Done, and more. This makes

The Visualizer module is a feature of OnePlan it easy to see if plans are getting off track, or may

plans that enables users to easily view plan cause issues for its associated plans.

dependencies and relationships. ) ) )
The lines represent the relationships between the

To use the Visualizer, your OnePlan administrator plans.
must first set it up. See Set Up Visualizer for
instructions.

Video Length - 5:37

https://player.vimeo.com/video/766556084

Access the Visualizer

Table 4. Visualizer Icons and Menus

S i
. . . Icon / Menu Name Description
The Visualizer module is added R Click P A
T unway view ick to access the
to individual plan typgs .and Runway view.
process flow steps within the plan

. K o Dependencies Click to access the
details form. You must be in the . Dependencies view.
correct plan type and process This is the default
flow step to access the Visualizer VLI
module. Consult your OnePlan Configuration gzlﬁaﬁalfblzn

.. . unway view.
administrator for a list of plan Click to configure
types and process steps where the the columns in the
Visualizer module is available in Runway view.
your OnePlan environment. Color By: None Color By menu Select the plan field

to drive the dot
coloration in the

Visualizer.
Refresh Click to refresh the
) Visualizer.
1. Go to the desired plan. Be sure that t.he p!an Zoom Out Click to Zoom out.
is in a process flow step where the Visualizer ) .
. ] Zoom In Click to zoom in.
module is available. ) , )
. . . . View: None + View menu Only available in
2. Go to Reports > Visualizer. The Visualizer the Runway view.
module will open. Select, save, or

delete custom view
configurations for the
== Visualizer.

Dependencies View

= * 2 The Dependencies view allows you to visualize
o your plan successors and dependencies. This
o allows for better understanding your predecessors
— and successors and communicating changes and
risks to other plan managers.
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See Use the Visualizer Dependencies View [236]
for instructions on how to use the Dependencies
view.

Runway View

The Runway view allows you to better visualize
relationships between other plans. For example,
you could visualize all of the Objectives, Key
Results, Value Streams, Products etc. that are
associated to your Project.

See Use the Visualizer Runway View [237] for
instructions on how to use the Runway view.

Use the Visualizer

Dependencies View

This article explains how to use the Dependencies
view of the Visualizer module.

The Dependencies view allows you to visualize
your plan successors and dependencies. This
allows for better understanding your predecessors
and successors and communicating changes and
risks to other plan managers.

The Dependencies view has three columns:
Predecessors, Plan, and Successors.

* Predecessors are plans that must begin or end
before the current plan can begin.
* Plan is the current plan you are analyzing.

* Successors are plans that follow (are dependent
on) the current plan.

The dots within each column represent a plan in
your OnePlan portfolio.

The lines represent the relationship between
the plans in your portfolio. The lines in the
Dependencies view have arrows indicating the
direction of the relationship, pointing towards
SUCCeSsOrs.

Contextual Menu Actions

Click on a dot to access the contextual menu.
From this menu, you can access the plan's Quick
Edit form, or drill through for more dependency
information.

O Quick Edit |

JUNgE

_"rl T imnm
—" ot

Quick Edit

Select Quick Edit from the contextual menu to
open the Quick Edit form for the plan. The Quick
Edit form will open on the right side of the screen.
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Proposed

Strategy Information -
Name: Appeal to a younger demographic
Manager:

Executive Sponsor:

Priority: High

State:

Category: New Product Development
Business Unit: T

Goals: Grow Business

arov =

. Strategy Description -

Strategy Schedule -
Estimated Start:

02/01/2022

Estimated End: 0/2022

]
I
[S

Strategy Financials -

Budget: $1,778,965.00

Drill-Through

Select Drill-Through from the contextual menu to

view the dependencies for the selected plan in the

Visualizer. This will place the selected plan in the

Plan column of the Visualizer, and display the plan's

predecessors and successors.

Use the Visualizer Runway View

This article explains how to use the Runway view of

the Visualizer module.

The Runway view allows you to better visualize
relationships between other plans. For example,
you could visualize all of the Objectives, Key
Results, Value Streams, Products etc. that are
associated to your Project.

The dots within each column represent a plan in
your OnePlan portfolio.

The lines represent the relationship between the
plans in your portfolio.

Configure the Columns

The columns in the Runway view are configurable
S0 you can view the relationships that are important
to you.

Add Columns

1. Click on the Configure icon . The
Configure form will open.

2. Click the Add icon to create a new column.
The Add Column form will open. Complete the
form.
a. Display Name: Enter the display name for

the new column.
b. Plan Types: Select the plan type(s) you
would like to display.

Add Column

2y Mame Objective

n Types: Objective

c. Lookup Field: Select the lookup field
that associates your current plan with the
selected plan type.

@ OnePlan

237



Using OnePlan

For example, | am adding an Objective 4. When your configuration is complete, click OK.
column that will show objectives related Your new column configuration will display in
to the current plan. These objectives are the Visualizer.

associated to the current plan through the
Associated Objectives field.

Add Column x

Edit Columns

1. Click on the Configure icon . The
Configure form will open.

2. You can drag and drop columns in the
Configure form to update their display order.

d. Click Ok to create your new column.
3. Torearrange the column display order, select Configure x

a column from the Configure form, and drag

and drop it into the desired location. The top

column in the list will be on the left of the ¢/ Name: Plan

screen, and the last column will be on the right — e

Name: Objective

Of the screen. . PlanTypes: Objective
Field: Associated Objectives

Configure x £ : Name: Key Results
PlanTypes: Key Result
Field: Associated Results

Name: Plan C CANCEL

Name: Objective 3
PlanTypes: Objective -
Field: Associated Objectives

To edit the details of a column, click the Edit

icon < next to the desired column. The Edit

; ’ ’ Name: Key Results H
PranTypen o el Column form will open.

Field: Associated Results

Edit Column x

Configure x

Lookup Field Associated Ohbjectives hd

Name: Objective
PlanTypes: Objective
Field: Associated Objectives

4. Update the column details as necessary. Click
Save to apply the changes.

Name: Plan
Name: Key Results .
PlanTypes: Key Result Custom Views

Field: Associated Results . . .
You can save custom views of the Visualizer for
ceL easy access using the Views menu.
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Save Views

Complete Configure the Columns [237].

Click the Views menu, and select Save

View.The Save View form will open.

Complete the Save View form.

* View Name: Enter a name for the new view.

* Default View: Check the check box if this
will be the default view for the Visualizer.

* Personal View: Check the check box if this
is a personal view for your use only.

Click Save. The view will now be available for

use from the Views menu.

Delete Views

1.

Go to the Views menu and select a view. The
view will load in the Visualizer.

Go to the Views menu and select Delete View.
A confirmation will pop up. Click Yes to delete
the view.

View: Objectives and Key Resulis

Cbjectivas and Kay Aesulis
Save Vie
Delete View

Delete View x

9 Are you sure you want to delete the current view?

Contextual Menu Actions

Click on a dot to access the contextual menu.
From this menu, you can access the plan's Quick
Edit form, or drill through for more dependency
information.

. Cick Edit

Junge

_"rl T gn
—" ot

Quick Edit

Select Quick Edit from the contextual menu to
open the Quick Edit form for the plan. The Quick
Edit form will open on the right side of the screen.

Propased

Strategy Information
Name:

Manager:

Executive Sponsor:

Priority:

State:

Category:

Business Unit:

Goals:

Strategy Description

Strategy Schedule

Estimated Start:

Estimated End:

Strategy Financials

Budget:

1
oo

Appeal to a younger demographic

MNew Product Development

Grow Business

02/01/2022

$1,778,965.00
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Drill-Through

Select Drill-Through from the contextual menu to
view the dependencies for the selected plan in the
Visualizer. This will place the selected plan in the
Plan column of the Visualizer, and display the plan's
predecessors and successors.
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Resource Center

on user accounts in your Azure/Office365

Resource Center Overview tenant. Select the user name.

Invite new users to your OnePlan environment, and * Quantity: 1 signifies 1 FTE, or one full-

manage your pool of resources and teams using time resource. Full-time is all working hours

the Resource Center. based on the Calendar settings. 0.5 would
signify a part-time resource who is available

Watch the Resource Center Overview 1/2 time. This affects the resource's capacity.

Video * Group: Select the appropriate Enterprise

Security Group for this new user. Out

of the box, OnePlan comes with the
following Enterprise Security Groups, with
the following permissions:

The following video provides a walk through on the
OnePlan Resource Center, as well as how to add
resources to OnePlan.

https://player.vimeo.com/video/954 127343 * None: Does not have access to OnePlan
* Team Member: Can view and edit plans or
Related Resources tasks assigned to them
For more information on the OnePlan Resource * Contributor: Can create, view, and edit
Center, check out the following resources: their own plans
» Executive: Can view all plans (and
* Add Users to OnePlan content for those plans)
* Create and Manage Teams in the Resource + Manager: Can view and edit all plans (and
Center content for those plans)
+ Allocate Resources to Teams (Total Percentage « Owner: Can view and edit all plans
and Time-Phased Allocation) (and content for those plans); can modify
+ Manage Resource Notification Settings OnePlan configuration (Admin)
* Resend a OnePlan Invite - Business Unit: Select the business
* Remove a user from the license count unit. Available business unit choices are
configured on the Fields page, in the section
Add Users to OnePlan for resource-level fields.
This article explains how to add users/resources to * Role: Select primary role. Available role
your OnePlan environment. choices are configured on the Fields page,
in the section for resource-level fields.
Create Named Resources + Manager: Begin typing the name of the
] . . L. manager for this user. Select the desired
With Office365 Strict Authentication name.
If you are adding a new user who is part of + Timesheet Administrator: (This field only
your Entra/Office 365 tenant, and your organization shows when the Timesheet App has been
has Office365 Authentication enabled, follow these added). Select this check box if this user is a
instructions. timesheet administrator.

* Timesheet Manager: (This field only shows
when the Timesheet App has been added).
Begin typing the name of the timesheet
manager for this user. Select the desired
name.

» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

1. Go to the Resource Center.
2. Click Add Resource. The Add Resource form
will open.
3. Complete the Add Resource form.
» Generic: Leave the check box unchecked if
the resource is a named user.
+ User: Begin typing the name of the user.
The available names will authenticate based
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Rate: Enter the rate for this user, if different
than the rate associated to this user's role
(configured on the Cost Categories page).
Rate is the amount that you bill out for the
resource.

Governance Warnings, Governance
Problems, Compliance: These fields are
not editable. They are related to Insights,
and display the number of governance
warnings and problems and a calculated
compliance score. Skip.

Click Save. The new user will be available

throughout OnePlan. The user will also receive
an invitation email from OnePlan informing
them that they have been added to the
OnePlan group, as well as a link to the

group. The user can then use their Office 365
credentials to access OnePlan.

NOTE

Any additional fields that are
configured as resource-level
fields on the Fields page

will show on the Add/Edit
Resource forms.

K

Add Resource

With Multi-Authentication Enabled and the

User is part of your Entra/Office 365
Tenant

NOTE

Multi-Authentication must be
enabled in order to add users
with this method. See Enable
OnePlan Multi-Authentication for
instructions.

K

If you are adding a new user who is part of

your Entra/Office 365 tenant, and your organization

has Multi-Authentication enabled, follow these

instructions.

1.
2.

Go to the Resource Center.

Click Add Resource. The Add Resource form

will open.

Complete the Add Resource form.

* Click the Entra icon. Search for and select
the user you would like to add to OnePlan.

Add Resource

’:-lh

* Generic: Leave the check box unchecked if
the resource is a named user.

* Quantity: 1 signifies 1 FTE, or one full-
time resource. Full-time is all working hours
based on the Calendar settings. 0.5 would
signify a part-time resource who is available
1/2 time. This affects the resource's capacity.

* Group: Select the appropriate Enterprise
Security Group for this new user. Out
of the box, OnePlan comes with the
following Enterprise Security Groups, with
the following permissions:

242
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* None: Does not have access to OnePlan

* Team Member: Can view and edit plans or

tasks assigned to them

» Contributor: Can create, view, and edit
their own plans

* Executive: Can view all plans (and
content for those plans)

* Manager: Can view and edit all plans (and

content for those plans)

* Owner: Can view and edit all plans
(and content for those plans); can modify
OnePlan configuration (Admin)

* Business Unit: Select the business
unit. Available business unit choices are
configured on the Fields page, in the section
for resource-level fields.

* Role: Select primary role. Available role
choices are configured on the Fields page,
in the section for resource-level fields.

* Manager: Begin typing the name of the
manager for this user. Select the desired
name.

* Timesheet Administrator: (This field only
shows when the Timesheet App has been

added). Select this check box if this user is a

timesheet administrator.

* Timesheet Manager: (This field only shows
when the Timesheet App has been added).
Begin typing the name of the timesheet
manager for this user. Select the desired
name.

» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

* Rate: Enter the rate for this user, if different
than the rate associated to this user's role
(configured on the Cost Categories page).
Rate is the amount that you bill out for the
resource.

* Governance Warnings, Governance
Problems, Compliance: These fields are
not editable. They are related to Insights,
and display the number of governance
warnings and problems and a calculated
compliance score. Skip.

Click Save. The new user will be available

throughout OnePlan. The user will also receive

an invitation email from OnePlan informing
them that they have been added to the
OnePlan group, as well as a link to the

group. The user can then use their Office 365
credentials to access OnePlan.

3 NOTE
Any additional fields that are

configured as resource-level
fields on the Fields page
will show on the Add/Edit
Resource forms.

Add Resource x

With Multi-Authentication Enabled and the
User is an External Resource (Using an
External Email)

@ NOTE
Multi-Authentication must be

enabled in order to add users
with this method. See Enable
OnePlan Multi-Authentication for
instructions.
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If you are adding a new user who is NOT part
of your Entra/Office 365 tenant, follow these
instructions.

1. Go to the Resource Center.

2. Click Add Resource. The Add Resource form
will open.

3. Complete the Add Resource form.

* Generic: Leave the check box unchecked if
the resource is a named user.

» Display Name: Enter a display name for the
user. This will be the name shown in the
top right corner of OnePlan, as well as in
Resource Plans, Work Plans, etc.

« Email: Enter the email address for the new
user. This will be the email address where
this user will receive news and notifications
from OnePlan.

» Quantity: 1 signifies 1 FTE, or one full-
time resource. Full-time is all working hours
based on the Calendar settings. 0.5 would
signify a part-time resource who is available
1/2 time. This affects the resource's capacity.

* Group: Select the appropriate Enterprise 4.
Security Group for this new user. Out
of the box, OnePlan comes with the
following Enterprise Security Groups, with
the following permissions:

* None: Does not have access to OnePlan

* Team Member: Can view and edit plans or
tasks assigned to them

» Contributor: Can create, view, and edit
their own plans

» Executive: Can view all plans (and
content for those plans)

* Manager: Can view and edit all plans (and
content for those plans)

* Owner: Can view and edit all plans
(and content for those plans); can modify
OnePlan configuration (Admin)

» Business Unit: Select the business
unit. Available business unit choices are
configured on the Fields page, in the section
for resource-level fields.

* Role: Select primary role. Available role
choices are configured on the Fields page,
in the section for resource-level fields.

* Manager: Begin typing the name of the
manager for this user. Select the desired
name.

* Timesheet Administrator: (This field only
shows when the Timesheet App has been
added). Select this check box if this user is a
timesheet administrator.

* Timesheet Manager: (This field only shows
when the Timesheet App has been added).
Begin typing the name of the timesheet
manager for this user. Select the desired
name.

» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

* Rate: Enter the rate for this user, if different
than the rate associated to this user's role
(configured on the Cost Categories page).
Rate is the amount that you bill out for the
resource.

* Governance Warnings, Governance
Problems, Compliance: These fields are
not editable. They are related to Insights,
and display the number of governance
warnings and problems and a calculated
compliance score. Skip.

Click Save. The new user will be sent a link

in their email to finish setting up their OnePlan

account. See Create a OnePlan Account for

instructions.

S NOTE
Any additional fields that are

configured as resource-level
fields on the Fields page
will show on the Add/Edit
Resource forms.
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Add Resource x

Create Generic Resources

1. Go to the Resource Center.

2. Click Add Resource. The Add Resource form
will open.

3. Complete the Add Resource form.

Generic: Select the check box if the
resource is generic.

Display Name: Enter the generic resource
name. Typically, this is something like a role
name or something similar.

Quantity: 1 signifies 1 FTE, or one full

time resource. Full time is all working hours
based on the Calendar settings. 0.5 would
signify a part time resource who is available
1/2 time. This affects the resource's capacity.
Business Unit: Select a business unit

from the dropdown. Available business unit
choices are configured on the Fields page, in
the section for resource-level fields.

Role: Select a primary role from the
dropdown. Available role choices are
configured on the Fields page, in the section
for resource-level fields.

» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

* Rate: Enter the rate for this generic
resource, if different than the rate associated
to this generic resource's role (configured on
Cost Categories page, see How do | manage
Cost Categories?) . Rate is the amount that
you bill out for the resource.

* Manager, Timesheet Administrator,
Timesheet Manager, Governance
Warnings, Governance
Problems, Compliance: These fields are
not applicable for generic resources. Skip.

4. Click Save. The new generic resource will be

available throughout OnePlan.

Create and Manage Teams in the
Resource Center

This article explains how to create and manage
teams of resources from the OnePlan Resource
Center.

You can create teams of resources to represent
departments, divisions, groups, scrum teams, etc.
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Teams is a powerful feature in OnePlan that allows
you to manage groups of resources easily. In
OnePlan, you can easily assign entire teams of
resources to tasks in your work plan, and use
teams for resource planning rather than individual
resources.

@ NOTE
Only users with 'Manage

Resources' permissions can view
the Teams tab in the Resource
Center. The tab will be hidden
from all other users.

Create a New Team
To create a new team of resources:

1. Go to the Resource Center.
2. Click on the Teams tab. Here you will see alist 5.
of all your existing teams (if available).

=]

3. Click on the Add Team icon. The Create Team
form will open.

4. Complete the General tab of the Create Team
form. This is where you will enter general
information about the team, including the team
Name, a Description for the team, and, if
desired, you can select the team's Manager.

Create Team t

o IMPORTANT

Team Managers work just

like regular Managers in
OnePlan. If you assign the
team to tasks, that team's
manager will get the allocation
information. If you just assign
an individual resource, that
resource's manager will get
the allocation information.

Click on the Members tab. Here you can
search for and add resources to your team.
To add a resource to the team, click into the
search field and begin to type the resource's
name. After you enter a couple of letters

into the search field, resources will appear in
search results. Select the desired resource,
and they will be added to the team.

s NOTE
The resources need to

be active resources in the
Resource Center to be added
to a team.
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7.

Create Team x

(Optional) Update the resource's allocation

to the team. You can set how much of a
resource's time is going to be allocated to this
particular team. In this example, you can see
that Gavin Belson has been allocated 50% to
Team Three. To update a resource's allocation,
click into the Allocation field for the desired
resource, then enter the allocation % into the
field.

Create Team x

Members

] Gavin Belson Basic

Click Create to create your team. The team will
now be available for use across OnePlan.

Edit a Team

After you create your teams of resources, you will
likely need to add or remove members, update the
team names, etc. To edit a team:

1.

3.

Click the Edit icon next to the desired team.
The Edit Team form will open.

In the General tab of the Edit Team form, you
can update the team Name, Description, or
Manager.

Click the Members tab. Here you can add or

remove resources from the team.

a. To add a new resource to the team, click
into the search field and begin to type the
resource's name. After you enter a couple
of letters into the search field, resources
will appear in search results. Select the

@ OnePlan
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desired resource, and they will be added
to the team.

Edit Team x

Edit Team

&

b. To remove a resource from the team,
check the check box next to the desired
resource(s). Then click the Delete icon at
the top of the form.

3 NOTE
You can bulk remove

resources from a team
by selecting multiple
resources and clicking
Delete.

4. Once all of your updates are complete, click
Save.

Delete a Team

To delete a team, click the Delete icon next to the
desired team. The team will be removed from the
Resource Center.

Add Users to OnePlan

This article explains how to add users/resources to
your OnePlan environment.

Create Named Resources

With Office365 Strict Authentication

If you are adding a new user who is part of

your Entra/Office 365 tenant, and your organization
has Office365 Authentication enabled, follow these
instructions.
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Go to the Resource Center.
Click Add Resource. The Add Resource form
will open.

Complete the Add Resource form.

* Generic: Leave the check box unchecked if

the resource is a named user.

User: Begin typing the name of the user.

The available names will authenticate based

on user accounts in your Azure/Office365

tenant. Select the user name.

Quantity: 1 signifies 1 FTE, or one full-

time resource. Full-time is all working hours

based on the Calendar settings. 0.5 would

signify a part-time resource who is available

1/2 time. This affects the resource's capacity.

Group: Select the appropriate Enterprise

Security Group for this new user. Out

of the box, OnePlan comes with the

following Enterprise Security Groups, with

the following permissions:

* None: Does not have access to OnePlan

* Team Member: Can view and edit plans or
tasks assigned to them

» Contributor: Can create, view, and edit
their own plans

» Executive: Can view all plans (and
content for those plans)

* Manager: Can view and edit all plans (and
content for those plans)

* Owner: Can view and edit all plans
(and content for those plans); can modify
OnePlan configuration (Admin)

Business Unit: Select the business

unit. Available business unit choices are

configured on the Fields page, in the section

for resource-level fields.

Role: Select primary role. Available role

choices are configured on the Fields page,

in the section for resource-level fields.

Manager: Begin typing the name of the

manager for this user. Select the desired

name.

Timesheet Administrator: (This field only

shows when the Timesheet App has been

added). Select this check box if this user is a

timesheet administrator.

Timesheet Manager: (This field only shows

when the Timesheet App has been added).

Begin typing the name of the timesheet

manager for this user. Select the desired
name.

» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

» Rate: Enter the rate for this user, if different
than the rate associated to this user's role
(configured on the Cost Categories page).
Rate is the amount that you bill out for the
resource.

* Governance Warnings, Governance
Problems, Compliance: These fields are
not editable. They are related to Insights,
and display the number of governance
warnings and problems and a calculated
compliance score. Skip.

Click Save. The new user will be available

throughout OnePlan. The user will also receive

an invitation email from OnePlan informing
them that they have been added to the

OnePlan group, as well as a link to the

group. The user can then use their Office 365

credentials to access OnePlan.

K

NOTE

Any additional fields that are
configured as resource-level
fields on the Fields page

will show on the Add/Edit
Resource forms.
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Add Resource x

With Multi-Authentication Enabled and
the User is part of your Entra/Office
365 Tenant

S NOTE
Multi-Authentication must be

enabled in order to add users
with this method. See Enable
OnePlan Multi-Authentication for
instructions.

If you are adding a new user who is part of .
your Entra/Office 365 tenant, and your organization

has Multi-Authentication enabled, follow these

instructions. .

1. Go to the Resource Center.
2. Click Add Resource. The Add Resource form .
will open.
3. Complete the Add Resource form.
* Click the Entra icon. Search for and select
the user you would like to add to OnePlan.

Generic: Leave the check box unchecked if

the resource is a named user.

Quantity: 1 signifies 1 FTE, or one full-

time resource. Full-time is all working hours

based on the Calendar settings. 0.5 would

signify a part-time resource who is available

1/2 time. This affects the resource's capacity.

Group: Select the appropriate Enterprise

Security Group for this new user. Out

of the box, OnePlan comes with the

following Enterprise Security Groups, with

the following permissions:

* None: Does not have access to OnePlan

* Team Member: Can view and edit plans or
tasks assigned to them

» Contributor: Can create, view, and edit
their own plans

» Executive: Can view all plans (and
content for those plans)

* Manager: Can view and edit all plans (and
content for those plans)

* Owner: Can view and edit all plans
(and content for those plans); can modify
OnePlan configuration (Admin)

Business Unit: Select the business

unit. Available business unit choices are

configured on the Fields page, in the section

for resource-level fields.

Role: Select primary role. Available role

choices are configured on the Fields page,

in the section for resource-level fields.

Manager: Begin typing the name of the

manager for this user. Select the desired

name.

Timesheet Administrator: (This field only

shows when the Timesheet App has been

added). Select this check box if this user is a

timesheet administrator.
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* Timesheet Manager: (This field only shows

when the Timesheet App has been added).
Begin typing the name of the timesheet
manager for this user. Select the desired
name.

* Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

* Rate: Enter the rate for this user, if different

than the rate associated to this user's role
(configured on the Cost Categories page).
Rate is the amount that you bill out for the
resource.

* Governance Warnings, Governance
Problems, Compliance: These fields are
not editable. They are related to Insights,
and display the number of governance
warnings and problems and a calculated
compliance score. Skip.

Click Save. The new user will be available

throughout OnePlan. The user will also receive

an invitation email from OnePlan informing
them that they have been added to the
OnePlan group, as well as a link to the
group. The user can then use their Office 365
credentials to access OnePlan.

@ NOTE
Any additional fields that are

configured as resource-level
fields on the Fields page
will show on the Add/Edit
Resource forms.

Add Resource x

With Multi-Authentication Enabled and
the User is an External Resource
(Using an External Email)

S NOTE
Multi-Authentication must be

enabled in order to add users
with this method. See Enable
OnePlan Multi-Authentication for
instructions.

If you are adding a new user who is NOT part
of your Entra/Office 365 tenant, follow these
instructions.

1. Go to the Resource Center.
2. Click Add Resource. The Add Resource form
will open.
3. Complete the Add Resource form.
» Generic: Leave the check box unchecked if
the resource is a named user.
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Display Name: Enter a display name for the

user. This will be the name shown in the

top right corner of OnePlan, as well as in

Resource Plans, Work Plans, etc.

Email: Enter the email address for the new

user. This will be the email address where

this user will receive news and notifications

from OnePlan.

Quantity: 1 signifies 1 FTE, or one full-

time resource. Full-time is all working hours

based on the Calendar settings. 0.5 would

signify a part-time resource who is available

1/2 time. This affects the resource's capacity.

Group: Select the appropriate Enterprise

Security Group for this new user. Out

of the box, OnePlan comes with the

following Enterprise Security Groups, with

the following permissions:

* None: Does not have access to OnePlan

* Team Member: Can view and edit plans or
tasks assigned to them

» Contributor: Can create, view, and edit
their own plans

* Executive: Can view all plans (and
content for those plans)

* Manager: Can view and edit all plans (and
content for those plans)

* Owner: Can view and edit all plans
(and content for those plans); can modify
OnePlan configuration (Admin)

Business Unit: Select the business

unit. Available business unit choices are

configured on the Fields page, in the section

for resource-level fields.

Role: Select primary role. Available role

choices are configured on the Fields page,

in the section for resource-level fields.

Manager: Begin typing the name of the

manager for this user. Select the desired

name.

Timesheet Administrator: (This field only

shows when the Timesheet App has been

added). Select this check box if this useris a

timesheet administrator.

Timesheet Manager: (This field only shows

when the Timesheet App has been added).

Begin typing the name of the timesheet

manager for this user. Select the desired

name.

» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

* Rate: Enter the rate for this user, if different
than the rate associated to this user's role
(configured on the Cost Categories page).
Rate is the amount that you bill out for the
resource.

* Governance Warnings, Governance
Problems, Compliance: These fields are
not editable. They are related to Insights,
and display the number of governance
warnings and problems and a calculated
compliance score. Skip.

Click Save. The new user will be sent a link

in their email to finish setting up their OnePlan

account. See Create a OnePlan Account for
instructions.

NOTE
Any additional fields that are

configured as resource-level
fields on the Fields page
will show on the Add/Edit
Resource forms.
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» Cost: Enter the cost for this user. Cost is
what us costs to have the resource on a
project.

* Rate: Enter the rate for this generic
resource, if different than the rate associated
to this generic resource's role (configured on
Cost Categories page, see How do | manage
Cost Categories?) . Rate is the amount that
you bill out for the resource.

* Manager, Timesheet Administrator,
Timesheet Manager, Governance
Warnings, Governance
Problems, Compliance: These fields are
not applicable for generic resources. Skip.

4. Click Save. The new generic resource will be
available throughout OnePlan.

Add Resource x

Create Generic Resources

1. Go to the Resource Center.

2. Click Add Resource. The Add Resource form
will open.

3. Complete the Add Resource form.

* Generic: Select the check box if the
resource is generic.

* Display Name: Enter the generic resource
name. Typically, this is something like a role
name or something similar.

* Quantity: 1 signifies 1 FTE, or one full
time resource. Full time is all working hours
based on the Calendar settings. 0.5 would
signify a part time resource who is available
1/2 time. This affects the resource's capacity.

* Business Unit: Select a business unit
from the dropdown. Available business unit

Manage Resource Notification
Settings

choices are configured on the Fields page, in
the section for resource-level fields.

* Role: Select a primary role from the
dropdown. Available role choices are
configured on the Fields page, in the section
for resource-level fields.

This article explains how to update user system
notification settings.

Users can opt in or out of system notifications.
Managers and/or Owners can also change
notification settings for their resources.

@ OnePlan
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S NOTE ': ;-'.'. .'-‘.'-L
System notifications will not be

sent to users marked as inactive.

@ NOTE
If you disable a notification, users

will not receive the email or the in-
system notification.

1. Go to the Resource Center. Click the bell
icon next to the desired resource. The Manage
Notifications form will open.

View: Summary ¥ Search

Name

6 ina Shirk

2. By default, all notifications are enabled. To
opt out of selected notifications, uncheck the
Recieve All Notifications box. Then you can
unslelect/select individual notifications from the
list.

[TazkNzme} plan in OnePlan

3. Click Save to save your updates.

Create and Manage Teams in
the Resource Center

This article explains how to create and manage
teams of resources from the OnePlan Resource
Center.
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You can create teams of resources to represent
departments, divisions, groups, scrum teams, etc.

Teams is a powerful feature in OnePlan that allows
you to manage groups of resources easily. In
OnePlan, you can easily assign entire teams of
resources to tasks in your work plan, and use
teams for resource planning rather than individual
resources.

S NOTE
Only users with '"Manage

Resources' permissions can view
the Teams tab in the Resource
Center. The tab will be hidden
from all other users.

Create a New Team
To create a new team of resources: 5.

1. Go to the Resource Center.
2. Click on the Teams tab. Here you will see a list
of all your existing teams (if available).

=]

3. Click on the Add Team icon. The Create Team
form will open.

4. Complete the General tab of the Create Team
form. This is where you will enter general
information about the team, including the team
Name, a Description for the team, and, if
desired, you can select the team's Manager.

Create Team

IMPORTANT

Team Managers work just

like regular Managers in
OnePlan. If you assign the
team to tasks, that team's
manager will get the allocation
information. If you just assign
an individual resource, that
resource's manager will get
the allocation information.

Click on the Members tab. Here you can
search for and add resources to your team.
To add a resource to the team, click into the
search field and begin to type the resource's
name. After you enter a couple of letters

into the search field, resources will appear in
search results. Select the desired resource,
and they will be added to the team.

N

NOTE

The resources need to

be active resources in the
Resource Center to be added
to a team.
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7.

Create Team x

(Optional) Update the resource's allocation

to the team. You can set how much of a
resource's time is going to be allocated to this
particular team. In this example, you can see
that Gavin Belson has been allocated 50% to
Team Three. To update a resource's allocation,
click into the Allocation field for the desired
resource, then enter the allocation % into the
field.

Create Team x

Members

] Gavin Belson Basic

Edit a Team

After you create your teams of resources, you will
likely need to add or remove members, update the
team names, etc. To edit a team:

1.

Click the Edit icon next to the desired team.
The Edit Team form will open.

In the General tab of the Edit Team form, you
can update the team Name, Description, or
Manager.

Click the Members tab. Here you can add or

remove resources from the team.

a. To add a new resource to the team, click
into the search field and begin to type the
resource's name. After you enter a couple
of letters into the search field, resources
will appear in search results. Select the

256

2.
Click Create to create your team. The team will 3.
now be available for use across OnePlan.
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desired resource, and they will be added
to the team.

Edit Team

&

b. To remove a resource from the team,
check the check box next to the desired
resource(s). Then click the Delete icon at
the top of the form.

3 NOTE
You can bulk remove

resources from a team
by selecting multiple
resources and clicking
Delete.

Once all of your updates are complete, click
Save.

Edit Team x

Delete a Team

To delete a team, click the Delete icon next to the
desired team. The team will be removed from the
Resource Center.

Allocate Resources to Teams
(Total Percentage and Time-
Phased Allocation)

This article explains how resource allocation works
for resource teams.

When creating a team of resources, you can
specify which resources are part of each team, and
choose what percent they will be allocated to that
team. Additionally, you can break down resource
allocation to a team in a time-phased manner.
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Set a Resource's Total Allocation to a
Team

To specify the percentage of resource's capacity
allocated to a team:

1.

2.

Once you add a resource to a team (see
Create and Manage Teams in the Resource
Center), click into the Allocation field for the
desired resource, then enter the allocation %
into the field.

In this example, 50% of Amanda Crew's
capacity, 33% of Steven Tobolowsky's capacity,
and 100% of Tina Shirk's capacity are allocated
to the team. This means that these resources
will ALWAYS be allocated the specified
percentage to the team, as long as this team
exists.

Create Team x

Click Create or Save to save the allocation
updates to the team.

Time-Phased Allocation of a Resource
to a Team

If you would like the resource allocations to a given
team to last for a specified period, you can break
down resource allocations to a team using the time-
phased allocation feature.

1.

Create and save your team (see Create and
Manage Teams in the Resource Center for
instructions). Once you click Create, you will
return to the Teams list.

Back on the Teams list, click the Time-phased
Allocations icon next to the team name. The
Team Allocation form will open.

From the Add Resource drop-down, select the
resource you would like to add time-phased
allocations for. The selected resource will be
added to the allocations list below. Repeat until
all of the desired resources are added to the
allocations list.

S NOTE
You can add as many

resources from your team
as you wish and create time-
phased allocations for all of
them.

Click on the Dates menu and select the

date range you would like the time-phased
allocations to fall within. You can set the
allocations on a monthly (Month), quarterly
(Quarter), or yearly (Year) basis. Then you can
select from a preset date range including Last
Year, This Year, Next Year, or Next 5 Years.
Or, you can create a Custom Range. Once
the date range is set, click Apply, and the
allocation list view will update to match your
date settings.

In this example, | am going to allocate monthly
and set a custom date range for December
2023 through May 2024.
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Dates: Jan 2023 - Dec 2023 Aliocate

Month  Cuarter  Year

5. Now enter the allocation percentages for the
resources. There are two ways to do this:

1.

Click into the cells for the resource and
manually enter the allocation percentages.
This method is useful if the resource will
be allocated differently month-to-month (or
quarter-to-quarter, or year-to-year)

In this example, Dwight has been
allocated to the team 30% in December,
20% in January, 40% in February, 50% in
March, 50% in April, and 33% in May.

Check the checkbox next to the desired
resource, then click the Allocate button,
and the Allocate form will open. The
Allocate form allows you to select a start
and end date, and a % Allocation. The
allocation % set will apply equally to each
month/quarter/year between the start and
end dates.

Allocate x

L8

]

il

|

]

i
4

In this example, Tina has been allocated to
the team 45% for December 2023 through
April 2024.

Allocate x
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Resend a OnePlan Invite

This article explains how to resend a OnePlan invite
email. If a user has been invited to OnePlan but has
not yet accepted, you can use the resend button

in the resource edit screen. This button allows

the user to resend the invitation, streamlining the
process and ensuring that invitations can be easily
reissued when needed.

1. Go to the Resource Center.

2. Locate the user you would like to resent the
OnePlan invite to. Click the Edit icon next to
their name. The Edit Resource form will open.
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3. Atthe top of the Edit Resource form, click the
Resend Invite icon. The OnePlan invite email
for your OnePlan Group will resend to the user.

Edit Resource x |

kristinashirk@gmail.com
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Audit Overview

This article provides an overview of the Audit
feature.

The Audit feature allows you to keep track of
important usage data on a Plan level, and for
individual resources.

Plan level auditing captures information such as:

+ Work item creation, updates, and deletions

» Adding, updating, or removing users from a plans
shared with

» Archiving a plan

See Audit a Plan [261] for more information on Plan
level auditing.

Resource level auditing captures information such
as:

» User logins
+ Editing users
* Adding new users

See Audit Resources [263] for more information on
Resource level auditing.

You Also Need to Know

» The Audit feature is available for Enterprise
customers. Please contact OnePlan sales for
more information.

» Please contact OnePlan to enable the Audit
feature. Once enabled, users with "Owner"
permissions can configure what is being audited
in the Audit Settings.

Audit Triggers

This article describes the actions that will trigger
audit log entries.

The Audit feature allows you to keep track of
important usage data on a Plan level, and for
individual resources.

The following actions when working in a plan will
trigger an audit log entry:

Creating a work item

Updating a work item

Deleting a work item

Updating a work item using the REST API
Converting a work item into a milestone using the
Convert to Milestone function

Updating work items using the Gantt

Adding a user to a plan Shared With list
Updating a user in a plan Shared With list
Removing a user from a plan Shared With list
Archiving a plan

Adding a predecessor to a work item
Updating a work items calendar

Updating a work item's mode

» Converting a work item to a milestone
* Marking a work item as inactive

Changing a work item to be manually scheduled
Copying and pasting work items

The following actions when working with resources
will trigger an audit log entry:

User logins

Editing users

Adding new users

Changing a generic resources name

Using the import option in the resource planner

Audit a Plan

This article explains OnePlan's Plan Auditing
feature.

NOTE

The Audit feature is available

for Enterprise customers. Please
contact OnePlan sales for more
information.

K
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The Plan Auditing feature allows you to capture
user interaction with plans including when a user
adds, updates, or deletes work items, who a user
shares a plan with, and much more. Plan auditing
captures information from the Plan Details, the
Resource Plan, the Financial Plan, the Share With,
and the Work Plan.

Access a Plan Audit Log

1. Goto aplan and open it.

2. Click the ellipsis (...) next to the plan name,
and select Audit from the drop down. The
Audit form will open.

e

3. To access the various audit logs from the
selected plan, use the tabs at the top of the
Audit form. Options include:

* Plan Details. Here you can view audit
information for any changes made to the
plan's Plan Details form.

* Financials. Here you can view audit
information for any changes made to the
plan's Financial Plan.

* Resource Plans. Here you can view audit
information for any changes made to the
plan's Resource Plans.

» Share With. Here you can view audit
information for any changes made to the
plan's Share With list (who the plan is shared
with).

* Work Plan. Here you can view audit
information for any changes made to the
plan's Work Plan.

Audit Filters

You can apply filters to audit specific plan
information. The filters available are across the
top of the Audit form. The filters available change
based on the audit log tab you are in.

Plan Details filters

» Action Taken: Select the user actions you would
like to review. Options include Add and Update.

» Modified By: Select a user from the drop down
to view the data modified by that user.

» Fields: Select a plan field to view audit
information for the selected field.

» Date Range: Select a date range to view audit
data from the selected date(s).

Financials filters

» Action Taken: Select the user actions you would
like to review. Options include Add, Update, and
Delete.

* Modified By: Select a user from the drop down
to view the data modified by that user.

* Fields: Select a financial plan field to view audit
information for the selected field.

» Entry Date: Select an entry date or entry date
range to view financial data entered on the
selected date(s).

» Date Range: Select a date range to view audit
data from the selected date(s).

Resource Plans filters

» Action Taken: Select the user actions you would
like to review. Options include Add, Update,
Delete, Approve, and Reject.

* Modified By: Select a user from the drop down
to view the data modified by that user.

* Resource: Search for and select a resource to
view audit information for the selected user.
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* Fields: Select a resource plan field to view audit
information for the selected field.

+ Entry Date: Select an entry date or entry date
range to view resource data entered on the
selected date(s).

+ Date Range: Select a date range to view audit
data from the selected date(s).

Share With filters

» Action Taken: Select the user actions you would
like to review. Options include Add, Update, and
Delete.

* Modified By: Select a user from the drop down
to view the data modified by that user.

* Resource: Select a resource from the drop down
to view the audit information for the selected
resource.

+ Date Range: Select a date range to view audit
data from the selected date(s).

Work Plan filters

+ Action Taken: Select the user actions you would
like to review. Options include Add, Update, and
Delete.

+ Item: Select a work item from the drop down to
filter for that item's audit data.

* Modified By: Select a user from the drop down
to view the data modified by that user.

* Fields: Select a work plan field to view audit
information for the selected field.

» Date Range: Select a date range to view audit
data from the selected date(s).

Export the Plan Audit Log

You can export the Plan Audit Log into an Excel
spreadsheet.

Simply click the Export icon, select Excel xIsx, and
an Excel file will download to your machine.

NOTE

When exporting the audit logs,
audit log rows created by system
jobs will show as modified by
"System".

Audit Resources

This article explains OnePlan's Resource Auditing
feature.

S NOTE
The Audit feature is available

for Enterprise customers. Please
contact OnePlan sales for more
information.

The Resource Auditing feature allows you to
capture Resource information like logins, and much
more.

Access Resource Audit Logs

1. Go to the Resource Center.
2. Locate the desired resource, and click the Edit

icon < next to their name. The Edit Resource
form will open.

2000080

=
o00008

3. Click the Audit button at the bottom of the Edit
Resource form. The Audit - Resource log will
open.
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Edit Resource x

Export the Resource Audit Log

You can export the Resource Audit Log into an
Excel spreadsheet.

Simply click the Export icon, select Excel xIsx, and
an Excel file will download to your machine.

Audit Filters

You can apply filters to audit specific resource
information. The filters available are across the top
of the Audit - Resources form.

» Action Taken: Select the resource actions you
would like to review. Options include Add,
Update, and Login.

* Modified By: Select a user from the drop down
to filter for the users audit data.

* Fields: Select a resource field to view audit
information for the selected field.

* Date Range: Select a date range to view audit
data from the selected date(s).
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OnePlan in Other Apps

Install the OnePlan for Project

Connector

This article explains how to install the OnePlan for
Project Connector between OnePlan and Microsoft
Project. The OnePlan for Project Connector tools
allows project managers to build and manage their
project schedules in the MS Project Desktop, and
then sync the project schedule to OnePlan.

You must have Microsoft Project Desktop installed Run Installer Setup Wizard
locally on your machine to use the OnePlan for

Project Connector. Have Microsoft Project installed o One Plan For Project - x
prior to installing the OnePlan connector. Welcome to the One Plan For Project Setup Wizard  [7

=
I n Sta I I 0 n e P I a n fo r P roj ect C o n n ecto r E:g\ussllerwll uicks you throucgh te sleps requied 1oinstall One Flan For Froject onwour
Tool

Navigate to the OnePlan Integration page
for Microsoft Project: https://oneplan.ai/integrations/
microsoftproject/.

WARRIMG: This computer pragram ie protecied by coprpnght 2w and mlemetional reafias.
Unouthorized duplication or distribution of this program. or any portion of it may resultin severs civil
orciringl penallies, andwill be proseculed b the masinun edeat possible ancer fhe Ew

Click the blue button to install the connector.

Cancel <Back Bleat

#5 One Plan For Project — x
Select Installation Folder (. N
=5 ]
by

The installerwill inztall One Plan For Project 1o he follawing lalder,

Toinstall inthis older, dick "Nesd®. Toinstall o a diffeeatolder, enter it below or click *Browse*.

Falder

CAProgram Files\OneManiOneFanForPoject, Browse. . |
Disk Cost.. |
Save the Download File
If prompted, click Save. Do not click Run. Instead,
go to your Downloads folder (or wherever you may — | ]

have saved it).

Unblock Download File

You may prompted that the download file is
blocked. Open the properties for the download
file. On the general tab, select the check box for
Unblock.
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& One Plan For Project - =

Confirm Installation

The installer i reacy v inzlall Cne Plan For Frajec onyour computer.

Click "Mesd® o =ter the inztallabon

Cancel <Back

& One Plan For Project - =

Installation Complete

Cne Plan For Project has keen successuly installed.

Click "Cloze® o exit

Fleases uzeWindows Update to check for any critical updetes 1o the WET Framewar.

Close

Open Microsoft Project

After the installation is complete, open Microsoft
Project. The first time you open MS Project, you will
be prompted to confirm installation of the connector
add-in. You may start with a blank schedule & build
it out, or begin with an existing schedule/template.
Click Install.

Microsoft Office Customization Installer

e 2 »
Publisher has been verified [

Are you sure you want to install this customization?

Mame: Project_and_OnePlan_Synch - Project_and_OnePlan_Synch
filey/{/C; Program
Files/OnePlan/OneManForProject/Project_and_OnePlan_Synch.sto
Publisher: 1Plan Ll

From:

i While Office customizations can be useful, they can potentially harm your
computer. if you do not trust the source, do not install this software. More

Information_
m o et

OnePlan Menu in Microsoft Project

Once installed, the OnePlan Connector will show
the OnePlan menu.

“ Task Resource Report Project View Help

q i Connec
o g B | Do

%] Map Resources Hel
Open Publish Update cMap @ P
Plan @ Settings

Synchronization Confiquration Help

OnePlan Connector Settings

Hide Resource Mapping on Publish: Select the
check box to skip the resource mapping on publish.
Users would instead click the Map Resources
button on the ribbon prior to publishing.

Check for Updates: Select the check box to auto-
check for updates each time you open MS Project.
You may also manually check for updates if you
leave that option unchecked.

Synch Choice Fields: Click this button to synch
the choice options for fields mapped between
OnePlan and MS Project.

n T Ao Hak Al Holp  OnePlan
N o L | Ao
e il pugfemce @ el
s S Pusisk Optiana
1 e 3 e e
L * Desent Skiss 158.75 days ThL Crack for Updates
- [

S5 dm s [rr—
30 4

WIEdays  Tem ¥ Comsl
SRR P o R—
mstisd 10 days Tue 10/2/19 Tew 10/32/10 sarmport]

OnePlan Help

The OnePlan Help menu directs the user to the
OnePlan online guide.

OnePlan User Guide

OnePlan to Microsoft Project Connector

Install the

View all chapters

Follow to the article How to Use the OnePlan for
Project Connector for how to connect your plan
and project schedule. Use the OnePlan for Project
Connector [267]
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Updates

If you have the Check for Updates box checked,
when a new version is available, you will be
prompted to download the latest version.

[@] Download Update X

Latest OnePlan app version (V1.1.31) is available.

Would you like to download the new version?

Yes No

Use the OnePlan for Project

Connector

This article explains how to use the OnePlan for
Project Connector between OnePlan and Microsoft
Project. The OnePlan for Project Connector tools
allows project managers to build and manage their
project schedules in the MS Project Desktop, and
then, sync the project schedule to their Plan in
OnePlan.

From within OnePlan, users can see resource
load across all projects, dive into project schedule
details, view the Gantt, timeline, critical path, etc.
Also, users can do additional collaboration (even
task-level). Users can also view & work with the
tasks in a KanBan board.

You must have both Microsoft Project Desktop and
the OnePlan for Project Connector installed locally
on your machine to use the OnePlan for Project
Connector. The Project Professional app must also
be installed in OnePlan by your admin.

New Plan without a Schedule of Tasks

Typically, you will already have a plan with details,
but not yet a schedule. Navigate to the Schedule
Grid page for your plan. If you don't yet have a plan
in OnePlan, create it. Later, when publishing from
Microsoft Project, you'll be prompted to select your
plan.

Open Microsoft Project

Build your task schedule. When ready to publish,
open the OnePlan menu.

o wap [ OnePlan armat whan you went 10 do

n7 W 10/91 Mon 2/3/20

37 Wed 10/9/19 Fil 10/18/19

sl Wed 10/8/19 Mon
mi1a1s

Man
10/18/13

Connect to OnePlan Group and Plan

Click Connect. Authenticate to your Office365
account.

Pick an account

Select OnePlan Instance and Group

You may have access to multiple OnePlan
instances and/or groups. If so, first select your
OnePlan instance.

@

Please select a OnePlan instance for connection

my.oneplan.ai

Select

Then select your OnePlan group,
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OnePlan Groups x
P

Please select a OnePlan group

Cancel

Connection Successful

OK

Save Plan

Save your project schedule as the same name of its
corresponding plan in OnePlan.

Dnefian o M5 Frogect Schecdes

Publish Project Schedule to OnePlan

Now that your Project file is connected to OnePlan,
it's time to publish this schedule to OnePlan.

Click Publish.

Task  Resource  Report Project View  Help OnePlan

Select Plan
The connector looks for the existing plans in your
OnePlan group. Select your plan.

OnePlan Plans x
Please select a OnePlan plan

Azure Migration

Desert Skies

Employee Portal Launch
Fabrikam

Hooli

Office365 Launch

Rose Desktop App

Software Development

Support Customers using Mobile
VOIP Phones

Cancel

Map Resources / Build Team

You may map resources before publishing, by
selecting Map Resources in the OnePlan menu. Or,
you may wait to be prompted to map resources
during the publish process.

Custom Filters for Mapping Resources

If you have a large Resource Center in OnePlan,
you may add filters to limit which resources show
for mapping. Select a resource-level field, such

as department, role, etc. Select the operator, and
enter the desired filter value. If adding additional
rows, select And/Or for how the filters should work
together. Once the filters are set, you may minimize
the filter section again to map the resources.

Menu options: Refresh/Apply Filter, Save Filter, Add
Filter Row, Remove Filter Row

g e
|
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Save Filter

If you expect to use the same or similar filters, click
the Save Filter icon. Enter the filter name. It will
now show under the saved filters drop down.

Filtar QewPlan Risources
Saved fears: [Wl Fascarces

4 Cutoss Fiters

| @ eaitd Team
" Filtne Cinaian Raccurcas
| tovea mmars: a0 Raseurcis

1
| Gurioss Fitars
f Bl Tuam

| OnePlan Besoeces
1 Dianiel Witiams
Project Marager
Busingss Analyst

Sheve McGarrert

i Aitam Noshimiel

Fisdd Mavreo
Ehsminuss Uit

Build Toaen

Cpomor

el

DretPlan Resaurces

Praject Manager

Amy Comelll
Grace Williams
Erwn Zmchia
Fatrick Sanks

Map Resources

Select the name of a OnePlan resource on the left
side. Select the name of a resource from your MS
Project schedule on the right side. Click Replace.
This will replace any references to that MS Project '
schedule resource with the name of the OnePlan ! )

resource.

Microsaft Project Resouries
Dl Wikams

e Careal
TErwin Zischks
Supaort

4 [ B Team
1 Fiter OnePlan Rescerces
| Eaved Sters Al RaSources

# Costam Peters
! B Team

[ —

Microsaft Fraject Resowces

Praject Manager
Acceatos
AppcaTon Archiec

A . Techical Acchitect
e Quality [}

Camtracts Manoges
Fenom

If a name is mapped that you want to change,
select the row on the right side, then click the
Remove button.

CinePlan Resnorces
Disvel Willars

Praject Manager

Business Analyst

Deveiones

Supgart

Kono Kalskaua

St McGamett

farm Noshimuri

Ay Cames

[}

Lisa
Lori Weston
Satrick Sand

[ —
Dansed Wisiams

Progect Manoger

Acceptar

Application Acchitect
Tacknical Architect

[
[TI00 o show on putlish egeir

button.

Select the name of a OnePlan resource on the left
side. Click Add. This will add the name to the MS
Project schedule list of resources.

{ (B f Teom
Fittar CnePlan Resnurres
saven s IR

& Cuttam Filluss
¥ B Team

Fublat. Canc

You may select the check box to not show
on publish (you'll still be able to manually map
resources via the ribbon button).

Once all mappings are done, click the Publish

el Resotiioes
[
Project Manages
Bunass Ansdyit
Deveipel
Support

Keno Kalakaas
Stova McGamatt
A Mastim
Ay Correll
Grace Wilkame
Erwin Ziscrin
Lisa Andrews
Losi Wieaton

]0 not shaw on publzh agan

Wicrasolt Project Resowsres

W Fat
Acceptnr

0ng Kaakaus
Sheve Moisamett
Grace Widiams
Erwin Tischia
Suppor

Fubitzn Cancel
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Task Import Progress X

Importing tasks to OnePlan...

Publish Successful

@ Task Import Progress X

Publish Successful

Close

Open Plan in OnePlan

Open the Schedule Grid page of your plan. If you
were already there, refresh your browser. The tasks
will show for your plan now.

View Which Plans are Connected to

MS Project

Navigate to the Portfolios page. Any plans
connected to MS Project will show the Project icon
on the row.

Updated Team

Any tasks assigned to resources in the MS Project
schedule when mapped and published will be
added to your plan team (Shared With).

000000

Updates in Project Schedule

Through the life of the project, come back to your
MS Project schedule. Click the Update button to
review the updates to tasks made by the team
members. If there are no updates, you'll be notified.
Otherwise, you may review to accept or reject the
updates.

File Task  Resource Report Project View Help  OnePlan
Pl E_ _t Connect
g S ] Map Resources @ Help
Open Publis§ Update _
Plan & settings
synchrenization Corfiguration Helg

There are no tasks to be updated back into this project.

Map Custom Fields in the

OnePlan to Project Connector

This article explains how to map OnePlan fields
and Project fields using the OnePlan to Project
Connector.

This procedure requires the Project Professional
app to be installed in your OnePlan config. See
How do | Add Apps to OnePlan? for more
information.

This procedure also requires the OnePlan for
Project Connector to be installed and configured.
See Install the OnePlan for Project Connector
and Use the OnePlan for Project Connectorfor
instructions.

Map Custom Fields in the OnePlan
and Project Connector

1. Go to the OnePlan admin pages > Project
Professional.

2. Click New Mapping. The New Mapping form
will open.
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Import Microsoft Project

Schedule into OnePlan
This article explains how to import your Microsoft

3. Configure the new custom field mapping using Project schedules into OnePlan.

the New Mapping form.

* Microsoft Project Field: Select the MS You would want to use these steps when you are
Project field you would like mapped to the migrating from Microsoft Project to OnePlan as your
selected OnePlan field. main project management tool.

* OnePlan Field: Select the OnePlan field .
you would like mapped to the selected MS 1. Follow Install the OpePIan for. Project .
Project field. annector [2§5] to install Project Connect in

» Direction: Select the direction you would like Microsoft Project. )
data to flow in the field mapping. Options 2. Follow Use the OnePIar) for Prole9t
include MS Project to OnePlan, OnePlan Connector [267] to publish your Microsoft
to MS Project, and Both. Project schedule into OnePlan.

3. Disconnect Microsoft Project from the schedule
Add Mapping » in the OnePlan Work Plan.
a. Click the Connected Systems icon in
crosoft Project - the Work Plan header. The Connected
= Systems popup will open.
OnePlan Field: - b. Click Disconnect to disconnect Microsoft
Project from the schedule.
4. Click Add to create the new field mapping.
5.  Open Microsoft Project Desktop.
6. Open the OnePlan menu > Settings.
7. Click Synch Fields to sync the field mappings

you configured in OnePlan.

4. Select the grid options menu = > Check
Schedule. The schedule check will run. Once
it is complete, click Ok in the Check popup
that appears. Save your work plan to save any
adjustments made during the check.
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How does my Project schedule

get stored in Teams?

This article explains how the feature works for
storing your Project schedule file in a Teams
document library rather than locally on your
desktop.

This feature requires that your admin has
configured both the Project Professional and
Microsoft Teams apps in OnePlan.

Storing Microsoft Project Templates

In SharePoint, add an app.

Select Document Library as the type.

Name the Document Library "PlanTemplates".
Upload Microsoft Project .mpp templates

oOn

How do | use OnePlan with
Project for the Web (Video)

https://player.vimeo.com/video/557839899

How do | manage OnePlan in

Microsoft Teams?

This article shows how to enable and use OnePlan
within Microsoft Teams.

Go to the Admin pages, select Microsoft Teams in
the navigation.

This requires the Microsoft Teams app be installed.
To learn how to add/install apps, refer to the article:
How do | add apps?

Enable Teams Integration

Click the link to enable the Teams integration with
your OnePlan group.

If you would like to create & team for this group click here

“heck this bo to sutomaticatly create a taam everysme a plan is created

Enable Permissions

This step only needs to be done once per tenant.
So, if you have multiple groups and the permissions
were already enabled in another group, you can
skip this step.

Refresh your browser (& navigate back to the
Teams settings page again). Click the Enable
Permissions button. This allows OnePlan to
communicate with Microsoft Teams. Click Accept.

Create a Group Team
Click the link to create a new Team in Microsoft
Teams for this OnePlan group. The Team is created

and when you view the Team, a new tab for
OnePlan is added.
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Group Level Team Created

When the Group Level Team is created, a tab

for OnePlan will show. All the functionality &
modules of OnePlan are available within the Teams
interface.

i
i

Set Auto Create Preference

Select the check box to have a new Team created
for every new plan created in OnePlan. Note, this
could be cumbersome if not every plan warrants a
need for its own Team. This is not recommended,
unless you are certain there should be a separate
Team for every plan.

Instead, leave the box unchecked. Then, the plan
owners can choose to create a new Team for their
plans as needed on demand.

Manage a Backlog with Azure
DevOps and OnePlan (Video)

In this video we demonstrate how to manage your
Azure DevOps (ADO) backlog in OnePlan using the
ADO and OnePlan integration.

/Iplayer.vimeo.com/video/725699436

@ OnePlan

273



Using OnePlan

End User Best Practices

in turn, slows performance. Higher-level financial

|mprove OnePlan Performance planning reduces the amount of data stored per
End U cost category and helps improve performance.
as an En ser * If your environment allows you to create custom

This article describes methods you, as an end user, cost categories or detail rows, refrain from adding
can use to help improve OnePlan performance. too many additional cost categories or detail
. rows to the financial planner. The more custom
Portfolio cost categories and detail rows you add to
the financial planner, the slower your OnePlan
» Use pre-filters. Ideally, your administrator has performance will be.

made pre-filters required for the portfolio area, so .
users must select a pre-filter in order for data to

load. These pre-filters are server-side filters that
significantly reduce the amount of data loaded in Timesheet
the Portfolio, thus increasing performance.

Limit the number of periods of data in your
financial planner.

* Archive old plans. The archive function moves « Limit the number of tasks in your timesheets. Be
your plans and associated data into a separate sure to delete tasks that you are not recording
database partition. Archiving old plans removes time to. The fewer tasks in your timesheet, the
them from your portfolio, reducing the number of faster it will load.
plans that OnePlan needs to load when you open
your portfolio. Work Plan

Modeler + Limit the number of tasks in your work plans. The

fewer tasks in your work plan, the faster it will

+ Use filters when setting up your models so you load.
only pullin the plans you need. Limiting the + Limit the levels of hierarchy in your work plan. 4-5
amount of data that the model needs to load will levels max is best practice, but the fewer |ayers,
reduce load times and improve performance. the better.

* If you find that your project is very large, with

Resource Plans a lot of tasks and levels of hierarchy, consider

breaking that large project into several sub-

» Use pre-filters. Ideally, your administrator has projects.

made pre-filters required for the resource
planner, so users must select a pre-filter in order
for data to load. These pre-filters are server-side
filters that significantly reduce the amount of data
loaded in the resource planner, thus increasing
performance.

+ Limit the number of periods of data in your
resource planner.

* You may also want to consider using Activities to
break down tasks into smaller work items rather
than creating several tasks and additional layers
of hierarchy. Using Activities reduces the number
of tasks and layers of hierarchy in your work plan,
which helps improve performance.

* Do not assign too many resources to tasks. The
more resources assigned to a task, the slower

. . the load time.
Financial Plan

+ Stick to monthly planning unless you absolutely
must plan weekly. In order to enable users
to plan on a weekly basis, OnePlan actually
stores data daily, which significantly increases
the amount of data handled by the system, and,
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